No part of this publication may be reproduced or used in any form, or by any electrical or mechanical means, without permission in writing from Zebra. This includes electronic or mechanical means, such as photocopying, recording, or information storage and retrieval systems. The material in this manual is subject to change without notice.

The software is provided strictly on an "as is" basis. All software, including firmware, furnished to the user is on a licensed basis. Zebra grants to the user a non-transferable and non-exclusive license to use each software or firmware program delivered hereunder (licensed program). Except as noted below, such license may not be assigned, sublicensed, or otherwise transferred by the user without prior written consent of Zebra. No right to copy a licensed program in whole or in part is granted, except as permitted under copyright law. The user shall not modify, merge, or incorporate any form or portion of a licensed program with other program material, create a derivative work from a licensed program, or use a licensed program in a network without written permission from Zebra. The user agrees to maintain Zebra's copyright notice on the licensed programs delivered hereunder, and to include the same on any authorized copies it makes, in whole or in part. The user agrees not to decompile, disassemble, decode, or reverse engineer any licensed program delivered to the user or any portion thereof.

Zebra reserves the right to make changes to any software or product to improve reliability, function, or design.

Zebra does not assume any product liability arising out of, or in connection with, the application or use of any product, circuit, or application described herein.

No license is granted, either expressly or by implication, estoppel, or otherwise under any Zebra Technologies Corporation, intellectual property rights. An implied license only exists for equipment, circuits, and subsystems contained in Zebra products.
# Revision History

Changes to the original manual are listed below:

<table>
<thead>
<tr>
<th>Change</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-01 Rev A</td>
<td>12/2012</td>
<td>Initial Release.</td>
</tr>
<tr>
<td>-02 Rev A</td>
<td>6/10/13</td>
<td>Add Windows Embedded Handheld support.</td>
</tr>
<tr>
<td>-03 Rev A</td>
<td>12/2014</td>
<td>Zebra Rebranding</td>
</tr>
<tr>
<td>-03 Rev B</td>
<td>4/2015</td>
<td>Zebra Rebranding</td>
</tr>
<tr>
<td>-05 Rev A</td>
<td>12/2015</td>
<td>Add Android operating system support.</td>
</tr>
<tr>
<td>-05 Rev B</td>
<td>5/2015</td>
<td>Remove references to TCM and Device Configuration Package, which are not supported in CE 7.0.</td>
</tr>
</tbody>
</table>
# TABLE OF CONTENTS

Revision History ........................................................................................................................................ iii

## About This Guide

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>xvii</td>
</tr>
<tr>
<td>Documentation Set</td>
<td>xvii</td>
</tr>
<tr>
<td>Configurations</td>
<td>xviii</td>
</tr>
<tr>
<td>Software Versions .......................................... xx</td>
<td></td>
</tr>
<tr>
<td>Windows Mobile and Windows CE</td>
<td>xx</td>
</tr>
<tr>
<td>AKU Version for Windows Embedded Handheld Devices</td>
<td>xx</td>
</tr>
<tr>
<td>OEM Version</td>
<td>xxi</td>
</tr>
<tr>
<td>BTEplorer Software</td>
<td>xxi</td>
</tr>
<tr>
<td>Fusion Software</td>
<td>xxi</td>
</tr>
<tr>
<td>Android</td>
<td>xxi</td>
</tr>
<tr>
<td>Chapter Descriptions ........................................... xxi</td>
<td></td>
</tr>
<tr>
<td>Notational Conventions ........................................ xxii</td>
<td></td>
</tr>
<tr>
<td>Related Documents and Software ................................ xxiii</td>
<td></td>
</tr>
<tr>
<td>Service Information ............................................... xxiii</td>
<td></td>
</tr>
</tbody>
</table>

## Chapter 1: Getting Started

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>1-1</td>
</tr>
<tr>
<td>Unpacking the MC92N0-G</td>
<td>1-1</td>
</tr>
<tr>
<td>Configuring the MC92N0-G</td>
<td>1-1</td>
</tr>
<tr>
<td>Resetting the MC92N0-G</td>
<td>1-2</td>
</tr>
<tr>
<td>Windows CE Devices</td>
<td>1-2</td>
</tr>
<tr>
<td>Performing a Warm Boot</td>
<td>1-2</td>
</tr>
<tr>
<td>Performing a Cold Boot</td>
<td>1-2</td>
</tr>
<tr>
<td>Windows Embedded handheld Devices</td>
<td>1-2</td>
</tr>
<tr>
<td>Performing a Warm Boot</td>
<td>1-3</td>
</tr>
<tr>
<td>Performing a Cold Boot</td>
<td>1-3</td>
</tr>
<tr>
<td>Performing a Clean Boot</td>
<td>1-3</td>
</tr>
<tr>
<td>Reset The Device Android</td>
<td>1-3</td>
</tr>
<tr>
<td>Performing a Soft Reset</td>
<td>1-4</td>
</tr>
<tr>
<td>Performing a Hard Reset</td>
<td>1-4</td>
</tr>
</tbody>
</table>
Performing an Enterprise Reset ................................................................. 1-4
Performing a Factory Reset ..................................................................... 1-5
Battery Management .................................................................................. 1-6
Battery Saving Tips .................................................................................. 1-6
Changing the Power Settings ..................................................................... 1-6
Changing the Display Backlight Settings .................................................. 1-6
Changing the Display Brightness ............................................................... 1-7
Changing the Keypad Backlight Settings .................................................. 1-7
Windows Devices ...................................................................................... 1-7
Android Devices ....................................................................................... 1-7
Turning Off the Radios .............................................................................. 1-8
On Windows Embedded Handheld Devices .............................................. 1-8
On Windows CE Devices .......................................................................... 1-8
WLAN Radio ............................................................................................ 1-8
Bluetooth Radio ........................................................................................ 1-9
On Android Devices .................................................................................. 1-9

Chapter 2: Accessories
Introduction .............................................................................................. 2-1
Keypads ..................................................................................................... 2-5
Replacing the Keypad ............................................................................... 2-5
Secure Device (SD) Card .......................................................................... 2-6
Single Slot Serial/USB Cradle ................................................................... 2-8
Setup ........................................................................................................ 2-9
Battery Charging Indicators ..................................................................... 2-9
Four Slot Ethernet Cradle CRD9000-4000ER ............................................. 2-11
Setup ........................................................................................................ 2-12
Battery Charging Indicators ..................................................................... 2-12
Ethernet Communication Setup ............................................................... 2-13
Installing MobileDox Cradle Manager ...................................................... 2-13
Installing iDocklt ...................................................................................... 2-13
MC92N0-G Configuration ......................................................................... 2-14
DHCP Server Configuration ..................................................................... 2-14
Cradle Configuration ................................................................................ 2-14
Four Slot Ethernet Cradle CRD9101-4001ER ............................................. 2-18
Setup ........................................................................................................ 2-19
Battery Charging Indicators ..................................................................... 2-19
Four Slot Charge Only Cradle ................................................................. 2-21
Battery Charging Indicators ..................................................................... 2-22
Four Slot Spare Battery Charger ............................................................... 2-23
Spare Battery Charging with the Four Slot Spare Battery Charger .......... 2-24
Battery Charging Indicators ..................................................................... 2-24
Magnetic Stripe Reader ............................................................................ 2-25
Setup ........................................................................................................ 2-26
Battery Charging Indicators ..................................................................... 2-26
USB Connection ....................................................................................... 2-27
Using the MSR ......................................................................................... 2-27
Cable Adapter Module .............................................................................. 2-28
Attaching and Removing .......................................................................... 2-29
### Table of Contents

- **Setup** ...................................................................................................................................... 2-30
- **Battery Charging Indicators** .................................................................................................... 2-30
- **USB Connection** ..................................................................................................................... 2-31
- **Universal Battery Charger (UBC) Adapter** ................................................................................... 2-32
- **Inserting and Removing a Battery** .......................................................................................... 2-32
- **Modem Module** ............................................................................................................................ 2-34
  - **Setup** ...................................................................................................................................... 2-35
    - Connecting to the MC92N0-G .......................................................................................... 2-35
    - Connecting to the Single Slot Serial/USB Cradle ............................................................. 2-36
    - Configuring the MC92N0-G for the Modem (Windows Embedded Handheld) ....................... 2-36
    - Configuring the MC92N0-G for the Modem (Windows CE) ................................................... 2-37
    - Connecting the Modem (Windows Embedded Handheld) ..................................................... 2-37
    - Connecting the Modem (Windows CE) .................................................................................. 2-37
    - Changing the Initialization String ...................................................................................... 2-37
  - **Serial Communication Setup** .................................................................................................... 2-39
    - Setting Up a Connection on the MC92N0-G (Windows Embedded Handheld) ..................... 2-39
    - Serial Connection Setup (Windows CE) ................................................................................ 2-40
  - **USB Host Communication Setup** ............................................................................................ 2-42
  - **Wall Mounting Bracket and Shelf Slide** .................................................................................. 2-43
    - Installing the Wall Mount Bracket ........................................................................................... 2-43
    - Attaching the Shelf Slide to the Wall Mount Bracket .............................................................. 2-44
    - One Single Slot Cradle/Four Slot Battery Charger ........................................................... 2-44
    - Two Single Slot Cradles/Four Slot Battery Chargers ............................................................. 2-44
    - Four Slot Cradle .............................................................................................................. 2-45
    - Installing the Cradle/Charger on the Bracket ......................................................................... 2-45

### Chapter 3: Synchronization

- **Introduction** .................................................................................................................. .......... 3-1
- **Installing the Sync Software** ............................................................................................... 3-1
- **MC92N0-G Setup** ..................................................................................................................... 3-2
- **Setting Up a Sync Connection** .............................................................................................. 3-2
  - ActiveSync .............................................................................................................................. 3-2
  - Windows Mobile Device Center ............................................................................................... 3-3
  - Setting up a Partnership with a Windows CE Device ............................................................... 3-4
  - Synchronization With a Windows Embedded Handheld Device ............................................ 3-6

### Chapter 4: USB Communication

- **Connecting to a Host Computer via USB** ....................................................................................... 4-1
- **Connecting to the MC92N0-G as a Media Device** ..................................................................... 4-1
- **Disconnect from the Host Computer** ..................................................................................... 4-2

### Chapter 5: Wireless Applications

- **Introduction** .................................................................................................................. .......... 5-1
- **Windows CE Devices** .................................................................................................................. 5-1
- **Windows Embedded Handheld Devices** ................................................................................. 5-2
Chapter 6: Administrator Utilities

Required Software ............................................................................................................. 6-1
On-device Application Installation ....................................................................................... 6-1
Multi-user/AppLock Configuration ....................................................................................... 6-2
Enterprise Administrator Application .................................................................................. 6-2
  Creating Users .................................................................................................................. 6-2
  Adding Packages .............................................................................................................. 6-3
  Creating Groups ............................................................................................................... 6-4
  Creating Remote Authentication ....................................................................................... 6-5
  Save Data ......................................................................................................................... 6-5
  Exporting File ................................................................................................................... 6-5
  Importing User List ......................................................................................................... 6-6
  Importing Group List ....................................................................................................... 6-6
  Importing Package List ................................................................................................... 6-6
  Editing a User ................................................................................................................... 6-6
  Deleting a User ................................................................................................................ 6-6
  Editing a Group ............................................................................................................... 6-7
  Deleting a Group .............................................................................................................. 6-7
  Editing a Package .......................................................................................................... 6-7
  Deleting a Package ........................................................................................................... 6-7

MultiUser Administrator ................................................................................................... 6-8
  Importing a Password ...................................................................................................... 6-8
  Disabling the Multi-user Feature .................................................................................... 6-9
  Enabling Remote Authentication .................................................................................... 6-9
  Disabling Remote Authentication .................................................................................... 6-9
  Enabling Data Separation ............................................................................................... 6-9
  Disabling Data Separation ............................................................................................... 6-10
  Delete User Data ............................................................................................................ 6-10
  Capturing a Log File ....................................................................................................... 6-10

AppLock Administrator ..................................................................................................... 6-11
  Enabling Application Lock ............................................................................................. 6-11
  Disabling Application Lock ............................................................................................ 6-11

Manual File Configuration ................................................................................................. 6-11
  Groups File ...................................................................................................................... 6-11
  White List File ............................................................................................................... 6-12
  Package List File ............................................................................................................ 6-13
  Groups File ...................................................................................................................... 6-13
  White List File ............................................................................................................... 6-13
  Determining Applications Installed on the Device .......................................................... 6-14
  Package List File ............................................................................................................ 6-15

Secure Storage .................................................................................................................... 6-16
  Installing a Key ............................................................................................................... 6-16
  Viewing Key List ............................................................................................................. 6-16
Deleting a Key ........................................................................................................ 6-17
Volumes ................................................................................................................. 6-17
    Creating Volume Using EFS File ................................................................. 6-17
    Creating a Volume Manually ......................................................................... 6-17
Mounting a Volume .............................................................................................. 6-18
Listing Volumes .................................................................................................... 6-18
Unmounting a Volume .......................................................................................... 6-18
Deleting a Volume ................................................................................................. 6-18
Creating an EFS File ............................................................................................ 6-18
Off-line Extraction Tool ...................................................................................... 6-19
Usage ..................................................................................................................... 6-19
Creating an Image ................................................................................................. 6-19
Mounting an Image .............................................................................................. 6-20
Unmounting an Image .......................................................................................... 6-20

Chapter 7: Application Deployment for Windows CE
Introduction ........................................................................................................... 7-1
Packaging .............................................................................................................. 7-1
Software Installation on Development PC .......................................................... 7-1
    Platform SDK ................................................................................................. 7-2
    EMDK for C .................................................................................................... 7-2
    Installing Other Development Software ....................................................... 7-3
Software Updates ................................................................................................. 7-3
Windows CE Flash Storage .................................................................................. 7-3
    FFS Partitions ............................................................................................... 7-3
    Working with FFS Partitions ......................................................................... 7-3
    RegMerge.dll ................................................................................................. 7-3
    CopyFiles ....................................................................................................... 7-4
    Non-FFS Partitions ......................................................................................... 7-4
Downloading Partitions to the MC92N0-G ......................................................... 7-5
Bootloader ............................................................................................................ 7-5
    Partition Update vs. File Update .................................................................. 7-5
    Upgrade Requirements .................................................................................. 7-5
Deployment ........................................................................................................... 7-5
Copying Files from a Host Computer ................................................................. 7-6
Adding Programs ................................................................................................. 7-7
    Adding a Program from the Internet .......................................................... 7-7
Updating Images ................................................................................................. 7-8
    Windows CE 7.0 OSUpdate Loader ............................................................ 7-8
    Bootloader ................................................................................................... 7-9
    Bootloader Error Detection ........................................................................ 7-13
Mobility Services Platform .................................................................................. 7-15
Creating a Splash Screen .................................................................................... 7-16

Chapter 8: Application Deployment for Windows Embedded Handhelds
Introduction ........................................................................................................... 8-1
Security .................................................................................................................. 8-1
Application Security ............................................................................................. 8-1
Chapter 9: Application Deployment for Android Devices

Security ......................................................................................................................... 9-1
Secure Certificates ........................................................................................................... 9-1
Installing a Secure Certificate ......................................................................................... 9-1
Development Tools .................................................................................................... 9-2
ADB USB Setup ........................................................................................................... 9-2
Application Installation .................................................................................................. 9-3
Installing Applications Using the USB Connection ...................................................... 9-3
Installing Applications Using an SD Card ................................................................ 9-4
Installing Applications Using the Android Debug Bridge ........................................ 9-4
Uninstalling an Application ........................................................................................ 9-5
System Update ................................................................................................................. 9-5
Storage ............................................................................................................................... 9-6
Random Access Memory ............................................................................................... 9-6
External Storage .............................................................................................................. 9-7
Internal Storage ............................................................................................................ 9-8
Enterprise Folder ........................................................................................................... 9-8
Chapter 10: DataWedge Configuration

### DataWedge Configuration

**Basic Scanning**
- Using the Imager ................................................................. 10-1
- Profiles .................................................................................. 10-1
- Profile0 .................................................................................. 10-2
- Plug-ins .................................................................................. 10-2
- Input Plug-ins ........................................................................ 10-2
- Process Plug-ins .................................................................... 10-3
- Output Plug-ins ...................................................................... 10-3
- Profiles Screen ....................................................................... 10-3
- Profile Context Menu ............................................................. 10-4
- Options Menu .......................................................................... 10-4
- Disabling DataWedge ............................................................ 10-5
- Creating a New Profile .......................................................... 10-5

### Profile Configuration

- Creating a New Profile .......................................................... 10-5
- Disabling DataWedge ............................................................ 10-5
- Options Menu .......................................................................... 10-4

### Profile Context Menu

- Defining a Rule ......................................................................... 10-27
- Deleting a Rule ........................................................................ 10-27
- Defining Criteria ...................................................................... 10-27
- Defining an Action ................................................................... 10-29
- Deleting a Rule ........................................................................ 10-29
- Order Rules List ...................................................................... 10-29
- Deleting an Action ................................................................... 10-31
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADF Example</td>
<td>10-31</td>
</tr>
<tr>
<td>DataWedge Settings</td>
<td>10-34</td>
</tr>
<tr>
<td>Importing a Configuration File</td>
<td>10-34</td>
</tr>
<tr>
<td>Exporting a Configuration File</td>
<td>10-34</td>
</tr>
<tr>
<td>Importing a Profile File</td>
<td>10-35</td>
</tr>
<tr>
<td>Exporting a Profile</td>
<td>10-35</td>
</tr>
<tr>
<td>Restoring DataWedge</td>
<td>10-35</td>
</tr>
<tr>
<td>Configuration and Profile File Management</td>
<td>10-35</td>
</tr>
<tr>
<td>Enterprise Folder</td>
<td>10-35</td>
</tr>
<tr>
<td>Auto Import</td>
<td>10-36</td>
</tr>
<tr>
<td>Programming Notes</td>
<td>10-36</td>
</tr>
<tr>
<td>Overriding Trigger Key in an Application</td>
<td>10-36</td>
</tr>
<tr>
<td>Capture Data and Taking a Photo in the Same Application</td>
<td>10-36</td>
</tr>
<tr>
<td>Soft Scan Feature</td>
<td>10-36</td>
</tr>
<tr>
<td>Sample</td>
<td>10-37</td>
</tr>
<tr>
<td>Scanner Input Plugin</td>
<td>10-37</td>
</tr>
<tr>
<td>Function Prototype</td>
<td>10-37</td>
</tr>
<tr>
<td>Parameters</td>
<td>10-37</td>
</tr>
<tr>
<td>Return Values</td>
<td>10-37</td>
</tr>
<tr>
<td>Example</td>
<td>10-38</td>
</tr>
<tr>
<td>Comments</td>
<td>10-38</td>
</tr>
<tr>
<td>Enumerate Scanners</td>
<td>10-38</td>
</tr>
<tr>
<td>Function Prototype</td>
<td>10-39</td>
</tr>
<tr>
<td>Parameters</td>
<td>10-39</td>
</tr>
<tr>
<td>Return Values</td>
<td>10-39</td>
</tr>
<tr>
<td>Example</td>
<td>10-40</td>
</tr>
<tr>
<td>Comments</td>
<td>10-40</td>
</tr>
<tr>
<td>Set Default Profile</td>
<td>10-40</td>
</tr>
<tr>
<td>Default Profile Recap</td>
<td>10-40</td>
</tr>
<tr>
<td>Usage Scenario</td>
<td>10-41</td>
</tr>
<tr>
<td>Function Prototype</td>
<td>10-41</td>
</tr>
<tr>
<td>Parameters</td>
<td>10-41</td>
</tr>
<tr>
<td>Return Values</td>
<td>10-41</td>
</tr>
<tr>
<td>Example</td>
<td>10-42</td>
</tr>
<tr>
<td>Comments</td>
<td>10-42</td>
</tr>
<tr>
<td>Function Prototype</td>
<td>10-43</td>
</tr>
<tr>
<td>Parameters</td>
<td>10-43</td>
</tr>
<tr>
<td>Return Values</td>
<td>10-43</td>
</tr>
<tr>
<td>Example</td>
<td>10-43</td>
</tr>
<tr>
<td>Comments</td>
<td>10-43</td>
</tr>
<tr>
<td>Profiles Recap</td>
<td>10-44</td>
</tr>
<tr>
<td>Usage Scenario</td>
<td>10-44</td>
</tr>
<tr>
<td>Function Prototype</td>
<td>10-44</td>
</tr>
<tr>
<td>Parameters</td>
<td>10-44</td>
</tr>
<tr>
<td>Return Values</td>
<td>10-45</td>
</tr>
<tr>
<td>Example</td>
<td>10-45</td>
</tr>
<tr>
<td>Comments</td>
<td>10-45</td>
</tr>
</tbody>
</table>
Appendix B: Using iDockIt

Introduction ..................................................................................................................... B-1
General Recommendations ............................................................................................... B-2
Prepare the MC92N0-G To Connect .............................................................................. B-2
   Enable iDockIt To Manage Connections Automatically .............................................. B-2
   Enable iDockIt To Manage Connections Manually ..................................................... B-2
Launch Application Upon Connection ........................................................................ B-3
View Connection Status ................................................................................................ B-3
Minimize iDockIt ............................................................................................................. B-3
Exit iDockIt .................................................................................................................... B-3
Windows Embedded Handheld Configuration ............................................................... B-4
   General Tab ................................................................................................................ B-4
   Ethernet Tab .............................................................................................................. B-5
   Direct Tab ................................................................................................................ B-6
   Modem Tab ................................................................................................................ B-7
      Create A New Modem Connection ........................................................................ B-8
      Edit an Existing Modem Connection .................................................................... B-9
      Delete an Existing Modem Connection ................................................................ B-9
Status Tab ..................................................................................................................... B-9
Windows CE Configuration ............................................................................................ B-11
   General Tab ................................................................................................................ B-11
   Ethernet Tab ............................................................................................................ B-12
   Direct Tab ................................................................................................................ B-13
      USB Notes ........................................................................................................... B-14
   Modem Tab ................................................................................................................ B-15
      Create A New Modem Connection ........................................................................ B-16
      Edit An Existing Modem Connection ................................................................ B-16
      Delete An Existing Modem Connection ................................................................ B-17
Status Tab ..................................................................................................................... B-17
Un-installing iDockIt ..................................................................................................... B-18

Appendix C: Special Software Configurations

Bluetooth Configuration Setting ..................................................................................... C-1
Sample Applications and StartUpCtl Configuration ..................................................... C-1
   StartUpCtl Application Configuration ..................................................................... C-2
   Removing Sample Applications and StartUpCtl Application .................................. C-2
Switching Between QVGA and VGA Resolution in Windows CE Devices ...................... C-2
Battery Usage Threshold Setting .................................................................................. C-3
   Registry Setting ...................................................................................................... C-4
WLAN Default Settings ................................................................................................. C-5
Shift Key Settings .......................................................................................................... C-5
Glossary

Index
ABOUT THIS GUIDE

Introduction

This guide provides information about setting up and configuring the MC92N0-G and accessories.

☑️  NOTE  Screens and windows pictured in this guide are samples and can differ from actual screens.

Documentation Set

The documentation set for the MC92N0-G is divided into guides that provide information for specific user needs.

- MC92N0-G Quick Start Guide - describes how to get the MC92N0-G mobile computer up and running.
- MC92N0-G User Guide - describes how to use the MC92N0-G mobile computer.
- MC92N0-G Integrator Guide - describes how to set up the MC92N0-G mobile computer and the accessories.
- MC92N0-G Regulatory Guide - provides all regulatory, service and EULA information for the MC92N0-G mobile computer.
- Enterprise Mobility Developer Kit (EMDK) Help File - provides API information for writing applications.
## Configurations

This guide covers the following configurations:

<table>
<thead>
<tr>
<th>Feature</th>
<th>MC9200 Premium with Android</th>
<th>MC9200 Premium with Windows</th>
<th>MC9200 Standard Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TI OMAP 4430 1GHz</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Radios</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WLAN: 802.11 a/b/g/n</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Memory</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 GB RAM / 2 GB Flash</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>512 MB RAM / 2 GB Flash</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Operating System</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Android 4.4</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Windows Embedded Handheld 6.5.3</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Microsoft Windows Embedded Compact 7</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Display</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.7” VGA color</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>3.7” QVGA color</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Data Capture</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SE4750-SR Standard Range Imager</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>SE4750-MR Mid-Range Imager</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>SE-965 Standard Range Laser</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>SE4500-DL Driver License Imager</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>SE4500-SR Standard Range Imager</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>SE4500-HD High Density Imager (DPM)</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>SE1524-ER Extended Range Laser</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>SE4600-LR Long Range Imager</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>SE4850-ER Extended Range Imager</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Keypads</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>53, 53 VT, 5250, 3270, 28, 43</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>53 key High Visibility</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Audio</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 Watt Speaker</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IST, RFID tag</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Condensation Resistant Option</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
Software Versions

Windows Mobile and Windows CE

This guide covers various software configurations and references are made to operating system or software versions for:

- Adaptation Kit Update (AKU) version
- OEM version
- BTExplorer version
- Fusion version.

AKU Version for Windows Embedded Handheld Devices

To determine the Adaptation Kit Update (AKU) version on a Windows Embedded Handheld device, tap Start > Settings > System > About > Version.

The second line lists the operating system version and the build number. The last part of the build number represents the AKU number. For example, Build 59128.5.12.16 indicates that the device is running AKU version 5.12.16.

OEM Version

To determine the OEM software version:

On Windows Embedded Handheld devices, tap Start > Settings > System > System Information > System.

On Windows CE devices, tap Start > Settings > Control Panel > System Information > System.

BTExplorer Software

By default, the Microsoft Bluetooth stack is enabled. BTExplorer application is only available when the StoneStreet One Bluetooth stack is enabled. See Appendix C, Special Software Configurations for information on selecting the Bluetooth stack.

To determine the BTExplorer software version:

On Windows Embedded Handheld devices, tap Start > BTExplorer > Menu > About.

On Windows CE devices, tap BTExplorer icon > Show BTExplorer > File > About.
Fusion Software

To determine the Fusion software version:


On Windows CE devices, tap Wireless Strength > Wireless Status > Versions or tap Start > Programs > Fusion > Wireless Status > Versions.

Android

To determine the current software versions touch > About device.

- **Serial number** - Displays the serial number.
- **Model number** - Displays the model number.
- **Android version** - Displays the operating system version.
- **Kernel version** - Displays the kernel version number.
- **Build number** - Displays the software build number.

---

**Chapter Descriptions**

Topics covered in this guide are as follows:

- **Chapter 1, Getting Started**, provides information on setting up the MC92N0-G.
- **Chapter 2, Accessories**, describes the accessories available for the MC92N0-G and how to set up power connections and battery charging capabilities, where applicable.
- **Chapter 3, Synchronization**, provides instructions on installing ActiveSync and setting up a partnership between the MC92N0-G and a host computer.
- **Chapter 4, USB Communication** describes how to connect the MC92N0-G with Android to a host computer using USB.
- **Chapter 5, Wireless Applications**, provides instructions using and configuring the MC92N0-G on a wireless network.
- **Chapter 6, Administrator Utilities**, provides information for using the suite of administrative tools for configuring the TC8000.
- **Chapter 7, Application Deployment for Windows CE**, describes new features in Windows CE 7.0 including how to package applications, and procedures for deploying applications onto the MC92N0-G.
- **Chapter 8, Application Deployment for Windows Embedded Handhelds**, describes new features in Windows Embedded Handheld including new security features, how to package applications, and procedures for deploying applications onto the MC92N0-G.
- **Chapter 9, Application Deployment for Android Devices**, provides instructions for developing and managing applications.
- **Chapter 10, DataWedge Configuration**, describes how to use and configure the DataWedge application.
- **Chapter 11, Interactive Sensor Technology Configuration**, describes how to configure interactive sensing technology on the MC92N0-G.
• **Chapter 12, Maintenance and Troubleshooting**, includes instructions on cleaning and storing the MC92N0-G, and provides troubleshooting solutions for potential problems during MC92N0-G operation.

• **Appendix A, Technical Specifications**, includes a table listing the technical specifications for the MC92N0-G.

• **Appendix B, Using iDockIt**, provides iDockIt software operating instructions.

• **Appendix C, Special Software Configurations**, provides information for configuring sample applications.

---

**Notational Conventions**

The following conventions are used in this document:

• “Mobile computer” refers to the Zebra MC92N0-G hand-held computer.

• *Italics* are used to highlight the following:
  • Chapters and sections in this guide
  • Related documents

• **Bold** text is used to highlight the following:
  • Dialog box, window and screen names
  • Drop-down list and list box names
  • Check box and radio button names
  • Icons on a screen
  • Key names on a keypad
  • Button names on a screen.

• Bullets (•) indicate:
  • Action items
  • Lists of alternatives
  • Lists of required steps that are not necessarily sequential.

• Sequential lists (e.g., those that describe step-by-step procedures) appear as numbered lists.

---

**Related Documents and Software**

The following documents provide more information about the MC92N0-G.

• **MC92N0-G Quick Start Guide**, p/n 72-161751-xx

• **MC92N0-G Regulatory Guide**, p/n 72-161752-xx

• **MC92N0-G User Guide**, p/n 72E-162536-xx

• **Enterprise Mobility Developer Kits**, available at: [http://www.zebra.com/support](http://www.zebra.com/support)

• Platform SDK (PSDK92N0c70) for MC92N0-G with Windows CE 7.0, available at: [http://www.zebra.com/support](http://www.zebra.com/support)


For the latest version of this guide and all guides, go to: [http://www.zebra.com/support](http://www.zebra.com/support).
Service Information

If you have a problem with your equipment, contact the Zebra Global Interactive Center, for your region. Go to http://www.zebra.com/support. If you purchased your Zebra product from a Zebra Business Partner, contact that Business Partner for service.

Before contacting, have the model number and serial number at hand. If your problem cannot be solved by the Zebra Global Interactive Center, you may need to return your equipment for servicing and you will be given specific directions.

Zebra is not responsible for any damages incurred during shipment if the approved shipping container is not used. Shipping the units improperly can possibly void the warranty.
CHAPTER 1 GETTING STARTED

Introduction
This chapter provides information for setting up the MC92N0-G.

Unpacking the MC92N0-G
Carefully remove all protective material from around the MC92N0-G and save the shipping container for later storage and shipping.

Verify that you received all equipment listed below:

- MC92N0-G
- lithium-ion battery
- strap, attached to the MC92N0-G
- stylus, in the stylus silo
- Regulatory Guide.

Inspect the equipment for damage. If you are missing any equipment or if you find any damaged equipment, contact the Zebra Support Center immediately. See Service Information on page xxii for contact information.

Configuring the MC92N0-G

- To set up ActiveSync to synchronize the MC92N0-G with the host computer, see Chapter 3, Synchronization.
- To configure the MC92N0-G for wireless LAN network, see Chapter 5, Wireless Applications.
- To deploy software on the MC92N0-G, see Chapter 7, Application Deployment for Windows CE or Chapter 8, Application Deployment for Windows Embedded Handhelds.
Resetting the MC92N0-G

Windows CE Devices

There are two reset functions, warm boot and cold boot. A warm boot restarts the MC92N0-G by closing all running programs.

A cold boot also restarts the MC92N0-G, but erases all stored records and entries in RAM. Data saved in flash memory or a memory card is not lost. In addition it returns formats, preferences and other settings to the factory default settings.

Perform a warm boot first. This restarts the MC92N0-G and saves all stored records and entries. If the MC92N0-G still does not respond, perform a cold boot.

Performing a Warm Boot

Hold down the Power button for approximately five seconds. As soon as the MC92N0-G starts to perform a warm boot release the Power button.

Performing a Cold Boot

A cold boot restarts the MC92N0-G and erases all user stored records and entries that are not saved in flash memory (Application and Platform folders) or a memory card. Never perform a cold boot unless a warm boot does not solve the problem.

CAUTION Do not hold down any key, other than the Power button during a reset. Performing a cold boot restores formats, preferences and other settings to the default settings.

NOTE Any data previously synchronized with a computer can be restored during the next ActiveSync operation.

To perform a cold boot:

1. Press the primary battery release on the MC92N0-G to partially eject the battery from the MC92N0-G.
2. While the battery is partially released, simultaneously press and release the handle trigger and the Power button.
3. Push the battery to fully re-insert it in the MC92N0-G. One audible click can be heard as the battery is fully inserted.
4. The MC92N0-G initializes.
5. Calibrate the screen.

Windows Embedded handheld Devices

There are three reset functions, warm boot, cold boot and clean boot.

- A warm boot restarts the MC92N0-G and closes all running programs.
- A cold boot also restarts the MC92N0-G and closes all running programs but also resets the Real-Time-Clock (RTC).
- A clean boot resets the MC92N0-G to the factory default settings.

Data saved in flash memory or a memory card is not lost. Perform a warm boot first. This restarts the MC92N0-G and saves all stored records and entries. If the MC92N0-G still does not respond, perform a cold boot.
Performing a Warm Boot

Hold down the Power button for approximately five seconds. As soon as the MC92N0-G starts to perform a warm boot release the Power button.

Performing a Cold Boot

A cold boot restarts the MC92N0-G. The operating system and all applications are restarted. File storage is preserved. The Real-Time-Clock (RTC) resets. Only perform a cold boot if a warm boot does not solve the problem.

To perform a cold boot:

1. Press the primary battery release on the MC92N0-G to partially eject the battery from the MC92N0-G.
2. While the battery is partially released, simultaneously press and release the trigger and the Power button.
3. Push the battery to fully re-insert it in the MC92N0-G. One audible click can be heard as the battery is fully inserted.
4. The MC92N0-G initializes.

Performing a Clean Boot

**CAUTION** A clean boot should only be performed by an authorized system administrator. You must connect the MC92N0-G to AC power during a clean boot.

Removing AC power from the MC92N0-G during a clean boot may render the MC92N0-G inoperable.

A clean boot resets the MC92N0-G to the factory default settings. All data is the Application folder is retained. You must download the Clean Boot Package file from the Zebra Support Central and install on the MC92N0-G.

To perform a clean boot:

1. Download the Clean Boot Package from the Zebra Support Central. Follow the instructions included in the package for installing the package onto the MC92N0-G.
2. Press the primary battery release on the MC92N0-G to partially eject the battery from the MC92N0-G.
3. While the battery is partially released, simultaneously press and release the trigger and the Power button.

4. Push the battery to fully re-insert it in the MC92N0-G. One audible click can be heard as the battery is fully inserted.
5. Press and hold the trigger.
6. Connect the MC92N0-G to AC power using the CAM or insert the MC92N0-G into a powered cradle.
7. The MC92N0-G updates and then re-boots.
8. The calibration screen appears.

Reset The Device Android

There are four reset functions:

- Soft reset
Performing a Soft Reset

Perform a soft reset if applications stop responding.

1. Press and hold the soft power button \( \text{_until the menu appears.} \)
2. Touch Reset.
3. The device reboots.

Performing a Hard Reset

CAUTION Performing a hard reset with a SD card installed in the MC9200 may cause damage or data corruption to the SD card.

To perform a hard reset (if the device is completely non-responsive, skip steps 1 and 2).

1. Press the red Power button.
2. Tap Safe Battery Swap. The Indicator LED Bar lights red.
3. Press the primary battery release on the MC92N0-G to partially eject the battery from the MC92N0-G.
4. While the battery is partially released, simultaneously press and release the trigger and the Power button.
5. Push the battery to fully re-insert it in the MC92N0-G. One audible click can be heard as the battery is fully inserted.
6. The MC92N0-G reboots.
7. When the screen turns off, release the buttons.
8. The MC9200 reboots.

Performing an Enterprise Reset

An Enterprise Reset erases all data in the /cache and /data partitions and clears all device settings, except those in the /enterprise partition.

Before performing an Enterprise Reset, copy all applications and the key remap configuration file that you want to persist after the reset into the /enterprise/usr/persist folder.

1. Download the Enterprise Reset file from the Support Central web site.
2. Copy the \text{M92N0KXXXRExxxxxxx.zip} file to the root of the Internal Storage (see Chapter 4, USB Communication) or an SD card.
3. Press the red Power button.
4. Touch Reset.
5. Press and hold the trigger.
6. When the System Recovery screen appears, release the trigger.
Performing a Factory Reset

A Factory Reset erases all data in the /cache, /data and /enterprise partitions in internal storage and clears all device settings. A Factory Reset returns the device to the last installed operating system image. To revert to a previous operating system version, re-install that operating system image. See System Update on page 9-5.

1. Download the Factory Reset file from the Support Central web site.
2. Copy the M92N0KXXXRFxxxxxxx.zip file to the root of the Internal Storage (see Chapter 4, USB Communication) or an SD card.
3. Press the red Power button.
4. Touch Reset.
5. Press and hold the trigger.
6. When the System Recovery screen appears, release the trigger.

7. Use the arrow key to select apply update from emulated storage or apply update from sdcard.
8. Press the Enter key.
9. Use the arrow key to select M92N0KXXXRFxxxxxxxx.zip file is highlighted.
10. Press the Enter key. The Factory Reset occurs and then the device resets.

Battery Management

Battery Saving Tips

• Set the MC92N0-G to turn off after a short period of non-use.
• Set the display to turn off or dim the backlight.
• Set the keyboard backlight to turn off after a short period of non-use.
• Turn off all wireless radio activity when not in use.
• Power off the MC92N0-G when charging to charge at a faster rate.

Changing the Power Settings

To set the MC92N0-G to turn off after a short period of non-use:

   or
   On Windows Embedded Handheld devices, tap Start > Settings > System > Power > Advanced.
2. Select the On battery power: Turn off device if not used for: check box and select a value from the drop-down list box.
3. Tap OK.

Changing the Display Backlight Settings

To change the display backlight settings in order to conserve more battery power:

   or
   On Windows Embedded Handheld devices, tap Start > Settings > System > Backlight > Battery Power.
2. Select the On battery power: Disable backlight if not used for: check box and select a value from the drop-down list box.
3. Tap Brightness.
4. Tap the Disable backlight check box to completely turn off the display backlight.
5. Tap the Persist ‘Disable backlight’ setting over reset check box to ensure that the Disable backlight setting is set after a reset.
6. Use the slider to set the brightness of the backlight. Set it to a low value to save battery power.
7. Tap OK.

Changing the Display Brightness

![NOTE Android Devices only.]

To change the display brightness in order to conserve more battery power:

1. Touch > Display > Brightness.

![Figure 1-3  Brightness Dialog Box]

2. In the Brightness dialog box, use the slider to set a brightness level.
3. Touch .

Changing the Keypad Backlight Settings

Windows Devices

To change the keypad backlight settings in order to conserve more battery power:

   or
   On devices with Windows Mobile 6.5, tap Start > Settings > System > Keylight > Battery Power.
2. Select the On battery power: Disable keylight if not used for: check box and select a value from the drop-down list box.
3. Tap the Advanced.
4. Tap the Disable keylight check box to completely turn off the display backlight.
5. Tap the Persist 'Disable keylight' setting over reset check box to ensure that the Disable keylight setting is set after a reset.
6. Tap the Track Backlight State check box to (need information for this).
7. Tap OK.

Android Devices

To change the keypad backlight settings in order to conserve more battery power:

1. Touch > Display > Key light.
2. Select one of the options.
   - Always on - The touch key light is on when the screen is on.
• **6 seconds** - The touch key light stays on for six seconds then turns off (default).
• **10 seconds** - The touch key light stays on for 10 seconds then turns off.
• **15 seconds** - The touch key light stays on for 15 seconds then turns off.
• **30 seconds** - The touch key light stays on for 30 seconds then turns off.
• **1 minute** - The touch key light stays on for one minute then turns off.

3. Touch 🛋️.

---

**Turning Off the Radios**

**On Windows Embedded Handheld Devices**

Windows Embedded Handheld devices include **Wireless Manager**, which provides a simple method of enabling, disabling, and configuring all the device’s wireless capabilities in one place.

To open **Wireless Manager**, tap the Start Bar and then tap on the **Connectivity icon**.

Select **Wireless Manager**.

![Wireless Manager Window](image)

**Figure 1-4**  *Wireless Manager Window*

To enable or disable a wireless connection, tap its blue bar.

To enable or disable all wireless connections, tap and hold the **All** bar.

To configure settings for a connection, tap **Menu**.

**On Windows CE Devices**

**WLAN Radio**

To turn off the WLAN radio, tap the **Wireless Connection Status** icon on the task tray and select **Disable Radio**. A red X appears across the icon indicating that the radio is disabled (off).
To turn the radio back on, tap the Wireless Connection Status icon on the task tray and select Enable Radio. The red X disappears from the icon indicating that the radio is enabled (on).

**Bluetooth Radio**

To turn off the Bluetooth radio, tap Bluetooth icon in the task tray and select Disable Bluetooth.

To turn on the Bluetooth radio, tap Bluetooth icon in the task tray and select Enable Bluetooth.

**On Android Devices**

To turn off all the radio:

1. Drag the Status bar down from the top of the screen. The Quick Settings icon displays in the top right corner.
2. Touch to display the Quick Settings panel.
3. Touch Airplane Mode.

Drag the bottom of the Quick Settings Panel to the top of the screen to close the Quick Settings screen.


CHAPTER 2 ACCESSORIES

Introduction

Table 2-1 lists the accessories available for the MC92N0-G.

Table 2-1  MC92N0-G Accessories

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cradles</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Single Slot Serial/USB Cradle</td>
<td>CRD9000-1001SR</td>
<td>Charges the MC92N0-G main battery and a spare battery. It also synchronizes the MC92N0-G with a host computer through either a USB connection.</td>
</tr>
<tr>
<td>Four Slot Charge Only Cradle</td>
<td>CRD9101-4001CR</td>
<td>Charges the MC92N0-G main battery.</td>
</tr>
<tr>
<td>Four Slot Ethernet Cradle</td>
<td>CRD9101-4001ER</td>
<td>Charges the MC92N0-G main battery and synchronizes the MC92N0-G with a host computer through an Ethernet connection.</td>
</tr>
<tr>
<td>Fork Lift Cradle</td>
<td>FLC9000-1000R</td>
<td>Provides secure mounting solution for the MC92N0-G. The cradle is equipped with rugged RS232 and USB ports which are capable of powering and communicating with tethered devices.</td>
</tr>
<tr>
<td>Chargers</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Four Slot Spare Battery Charger</td>
<td>SAC9000-4000R</td>
<td>Charges up to four MC92N0-G spare batteries.</td>
</tr>
<tr>
<td>Universal Battery Charger Adapter</td>
<td>21-32665-48R</td>
<td>Charges an spare battery as a stand-alone charger or with the UBC2000 base.</td>
</tr>
<tr>
<td>UBC Four Slot Base</td>
<td>UBC2000-I500DR</td>
<td>Charges up to four batteries using the UBC adapter.</td>
</tr>
</tbody>
</table>
Table 2-1  **MC92N0-G Accessories**  

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>12 Volt Auto Charge Cable</td>
<td>VCA9001-12R</td>
<td>Plugs into a 12 volt cigarette lighter to charge the MC92N0-G while on the road. Requires the Cable Adapter (ADP9000-100R).</td>
</tr>
<tr>
<td>24 Volt Auto Charge Cable</td>
<td>VCA9000-24R</td>
<td>Plugs into a 24 volt cigarette lighter to charge the MC92N0-G while on the road. Requires the Cable Adapter (ADP9000-100R).</td>
</tr>
<tr>
<td>Spare lithium-ion battery</td>
<td>BTRY-MC9X-26MA-01</td>
<td>Replacement battery.</td>
</tr>
<tr>
<td>Power Supply</td>
<td>PWRS-14000-148R</td>
<td>Provides power to the Single Slot Serial/USB cradle. 100 - 240 VAC input, 12 VDC 3.33 A output.</td>
</tr>
<tr>
<td>Power Supply</td>
<td>PWRS-14000-241R</td>
<td>Provides power to the Four Slot Charge Only cradle and Four Slot Ethernet cradle. 90 - 264 VAC input, 12 VDC 9 A output.</td>
</tr>
<tr>
<td>Fork Lift High Voltage Power Converter</td>
<td>PWRS-14000-251R</td>
<td>Provides power to the Fork Lift Cradle.</td>
</tr>
<tr>
<td>Fork Lift Low Voltage Power Converter</td>
<td>PWRS-14000-252R</td>
<td>Provides power to the Fork Lift Cradle.</td>
</tr>
<tr>
<td>Cables</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DC Line Cord</td>
<td>50-16002-029R</td>
<td>Provides power from the power supply to the Four Slot Charge Only and Ethernet cradles.</td>
</tr>
<tr>
<td>DC Line Cord</td>
<td>25-72614-01R</td>
<td>Provides power from power supply to the Four Slot Charge Only and Four Slot Ethernet cradles.</td>
</tr>
<tr>
<td>Fork Lift Power Input Cable</td>
<td>25-103872-01R</td>
<td>Provides power from the power supply to the Fork Lift Cradle.</td>
</tr>
<tr>
<td>USB Sync Cable</td>
<td>25-64396-01R</td>
<td>Provides USB communication with a host computer through the Single Slot Serial/USB cradle.</td>
</tr>
<tr>
<td>USB Cable</td>
<td>25-62166-01R</td>
<td>Provides USB communication to the host through the Cable Adapter Module (ADP9000-100R).</td>
</tr>
<tr>
<td>DEX Cable with Floating Jack Screws</td>
<td>25-62167-03R</td>
<td>Provides electronic data exchange to the host through the Cable Adapter Module (ADP9000-100R).</td>
</tr>
<tr>
<td>Paxar Printer Cable</td>
<td>25-62168-01R</td>
<td>Connects the MC92N0-G to a Paxar printer.</td>
</tr>
<tr>
<td>O’Neil Printer Cable</td>
<td>25-62169-01R</td>
<td>Connects the MC92N0-G to an O’Neil printer.</td>
</tr>
<tr>
<td>Zebra Printer Cable</td>
<td>25-62170-02R</td>
<td>Connects the MC92N0-G to a Zebra printer.</td>
</tr>
</tbody>
</table>
## Table 2-1  MC92N0-G Accessories

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modem Cable</td>
<td>25-63856-01R</td>
<td>Allows the Single Slot Serial/USB cradle to be used as a modem cradle.</td>
</tr>
<tr>
<td>Serial Cable</td>
<td>25-63852-01R</td>
<td>Provides serial communication from the Single Slot Serial/USB cradle to a host computer.</td>
</tr>
<tr>
<td>USB Cable</td>
<td>25-71918-01R</td>
<td>USB cable for FLC9000-1001R.</td>
</tr>
<tr>
<td>Serial Cable</td>
<td>25-71917-01R</td>
<td>Serial cable for FLC9000-1001R.</td>
</tr>
<tr>
<td>Soft Goods</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Holster</td>
<td>SG-MC91212112-01R</td>
<td>Holds the MC92N0-G when not in use.</td>
</tr>
<tr>
<td>Heated Boot</td>
<td>SG-MC9024242-01R</td>
<td>Maintains operating temperature of the MC92N0-G when in a freezer environment.</td>
</tr>
<tr>
<td>Handstrap</td>
<td>KT-66447-03R</td>
<td>Package of 3 handstraps.</td>
</tr>
<tr>
<td>Belt</td>
<td>11-08062-02R</td>
<td>For use with holster.</td>
</tr>
<tr>
<td>Protective Boot</td>
<td>11-67218-04R</td>
<td>Provides additional protection for MC9XXX-G configurations.</td>
</tr>
<tr>
<td>Shoulder Strap</td>
<td>58-40000-007R</td>
<td>Universal shoulder strap for holster.</td>
</tr>
<tr>
<td>Snap-on</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cable Adapter Module (CAM)</td>
<td>ADP9000-120R</td>
<td>Attaches to the bottom of the MC92N0-G and provides power (5 VDC 350 mA) for use to cable to Apriva BT200 Reader.</td>
</tr>
<tr>
<td>Cable Adapter Module (CAM)</td>
<td>ADP9000-110R</td>
<td>Attaches to the bottom of the MC92N0-G and provides power (5 VDC 350 mA) for use with the LS3408ER scanner.</td>
</tr>
<tr>
<td>Cable Adapter Module (CAM)</td>
<td>ADP9000-100R</td>
<td>Attaches to the bottom of the MC92N0-G and provides power for operating change charging the MC92N0-G and provides serial communication.</td>
</tr>
<tr>
<td>Keypads</td>
<td></td>
<td></td>
</tr>
<tr>
<td>28-key keypad</td>
<td>KYPD-MC9XMR000-01R</td>
<td>Replacement 28-key keypad.</td>
</tr>
<tr>
<td>53-key keypad</td>
<td>KYPD-MC9XMS000-01R</td>
<td>Replacement 53-key keypad.</td>
</tr>
<tr>
<td>43-key keypad</td>
<td>KYPD-MC9XMT000-01R</td>
<td>Replacement 43-key keypad.</td>
</tr>
<tr>
<td>53-key VT keypad</td>
<td>KYPD-MC9XMU000-01R</td>
<td>Replacement 53-key VT keypad.</td>
</tr>
<tr>
<td>53-key 3270 keypad</td>
<td>KYPD-MC9XMV000-01R</td>
<td>Replacement 53-key 3270 keypad.</td>
</tr>
<tr>
<td>53-key 5250 keypad</td>
<td>KYPD-MC9XMW000-01R</td>
<td>Replacement 53-key 5250 keypad.</td>
</tr>
</tbody>
</table>
### Table 2-1  MC92N0-G Accessories

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>53-key High Visibility keypad</td>
<td>KYPD-MC9XMS000-01R</td>
<td>Replacement 53-key white key keypad.</td>
</tr>
<tr>
<td><strong>Miscellaneous</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MC90XX Wall Mounting Bracket</td>
<td>KT-61498-01R</td>
<td>Order one for Single Slot cradle and one for the SAC9000. Order two for Four Slot Cradles. Order Cradle Bracket separately to attach to the wall mount bracket.</td>
</tr>
<tr>
<td>MC90XX Cradle Bracket</td>
<td>KT-61499-01R</td>
<td>Order one for Single Slot cradle and one for the SAC9000. Order two for Four Slot Cradles. Attaches to the bottom of the cradle.</td>
</tr>
<tr>
<td>Screen Protector</td>
<td>KT-151827-03R</td>
<td>Adds an additional level of protection for the MC9XXX screen to protect against scratches. (3-pack).</td>
</tr>
<tr>
<td>Stylus Kit</td>
<td>KT-81680-50R</td>
<td>Replacement gray stylus with tether for MC92N0-G (50-pack).</td>
</tr>
<tr>
<td>Stylus Kit</td>
<td>KT-81680-03R</td>
<td>Replacement gray stylus with tether for MC92N0-G (3-pack).</td>
</tr>
<tr>
<td>Belt Clip</td>
<td>KT-70147-01R</td>
<td>Attaches to a user’s belt.</td>
</tr>
<tr>
<td>Rugged Cable Headset</td>
<td>RCH51</td>
<td>Rugged headset</td>
</tr>
<tr>
<td>RCH51 Adapter Cable</td>
<td>25-124387-01R</td>
<td>RCH50 adapter cable for standard 3-pole, 2.5mm barrel jack used with MC92N0-G.</td>
</tr>
<tr>
<td>Stylus Kit</td>
<td>KT-68144-10R</td>
<td>Replacement gray stylus for MC92N0-G (10-pack).</td>
</tr>
<tr>
<td>Stylus Kit</td>
<td>KT-68144-50R</td>
<td>Replacement gray stylus for MC92N0-G (50-pack).</td>
</tr>
</tbody>
</table>
Keypads

The MC92N0-G has interchangeable modular keypads. The modular keypads can be changed in the field as necessary to support specialized applications.

\[\text{NOTE}\] Do not remove the keypad while the MC92N0-G is on and do not operate the MC92N0-G with the keypad detached. Follow proper Electro-Static Discharge (ESD) precautions to avoid damaging the SD card. Proper ESD precautions include, but are not limited to, working on an ESD mat and ensuring that the operator is properly grounded.

Replacing the Keypad

1. Press the \textbf{Power} button to suspend the MC92N0-G.
2. Remove the two keypad screws. Slide the keypad down and lift up.

\[\text{CAUTION}\] Do not apply more than 4 in-lbs of torque when tightening the keypad screws.

3. Replace the keypad and re-attach using the two screws.
Figure 2-2  Installing the Keypad

4. Perform a warm boot.

Secure Device (SD) Card

The SD card provides secondary non-volatile storage. The SD card is located under the keypad (see Figure 2-1).

CAUTION Do not remove the keypad while the MC92N0-G is on and do not operate the MC92N0-G with the keypad detached. Follow proper ESD precautions to avoid damaging the SD card. Proper ESD precautions include, but are not limited to, working on an ESD mat and ensuring that the operator is properly grounded.

To insert the SD card:

1. Press the Power button to suspend the MC92N0-G.
2. Remove the two keypad screws and slide the keypad down and lift off (see Figure 2-1 on page 2-5).
3. Lift the SD card retaining door.
4. Position the SD card, with the contacts down, into the SD card holder. The SD card corner notch fits into the holder only one way.
5. Snap the retaining door closed.
Figure 2-3  Inserting the SD Card

CAUTION Do not apply more than 4 in-lbs of torque when tightening the keypad screws.

6. Replace the keypad and re-attach using the two screws (see Figure 2-2 on page 2-6).
7. Perform a warm boot.
This section describes how to set up and use a single Single Slot Serial/USB cradle with the MC92N0-G. For USB communication setup procedures see *Serial Communication Setup on page 2-30*.

The Single Slot Serial/USB Cradle:

- Provides 15VDC power for operating the MC92N0-G.
- Provides USB ports for data communication between the MC92N0-G and a host computer or other devices (e.g., a printer).
- Synchronizes information between the MC92N0-G and a host computer. (With customized or third party software, it can also be used to synchronize the MC92N0-G with corporate databases.)
- Charges the MC92N0-G’s battery.

**CAUTION** Ensure that you follow the guidelines for battery safety described in *Battery Safety Guidelines on page 12-1*.

CAUTION Do not place coins, keys or paper clips in cradle well.

**NOTE** When an MC92N0-G with Windows Embedded Handheld is placed in the cradle and an ActiveSync connection is made, the WLAN radio is disabled. This is a Microsoft security feature to prevent connection to two networks at the same time.
Setup

- Charges a spare battery.

**NOTE** Only USB is supported with the MC92N0-G.

![Diagram](image)

**Table 2-2** MC92N0-G LED Charging Indicators

<table>
<thead>
<tr>
<th>Spare Battery LED (on cradle)</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>MC92N0-G is not in the cradle or connected to a CAM. MC92N0-G is not placed correctly in the cradle. Charger is not powered. No spare battery in well; spare battery not placed correctly; cradle is not powered.</td>
</tr>
<tr>
<td>Fast Blinking Amber</td>
<td>Error in charging; check placement of the MC92N0-G.</td>
</tr>
<tr>
<td>Slow Blinking Amber</td>
<td>MC92N0-G is charging.</td>
</tr>
<tr>
<td>Solid Amber</td>
<td>Charging is complete. Note: When the battery is initially inserted in the MC92N0-G, the amber LED flashes once if the battery power is low or the battery is not fully inserted.</td>
</tr>
<tr>
<td>Spare Battery LED (on cradle)</td>
<td>Indication</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Off</td>
<td>No spare battery in well; spare battery not placed correctly; cradle is not powered.</td>
</tr>
<tr>
<td>Fast Blinking Amber</td>
<td>Error in charging; check placement of spare battery.</td>
</tr>
<tr>
<td>Slow Blinking Amber</td>
<td>Spare battery is charging.</td>
</tr>
<tr>
<td>Solid Amber</td>
<td>Charging complete.</td>
</tr>
</tbody>
</table>
Four Slot Ethernet Cradle CRD9000-4000ER

**CAUTION** Ensure that you follow the guidelines for battery safety described in *Battery Safety Guidelines on page 12-1*.

This section describes how to set up and use a Four Slot Ethernet cradle, p/n CRD9000-4000ER, with the MC92N0-G. For cradle communication setup procedures see *Ethernet Communication Setup on page 2-13*.

The Four Slot Ethernet cradle:

- Provides 12VDC power for operating the MC92N0-G.
- Enables data communication between the MC92N0-G (up to four) and a host computer, over an Ethernet network (using a standard Ethernet cable).
- Synchronizes information between the MC92N0-G and a host computer. (With customized or third party software, it can also be used to synchronize the MC92N0-G with corporate databases.)
- Simultaneously charges up to four batteries in the MC92N0-G.

**CAUTION** Do not place coins, keys or paper clips in cradle well.

![Four Slot Ethernet Cradle](image)
Table 2-4  Communication LED

<table>
<thead>
<tr>
<th>Status</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>MC92N0-G is not in cradle; MC92N0-G not placed correctly; cradle is not powered.</td>
</tr>
<tr>
<td>Solid Red</td>
<td>MC92N0-G is present, but communication has not started.</td>
</tr>
<tr>
<td>Flashing Green</td>
<td>MC92N0-G is in the cradle, and communicating with the host computer.</td>
</tr>
<tr>
<td>Slow Flashing Red</td>
<td>Error, communication did not start.</td>
</tr>
<tr>
<td>Fast Flashing Red</td>
<td>Warning: Terminal inactivity time-out. The terminal did not finish data synchronization or had an open connection for more than 15 minutes. This time is programmable in the cradle flash parameters.</td>
</tr>
<tr>
<td>Solid Green</td>
<td>Terminal is present in the slot and communication is complete.</td>
</tr>
<tr>
<td>All LEDs Flashing Red</td>
<td>Failed automatic cradle configuration via local DHCP Service.</td>
</tr>
</tbody>
</table>

Setup

**NOTE** The Four Slot Ethernet cradle must be connected to a power source and to an Ethernet Hub (when applicable).

![Diagram of Four Slot Ethernet Cradle Power Connection]

**Figure 2-7  Four Slot Ethernet Cradle Power Connection**

**Battery Charging Indicators**

The MC92N0-G’s amber charge LED, located in the Indicator LED Bar, shows the status of the battery charging in the MC92N0-G. See Table 2-2 for charging status indications. The battery usually charges in less than four hours.
Ethernet Communication Setup

To establish a connection between the MC92N0-G and the host computer to communicate over an Ethernet network, perform the following:

- Install MobileDox Cradle Manager
- Install iDockIt
- Configure the MC92N0-G
- Configure the host computer
- Configure the DHCP server
- Configure the cradle.

Installing MobileDox Cradle Manager

*NOTE* MobileDox Cradle Manager is used only when establishing a connection using the Four Slot Ethernet cradle.

The Cradle Management software features:

- View cradles that are attached to the network via MobileDox Net
- View cradle status
- Modify cradle settings including:
  - IP address settings
  - DNS and WINS settings
  - Identification settings
  - USB port specific settings
- Restart cradles connected to the network via MobileDox Net
- Update the firmware of MobileDox Net.

To install the Cradle Management Software on the host computer, download the latest version of the software from [http://www.zebra.com/support](http://www.zebra.com/support). Refer to the instructions included with the software.

Installing iDockIt

*iDockIt* is a connection utility which manages activities between the MC92N0-G and a connected Ethernet cradle. For more information on the utility, see the documentation provided with *iDockIt*.

*iDockIt* features:

- The ability to manage multiple cradle profiles. *iDockIt* auto-detects the cradle communication type and behaves accordingly.
- Integrated modem capabilities using TAPI interface.
- Runs as a tray application, and always runs in the background.
- The ability to configure settings within the application.
- Options to change parameters upon docking (with or without settings time-out).
- The ability to force synchronization events.
- The ability to disable WLAN connection on the device to ensure synchronization is performed via dock.
- Management of multiple connection types without losing settings.
To install iDockIt on the MC92N0-G download the latest version of the iDockIt software from http://www.zebra.com/support to the host computer. Follow the instructions provided with the iDockIt software to install iDockIt onto the MC92N0-G.

Refer to Appendix B, Using iDockIt for instructions on configuring and using iDockIt.

**MC92N0-G Configuration**

Inserting the MC92N0-G into the cradle provides direct-connect Remote Access Service (RAS) service. Configure each MC92N0-G for use with the cradle, just as any remote client would be configured to connect to an Internet Service Provider (ISP). The computer comm port setting was set to USB during the iDockIt installation procedure.

**DHCP Server Configuration**

If you use a DHCP server to distribute IP addresses and other network parameters, the server setup should include the following:

- IP address pool (1 or 5 IP address per cradle)
- Router/gateway address
- One or more DNS server addresses
- One or more WINS server addresses
- Subnet mask.

**Cradle Configuration**

The MobileDox Cradle Manager allows you to setup the Device IP Address and modify cradle settings. See Installing MobileDox Cradle Manager on page 2-13 for instructions to download and install the software. See Figure 2-6 on page 2-11 for instructions on Four Slot Ethernet cradle connections.

**Setting the Device IP Address**

By default, the cradle uses DHCP to obtain its IP address. However, if DHCP fails, the Cradle Manager can assign an IP address.

1. Launch the MobileDox Cradle Manager on the host computer.
2. Click File > Set IP Address of Unlisted Device. The Set IP Address window appears:
3. Enter the appropriate MAC Address and IP address.
4. Click OK.

**Modifying Cradle Settings**

1. Launch the MobileDox Cradle Manager on the host computer.
2. Select the name of the cradle you want to configure from the list.
3. Click **Device > Modify Settings**.
4. Use the **General Settings** tab to modify the identification settings of the cradle.

**Table 2-5  Cradle Settings - General Settings Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Name</td>
<td>A text string used to describe the MobileDox device. Any 15-character string may be entered.</td>
</tr>
</tbody>
</table>
5. Use the **TPC/IP Settings** tab to modify the DNS and WINS identification settings of the cradle.

![Figure 2-10 Cradle Settings Window - TCP/IP Settings Tab](image)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom String</td>
<td>A text string for any desired usage (examples are: location, asset ID, etc.). Any 15-character string may be entered.</td>
</tr>
<tr>
<td>Require Admin Privileges to Modify Settings check box</td>
<td>Selecting this check box requires users to have administrative privileges in order to modify MobileDox settings. Administrative privileges are validated using standard Windows authentication.</td>
</tr>
</tbody>
</table>

6. Use the **Port Settings** tab to modify the USB port settings of the cradle.
7. Click **OK**.
Four Slot Ethernet Cradle CRD9101-4001ER

**CAUTION** Ensure that you follow the guidelines for battery safety described in Battery Safety Guidelines on page 12-1.

This section describes how to set up and use a Four Slot Ethernet cradle, p/n CRD9101-4001ER, with the MC92N0-G.

![Four Slot Ethernet Cradle CRD9101-4001ER](image)

**Figure 2-12**  *Four Slot Ethernet Cradle CRD9101-4001ER*

**NOTE** The first MAC address listed on the Four Slot Ethernet Cradle CRD9101-4001ER corresponds to its first cradle well.

**CAUTION** Do not place coins, keys or paper clips in cradle well.

The Four Slot Ethernet cradle:

- Provides 12VDC power for operating the MC92N0-G.
- Enables data communication between the MC92N0-G (up to four) and a host computer, over an Ethernet network (using a standard Ethernet cable).
- Synchronizes information between the MC92N0-G and a host computer. (With customized or third party software, it can also be used to synchronize the MC92N0-G with corporate databases.)
- Simultaneously charges up to four batteries in the MC92N0-G.
Table 2-8  Communication LED

<table>
<thead>
<tr>
<th>Status</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>MC92N0-G is not in cradle; MC92N0-G not placed correctly; cradle is not powered.</td>
</tr>
<tr>
<td>Flashing Green</td>
<td>MC92N0-G is in the cradle, and communicating with the host computer.</td>
</tr>
<tr>
<td>Solid Green</td>
<td>MC910-G is present in the slot and ready for communication.</td>
</tr>
</tbody>
</table>

**Setup**

- **NOTE** The Four Slot Ethernet cradle must be connected to a power source and to an Ethernet Hub (when applicable).

![Diagram of Four Slot Ethernet Cradle Power Connection]

**Figure 2-13  Four Slot Ethernet Cradle Power Connection**

**Battery Charging Indicators**

The MC92N0-G’s amber charge LED, located in the Indicator LED Bar, shows the status of the battery charging in the MC92N0-G. See Table 2-2 for charging status indications. The battery usually charges in less than four hours.
LED Communication LEDs

The Ethernet Communication port on the back of the cradle contains two LEDs that indicate the connectivity data rate.

**Table 2-9  CRD9101-4001ER Data Rates**

<table>
<thead>
<tr>
<th>Data Rate</th>
<th>Left LED</th>
<th>Right LED</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Gbps</td>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td>100 Mbps</td>
<td>Off</td>
<td>On</td>
</tr>
<tr>
<td>10 Mbps</td>
<td>Off</td>
<td>Off</td>
</tr>
</tbody>
</table>
Four Slot Charge Only Cradle

**CAUTION** Ensure that you follow the guidelines for battery safety described in Battery Safety Guidelines on page 12-1.

This section describes how to set up and use a Four Slot Charge Only cradle with the MC92N0-G.

![Four Slot Charge Only Cradle](image)

**Figure 2-14  Four Slot Charge Only Cradle**

**CAUTION** Do not place coins, keys or paper clips in cradle well.

The Four Slot Charge Only cradle:

- Provides 12VDC power for operating the MC92N0-G.
- Simultaneously charges up to four batteries in the MC92N0-G.
**Battery Charging Indicators**

The MC92N0-G’s amber charge LED, located in the Indicator LED Bar, shows the status of the battery charging in the MC92N0-G. See *Table 2-2 on page 2-9* for charging status indications. The battery usually charges in less than four hours.
Four Slot Spare Battery Charger

**CAUTION** Ensure that you follow the guidelines for battery safety described in *Battery Safety Guidelines on page 12-1.*

This section describes how to set up and use the Four Slot Spare Battery Charger to charge up to four spare batteries.

![Four Slot Spare Battery Charger](image)

**Figure 2-16**  *Four Slot Spare Battery Charger*
Setup

Figure 2-17  Four Slot Spare Battery Charger Power Connection

Spare Battery Charging with the Four Slot Spare Battery Charger

1. Connect the charger to a power source as shown in Figure 2-17.
2. Insert the battery into a spare battery charging slot and gently press down on the battery to ensure proper contact.

Battery Charging Indicators

An amber LED is provided on each battery charging well (see Figure 2-16 on page 2-23). See Table 2-10 for charging status indications.

The battery usually charges in less than four hours.

Table 2-10  Spare Battery LED Charging Indicators

<table>
<thead>
<tr>
<th>LED</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>No spare battery in slot; spare battery not placed correctly; cradle is not powered.</td>
</tr>
<tr>
<td>Fast Blinking Amber</td>
<td>Error in charging; check placement of spare battery.</td>
</tr>
<tr>
<td>Slow Blinking Amber</td>
<td>Spare battery is charging.</td>
</tr>
<tr>
<td>Solid Amber</td>
<td>Charging complete.</td>
</tr>
</tbody>
</table>

Cable Adapter Module

This section describes how to set up and use the snap-on CAM with the MC92N0-G. The CAM snaps on to the bottom of the MC92N0-G and can be easily removed when not in use.
When attached to the MC92N0-G, the CAM:

- Provides power for operating the MC92N0-G, with the appropriate power connection.

**NOTE** When a MC92N0-G with Windows Mobile 6.5 is connected to a host computer through the CAM and an ActiveSync connection is made, the WLAN and WWAN radios (if applicable) are disabled. This is a Microsoft security feature to prevent connection to two networks at the same time.

- Provides USB connection through the USB pass-through port for communication with a USB device, such as a host computer. For communication setup procedures, see *Serial Communication Setup on page 2-30*.
- Charges the MC92N0-G’s battery, when used with the appropriate power supply.

**Attaching and Removing**

To attach, snap the CAM onto the bottom of the MC92N0-G.

To remove, squeeze the latch grips and pull the CAM from the MC92N0-G.

**NOTE** Remove the CAM from the bottom of the MC92N0-G before using a cradle for charging and communication.
Battery Charging Indicators

To charge the MC92N0-G’s battery through the CAM, connect the power supply to the CAM (see Figure 2-20 on page 2-26), then attach the CAM to the MC92N0-G. The MC92N0-G begins charging automatically.

**NOTE** Batteries must be charged within the 32° to 104° F (0° to +40° C) ambient temperature range.

The MC92N0-G’s amber charge LED, located in the Indicator LED Bar, shows the status of the battery charging in the MC92N0-G. See Table 2-2 on page 2-9 for charging status indications. The battery usually charges in less than four hours, if the MC92N0-G is not in use.
USB Connection

The CAM can connect to and communicate with a USB device, such as a printer or host computer, through its serial port. See Serial Communication Setup on page 2-30 for the host computer communication setup procedure.

To connect the CAM to a USB device, connect one end of the USB device cable into the serial port on the CAM and the other end into the USB port on the device.
Universal Battery Charger (UBC) Adapter

**CAUTION** Ensure that you follow the guidelines for battery safety described in *Battery Safety Guidelines on page 12-1*.

This section describes how to use the UBC adapter to charge a spare battery.

The UBC can be used with a power supply as a standalone spare battery charger or it can be used with the four station UBC2000 to provide charging to simultaneously charge up to four spare batteries. For additional information about the UBC2000, see the *UBC 2000 Universal Battery Charger Product Guide* (p/n 70-33188-xx).

![UBC Adapter Diagram](image)

**Figure 2-22** *UBC Adapter*

**Inserting and Removing a Battery**

Insert the battery into the battery well with the charging contacts facing down (over charging pins) and gently press down on the battery to ensure proper contact.

To remove the battery, press the battery release and lift battery out of the well.
Battery Charging Indicators

To charge a spare battery using the UBC adapter, connect the power supply to the UBC (see Figure 2-23 on page 2-29), then insert the spare battery. The spare battery begins charging automatically. The UBC’s charge LEDs (see Figure 2-24) show the status of the battery charging in the adapter. Table 2-11 shows battery charging status indications. The battery usually charges in three hours.

<table>
<thead>
<tr>
<th>LED</th>
<th>LED Indication</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>POWER</td>
<td>Green</td>
<td>Power is connected to the UBC Adapter.</td>
</tr>
<tr>
<td>READY or STANDBY</td>
<td>Green</td>
<td>Charging complete.</td>
</tr>
<tr>
<td>STANDBY</td>
<td>Flashing-Yellow</td>
<td>The battery was deeply discharged and is being trickle charged to bring the voltage up to the operating level. After operating level voltage is achieved the battery charges normally.</td>
</tr>
</tbody>
</table>
Serial Communication Setup

- **NOTE** Windows devices only.

The serial communications setup can be used to set up to communicate with a Single Slot Serial/USB Cradle, MSR or a CAM.

- **NOTE** For serial communication using accessories that can communicate with either a serial or USB connection, connect only the serial cable. Do not connect both the serial and USB cables. If both serial and USB communication cables are required, the host computer’s USB port must be disabled in ActiveSync before serial communication can be enabled.

### Setting Up a Connection on the MC92N0-G (Windows Embedded Handheld)

1. On the MC92N0-G tap Start > ActiveSync.
2. Tap Menu > Connections.
3. Select the Synchronize all PCs using this connection check box.
4. Select the connection (e.g., Bluetooth or USB) for synchronization from the drop-down list. The default connection for synchronization is USB.
5. Tap OK.
6. Ensure that synchronization software is installed on the host computer and a partnership was created.
7. Select Start > All Programs > Microsoft ActiveSync or Windows Mobile Device Center on the host computer, if it is not already running.

- **NOTE** Every MC92N0-G should have a unique device name. Never try to synchronize more than one MC92N0-G to the same name.
8. In the synchronization window, select File > Connection Settings.
9. In the Connection Settings window, select the appropriate check box for the type of connection being used. If using a serial connection, select the COM port from the drop-down list.

\[\text{NOTE}\] If serial, USB and Ethernet communication connections are used, all check boxes can be selected to avoid having to update this window for different connections.

10. Tap OK to save any changes made.

11. Ensure the accessory being used to communicate is connected to the host computer and the appropriate power source.

\[\text{NOTE}\] The accessory requires a dedicated port. It cannot share a port with any other device. Refer to the host computer user manual supplied to locate the USB ports.

12. Connect the MC92N0-G to the accessory being used for communication.

13. Power on the MC92N0-G.

14. If a partnership was already created between the host computer and MC92N0-G, synchronization occurs automatically upon connection.

**Serial Connection Setup (Windows CE)**

1. On the MC92N0-G tap Start > Settings > Control Panel > PC Connection icon.
2. Tap Change Connection...
3. Select the serial communication type from the drop-down list.
4. Tap OK.
5. Tap OK.
6. Ensure that synchronization software was installed on the host computer and a partnership was created.
7. Start ActiveSync or Windows Mobile Device Center if it is not running on the host computer. To start, select Start > Programs > Microsoft ActiveSync.
8. In the ActiveSync window, select File > Connection Settings. The Connection Settings window displays.

9. For a serial connection, select Allow connections to one of the following: check box and select the comm port from the drop-down list.
10. For USB connection, select Allow USB connection check box.
11. Tap OK to save any changes made.

   **NOTE** Every MC92N0-G should have a unique device name. Never try to synchronize more than one MC92N0-G to the same name.

12. Connect the device to the host computer.

   **NOTE** The cradle requires a dedicated port. It cannot share a port with an internal modem or other device. Refer to the computer user manual supplied to locate the serial port(s).

13. Upon connection, synchronization occurs automatically.
USB Host Communication Setup

1. On Windows Embedded Handheld devices, tap **Start > Settings > System > USBConfig**.
   On Windows CE devices, tap **Start > Settings > Control Panel > USB Config**.
   On Android devices, touch > USBConfig.
2. Tap the **USB Host Mode** radio button.
3. Tap **OK**.

**NOTE** USB Host mode is only available on Windows Mobile devices.

The MC92N0-G can be configured as a USB host device for use with USB client devices.

To configure the MC92N0-G as a USB host:

1. On Windows Embedded Handheld devices, tap **Start > Settings > System > USBConfig**.
   On Windows CE devices, tap **Start > Settings > Control Panel > USB Config**.
   On Android devices, touch > USBConfig.
2. Tap the **USB Host Mode** radio button.
3. Tap **OK**.
4. Remove the MC92N0-G from the cradle or CAM.
5. Re-insert the MC92N0-G into a cradle or re-connect the CAM.

**NOTE** When the MC92N0-G is configured a a USB host, it cannot ActiveSync with a host computer.
Wall Mounting Bracket and Shelf Slide

This section describes how to install and set up the MC9000 Wall Mount Bracket and Shelf Slide to mount cradles to a wall.

![Wall Mounting Bracket with Shelf Slide](image)

When installed on a wall, the mounting bracket and shelf slide enable mounting one or two single slot cradles to a wall. Use two brackets to mount a four slot cradle.

![Mounted Single Slot Cradle With Power Connection](image)

**Installing the Wall Mount Bracket**

To install the wall mount bracket for use with one or two single slot cradles or four slot chargers, place the smaller surface of the bracket against the wall or vertical support structure, and secure with four 1/4” screws (use two of the three screw holes in each row).
If using the bracket and slide with a four slot cradle, secure a second bracket to the wall next to the first, aligning the horizontal screw holes on the second with those of the first.

**Attaching the Shelf Slide to the Wall Mount Bracket**

**One Single Slot Cradle/Four Slot Battery Charger**

To attach the shelf slide to the wall mount bracket for use with one single slot cradle or four slot battery charger:

1. Place the slide on the bracket, aligning the larger pan-head screw holes in the slide with the center two screw holes on the bracket.
2. Secure the slide to the bracket by inserting the two pan-head screws provided from below the bracket, up through the bracket’s screw holes and then through the slide’s pan-head screw holes.

**Two Single Slot Cradles/Four Slot Battery Chargers**

To attach the shelf slide to the wall mount bracket for use with two single slot cradles or two four slot battery chargers:

1. Place the slide on the bracket, aligning the larger pan-head screw holes in the slide with the left or right two screw holes on the bracket.
2. Secure the slide to the bracket by inserting the two pan-head screws provided from below the bracket, up through the bracket’s screw holes and then through the slide’s pan-head screw holes.
3. Secure a second slide to the remaining two screw holes on the bracket in the same manner.
Attaching Two Shelf Slides

Four Slot Cradle

To attach the shelf slide to the wall mount bracket for use with a four slot cradle:

1. Place a slide on the left-hand bracket, aligning the larger pan-head screw holes in the slide with the left two screw holes on the bracket.
2. Secure the slide to the bracket by inserting the two pan-head screws provided from below the bracket, up through the bracket’s screw holes and then through the slide’s pan-head screw holes.
3. Place a slide on the right-hand bracket, aligning the larger pan-head screw holes in the slide with the right two screw holes on the bracket.
4. Secure the second slide to the bracket as described in Step 2.

Installing the Cradle/Charger on the Bracket

Install the cradle or charger onto the bracket, inserting the bracket’s slide into the grooves on the bottom of the cradle/charger and sliding the cradle/charger into the desired position.

For one single slot cradle/four slot charger, center it on the bracket.

For two single slot cradle/four slot chargers, slide one onto the left-hand slide, and one onto the right-hand slide.
For a four slot cradle, slide the cradle on to the slides, across both brackets. Secure each cradle or charger to its slide using the two set screws provided.

**Figure 2-34  Attaching Two Shelf Slides**

Insert set screws
CHAPTER 3 SYNCHRONIZATION

Introduction

✓ NOTE Windows devices only.

Synchronization lets the user manage information between an MC92N0-G and a host computer so that changes made either on the MC92N0-G or on the host computer appear in both places. Download and install sync software to the host computer (either Microsoft ActiveSync for Windows XP or Windows Mobile Device Center (WMDC) for Windows Vista and Windows 7) in order to use the sync feature. Visit www.microsoft.com on the host computer for details.

✓ NOTE When the MC92N0-G is connected to a host computer and a sync connection is made, the Wi-Fi radio is disabled. This is a Microsoft security feature to prevent connection to two networks at the same time.

The sync software:

• Allows working with MC92N0-G-compatible applications on the host computer. The sync software replicates data from the MC92N0-G to view, enter, and modify data on the host computer.
• Synchronizes files between the MC92N0-G and the host computer, converting the files to the correct format.
• Backs up the data stored on the MC92N0-G. Synchronization is a one-step procedure that ensures the data is always safe and up-to-date.
• Copies (rather than synchronizes) files between the MC92N0-G and the host computer.
• Controls when synchronization occurs by selecting a synchronization mode. For example, synchronize continuously while the MC92N0-G is connected to the host computer, or synchronize only on command.
• Selects the types of information to synchronize and control how much data is synchronized.

Installing the Sync Software

To download and install either Microsoft ActiveSync (for Windows XP) or WMDC (for Windows Vista and Windows 7), visit www.microsoft.com and follow the instructions for the host computer.
MC92N0-G Setup

NOTE Microsoft recommends installing the sync software on the host computer before connecting the MC92N0-G.

The MC92N0-G can be set up to communicate with a USB connection. The MC92N0-G communication settings must be set to match the communication settings used with ActiveSync or WMDC.

On Windows CE Devices:

![Figure 3-1 PC Connection Properties Window](image)

2. Tap the Change Connection button.
3. Select the connection type from the drop-down list.
4. Tap OK to exit the Change Connection window and tap OK to exit the PC Connection Properties window.
5. Proceed with installing ActiveSync or WMDC on the host computer and setting up a partnership.

On Windows Mobile Embedded Handheld Devices:
1. On the MC92N0-G tap Start > Programs > ActiveSync icon. The ActiveSync window appears.
2. Tap Menu > Connections.
3. Select the USB from the drop-down list.
4. Tap OK to exit the Connections window and tap OK to exit the ActiveSync window.
5. Proceed with installing ActiveSync or WMDC on the host computer and setting up a partnership.

Setting Up a Sync Connection

ActiveSync
1. Select Start > Programs > Microsoft ActiveSync on the host computer. The ActiveSync Window displays.
2. In the ActiveSync window, select **File > Connection Settings**. The **Connection Settings** window appears.

3. Select **Allow USB connections** check box.
4. Select the **Show status icon in taskbar** check box.
5. Select **OK** to save any changes made.

### Windows Mobile Device Center

1. Select **Start > All Programs > Windows Mobile Device Center** on the host computer.
2. In the WMDC window, under Mobile Device Settings, click Connection settings.

3. Select Allow USB connections and adjust any additional settings as needed.

4. Click OK to save your settings.

Setting up a Partnership with a Windows CE Device

1. If the Get Connected window does not appear on the host computer, select Start > All Programs > Microsoft ActiveSync.
2. Select if you want to create synchronize with the host computer or to connect as a guest.
3. Click Next.
4. Select the appropriate settings and click **Next**.

5. Click **Finish** or **Setup**.
During the first synchronization, information stored on the MC92N0-G is copied to the host computer. When the copy is complete and all data is synchronized, the MC92N0-G can be disconnected from the host computer.

**NOTE** The first synchronization operation must be performed with a local direct connection. To retain partnerships after a cold boot, capture partnership registry information in a .reg file and save it in the Flash File System, detailed information is provided in the EMDK Windows CE Help File for the Zebra MC92N0-G.

For more information about using ActiveSync or WMDC, start the application on the host computer, then see Help.

**Synchronization With a Windows Embedded Handheld Device**

**NOTE** When the MC92N0-G is connected to your computer and a sync connection is made, the Wi-Fi radio (if applicable) is disabled. This is a Microsoft security feature to prevent connection to two networks at the same time.

To synchronize with the MC92N0-G:

1. Connect the MC92N0-G to your computer using the provided USB cable.
2. If the Get Connected window does not appear on your computer, select Start > All Programs > Microsoft ActiveSync or Windows Mobile Device Center.
3. Click Next.
4. Select the check box to synchronize with a server running Microsoft Exchange if applicable.
5. Click Next.
6. Select the appropriate settings and click **Next**.

7. Click **Finish** or **Set Up**.
During the first synchronization, information stored on the MC92N0-G is copied to the host computer. When the copy is complete and all data is synchronized, the MC92N0-G can be disconnected from the host computer.

**NOTE** The first synchronization operation must be performed with a local direct connection. Windows Mobile retains partnerships information after a cold boot.
CHAPTER 4 USB COMMUNICATION

This chapter provides information for transferring files between the device and a host computer.

Connecting to a Host Computer via USB

Connect the MC92N0-G to a host computer using the Single Slot Serial/USB Cradle and USB cable or the CAM and USB cable to transfer files between the MC92N0-G and the host computer.

**CAUTION** When connecting the MC92N0-G to a host computer, follow the host computer’s instructions for connecting and disconnecting USB devices, to avoid damaging or corrupting files.

Connecting to the MC92N0-G as a Media Device

**NOTE** Using Media Device, you can copy files to the internal memory.

1. Connect the USB cable to the Single Slot USB Cradle or the CAM. See Chapter 2, Accessories.
2. Place the MC92N0-G into the cradle or connect the CAM to the MC92N0-G.
   **Connected as a media device** appears on the Status bar.
3. On the host computer, open a file explorer application.
4. Locate the **MC92N0** as a portable device.
5. Open the Internal Storage or SD card folder.
6. Copy or delete files as required.
Disconnect from the Host Computer

**CAUTION** Carefully follow the host computer’s instructions to unmount the device and disconnect USB devices correctly to avoid losing information.

1. On the host computer, unmount the device.
2. Remove the MC92N0-G from the Single Slot Serial/USB Cradle or CAM.
CHAPTER 5 WIRELESS APPLICATIONS

Introduction

NOTE Windows devices only.

Wireless Local Area Networks (LANs) allow the MC92N0-G to communicate wirelessly and send captured data to a host device in real time. Before using the MC92N0-G on a WLAN, the facility must be set up with the required hardware to run the wireless LAN and the MC92N0-G must be configured. Refer to the documentation provided with the access points (APs) for instructions on setting up the hardware.

NOTE 802.11d is enabled by default. When enabled, the AP must be configured the same in order to connect.

To configure the MC92N0-G, a set of wireless applications provide the tools to configure and test the wireless radio in the MC92N0-G. Refer to the Wireless Fusion Suite User Guide for Version 3.00 for information on configuring wireless profiles. Go to http://www.zebra.com/support for the latest version of this guide. See Software Versions on page xix to determine the Fusion version on the MC92N0-G.

Windows CE Devices

Tap the Signal Strength icon to display the Wireless Launcher menu.

NOTE On devices with Windows Mobile, access the Wireless launcher from the Home screen. Select the Fusion plug-in and then tap the Fusion Menu button.
The interface to the Signal Strength icon and Wireless Launcher has changed in the Windows Embedded Handheld default Today screen. To view the Wireless Launcher, select the Fusion plug-in on the Today screen and tap the Fusion Menu soft key.

Functionality of this dialog is similar to the Wireless Launcher menu. Drag the window up and down to view all menu items. Tap the icon next to the item to open it.
Many of the items in the menu invoke one of the Fusion applications. These menu items and their corresponding applications are summarized below:

- Find WLANs – Invokes the Find WLANs application which displays a list of the WLANs active in your area. The **Find WLANs** menu on the task tray provides the following wireless applications:
  - Manage Profiles – Invokes the Manage Profiles application (which includes the Profile Editor Wizard) to manage and edit your list of WLAN profiles.
  - Manage Certs – Invokes the Certificate Manager application which allows you to manage certificates used for authentication.
  - Manage PACs – Invokes the PAC Manager application which helps you manage the list of Protected Access Credentials used with EAP-FAST authentication.
  - Options – Invokes the Options application which allows you to configure the Fusion option settings.
  - Wireless Status – Invokes the Wireless Status application which allows you to view the status of the current wireless connection.
  - Wireless Diagnostics – Invokes the Wireless Diagnostics application which provides tools with which to diagnose problems with the wireless connection.
  - Log On/Off – Invokes the Network Login dialog which allows you to log on to a particular profile or to log off from the currently active profile.

Additional Wireless Launcher menu entries include:

- Enable/Disable Radio
- Hide Menu
- Exit.

**Signal Strength Icon**

The **Signal Strength** icon in the task tray indicates the MC92N0-G’s wireless signal strength as follows:
Table 5-1  Signal Strength Icons Descriptions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Excellent signal strength</td>
<td>WLAN network is ready to use.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Very good signal strength</td>
<td>WLAN network is ready to use.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Good signal strength</td>
<td>WLAN network is ready to use.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Fair signal strength</td>
<td>WLAN network is ready to use. Notify the network administrator that the signal strength is only “Fair”.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Poor signal strength</td>
<td>WLAN network is ready to use. Performance may not be optimum. Notify the network administrator that the signal strength is “Poor”.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Out-of-network range (not associated)</td>
<td>No WLAN network connection. Notify the network administrator.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>The WLAN radio is disabled</td>
<td>The WLAN radio is disabled. To enable, choose Enable Radio from the Wireless Applications menu.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>The Wireless Launcher application was exited.</td>
<td>The Wireless Launcher application has been closed. See the Fusion Functions paragraphs below for how to restart the Wireless Launcher.</td>
</tr>
</tbody>
</table>

Turning Off the Radio

On Windows CE Device

To turn off the WLAN radio tap the **Signal Strength** icon on the task tray and select **Disable Radio**. A red X appears across the icon indicating that the radio is disabled (off).

![Signal Strength Icon](image)

**Figure 5-4  Wireless Connection Status Icon**

To turn the radio back on, tap the **Signal Strength** icon on the task tray and select **Enable Radio**. The red X disappears from the icon indicating that the radio is enabled (on).

On Windows Embedded Handheld Devices

Windows Embedded Handheld devices include **Wireless Manager**, which provides a simple method of enabling, disabling the WLAN radio.

To open **Wireless Manager**, tap the Status bar and select the **Connectivity** icon.
Select **Wireless Manager**.

To enable or disable the WLAN radio, tap the **Wi-Fi** bar.
Zebra provide a suite of utilities that allow an administrator to manage the following features:

- **Multi-user Login** - The Multi-user Login feature allows an administrator to set up the device to be used by multiple users. The users have access to specific applications and features depending upon the user settings.
- **Application Lock** - The Application Lock feature allows an administrator to restrict application access for specific applications by user or groups of users. The permitted applications are managed using groups of user accounts from Multi-user Login feature.
- **Secure Storage** - Secure Storage Administrator application allows installation and deletion of encrypted keys and creation, mounting, un-mounting and deletion of the encrypted file systems.

The following applications help the administrator configure these features.

- **On-device applications** - reside on the device.
  - MultiUser Administrator
  - AppLock Administrator
  - Secure Storage Administrator.
- **Host computer application** - reside on a host computer.
  - Enterprise Administrator.

---

**Required Software**

These tools are available on the Support Central web site at Support Central. Download the required files from the Support Central web site and follow the installation instruction provided.

---

**On-device Application Installation**

See *Application Installation on page 9-3* for instruction on installing applications onto the device.
Multi-user/AppLock Configuration

To use the Multi-user Login and Application Lock features, the administrator must create user and group account information using the Enterprise Administrator application.

✓ **NOTE** The administrator can also create the account information manually. See *Manual File Configuration on page 6-11* for more information.

Enterprise Administrator Application

✓ **NOTE** Net Compact Framework 4 or later is required to run the Enterprise Administrator. To download, go to www.microsoft.com.

Use the Enterprise Administrator application to setup user and group accounts and create the required (Password, Group and White List) files for using the Multi-user and Application Lock features.

On the host computer launch the Enterprise Administrator application.

![Enterprise Administrator Window](image)

**Figure 6-1**  *Enterprise Administrator Window*

Creating Users

Each person that uses the device has to have a user name and password. To create a user:

1. Click + above the **Users** list box.
2. In the Username text box, enter a user name. The text is case sensitive and required.
3. In the Password text box, enter a password for the user. The text is case sensitive and required.
4. In the Retype Password text box, re-enter the user password.
5. Select the Admin checkbox to set the user to have administrator rights.
6. Select the Enabled checkbox to enable the user.
7. Click OK.
8. Repeat steps 1 through 7 for each additional user.

Adding Packages

✓ NOTE All system applications that are on the default image are available to all users.

Create a list of installed applications (packages) on the device that are available for use by all the users.
1. Click + next to Packages.

✓ NOTE To get a list of all the applications (packages) on the device see Determining Applications Installed on the Device on page 6-14.
2. In the **Package name** text box, enter the name of an application.
3. Click **OK**.
4. Repeat steps 1 through 3 for each additional package.

### Creating Groups

Create groups of users that have access to specific applications.

1. Click + above the **Groups** list. The **Group Manager** window appears with a list of users and packages.

2. In the **Group name** text box, enter a name for the group. This field is required.
3. Select a user in the **Available Users** list box and then click the **Add** button to add the user to the **Users in Group** list box or click the **Add All** button to add all the users in the **Available Users** list box to the **Users in Group** list box.
4. Select a package in the **Available Packages** list box and then click the **Add** button to add the package to the **Packages in Group** list box or click the **Add All** button to add all the packages in the **Available Packages** list box to the **Packages in Group** list box.
5. Click **OK**.
6. Click **Save**.

**Creating Remote Authentication**

Use the Remote Authentication feature to set a remote server for authentication.

1. Click the **Auth** button. The **Authentication** window appears.

![Authentication Window](image)

2. Select the **Remote** radio button.
3. In the **Server IP** text box, enter the address of the remote server.
4. In the **Port** text box, enter the port number of the remote server.
5. Select the **use SSL Encryption** check box if SSL encryption is required.
6. Click **OK**.

**Save Data**

At any time, the administrator can save the current data. The application creates two files in the `<user>\_APP_DATA` folder: `database` and `passwd`.

**Exporting File**

In order to use the features on the device, export the required files and then copy them to the device. The following files are created by the Enterprise Administrator application:

- **Password File** - Filename: `passwd`. Lists the user names, encrypted passwords, administrator and enable flags.
- **Group File** - Filename: `groups`. Lists each group and users associated to each group.
- **White List Files** - Filename: the filenames are the names of the group created in the Group file. Lists the user installed applications that the group is allowed to access.

1. Click **Export**.
2. In the Browse For Folder window, select a folder and then click **OK**.
3. Click OK.
4. Click File > Export > Server Information.
   The server file is saved in the <user>_APP_DATA folder.
5. Copy all the files to the root of the On-device Storage. See Chapter 4, USB Communication for information on copying files to the device.

Importing User List

1. Click File > Import > User List.
2. Navigate to the location when the passwd file is stored.
3. Select the passwd file.
4. Click Open.
   The user information is populated into the Users list.

Importing Group List

1. Click File > Import > Group List.
2. Navigate to the location when the group file is stored.
3. Select the group file.
4. Click Open.
   The group and package information is populated into the Groups and Packages list.

Importing Package List

To import a package list (see Package List File on page 6-15 for instructions for creating a Package List file):

1. Click File > Import > Package List.
2. Navigate to the location when the package file is stored.
4. Click Open.
   The package information is populated into the Packages list.

Editing a User

1. Select a user in the Users list.
2. Click Edit User.
3. Make changes and then click OK.

Deleting a User

1. Select a user in the Users list.
2. Click -. The user name is removed from the list.

Editing a Group

1. Select a user in the Groups list.
2. Click Edit Group.
3. Make changes and then click **OK**.

**Deleting a Group**

1. Select a group in the **Groups** list.
2. Click `-`.
3. Click **Yes**. The group name is removed from the list.

**Editing a Package**

1. Select a package in the **Packages** list.
2. Click **Edit Package**.
3. Make changes and then click **OK**.

**Deleting a Package**

1. Select a package in the **Packages** list.
2. Click `-`. The package name is removed from the list.
MultiUser Administrator

Use the MultiUser Administrator application to allow an administrator to enable, disable and configure the Multiuser Login feature.

Importing a Password

When the MultiUser Administrator is used for the first time, the password file must be imported.

1. Touch >.

Figure 6-6 MultiUser Administrator Screen

2. Touch Load User List. The application reads the data from the passwd file and configures the Multi-user Login feature.

3. Touch Enable Multiuser to enable the feature.

Figure 6-7 MultiUser Login Screen

4. In the Login text box, enter the username.
5. In the Password text box, enter the password.
6. Touch OK.
Disabling the Multi-user Feature

![NOTE] To disable the Multi-user Login feature, the user must have administrator rights. A message displays at the bottom of the screen notifying the user.

1. Touch > .
2. Touch Disable MultiUser.
   The Multi-user feature is disabled immediately.

Enabling Remote Authentication

![CAUTION] When Remote Authentication is enable, the device searches for the remote server during the login procedure. If the remote server is not available or the address is incorrect, the user would not be able to login and an Enterprise reset is required to access the device.

1. Touch > .
2. Touch Load Server Info. The application reads the data from the server file and configures the Multi-user Login feature.
3. Touch .
   The device accesses the remote server and then Login screen appears.

Disabling Remote Authentication

![CAUTION] When Remote Authentication is enable, the device searches for the remote server during the login procedure. If the remote server is not available or the address is incorrect, the user would not be able to login and an Enterprise reset is required to access the device.

1. Touch > .
2. Touch .
   The remote authentication feature is disabled immediately. The device suspends. When resumed, the login screen appears.

Enabling Data Separation

![NOTE] To enable Data Separation, the user must have administrator rights. A message displays at the bottom of the screen notifying the user.

Data Separation feature allows each user of the device to have separate isolated data area for installed application. To enable data separation:

1. Touch > .
2. Touch .
3. Touch **Enable Data Separation**. The current user is logged out to prepare the data space for each user as they log in.

## Disabling Data Separation

✓ **NOTE** To disable Data Separation, the user must have administrator rights. A message displays at the bottom of the screen notifying the user.

1. Touch 🔄.
2. Touch 🔄.
3. Touch 🔄.
4. Touch **Disable Data Separation**. The current user is logged out to restore the system to common data space for all users.

## Delete User Data

✓ **NOTE** To delete user data, the user must have administrator rights. A message displays at the bottom of the screen notifying the user.

1. Touch 🔄 > 🔄.
2. Touch 🔄.
3. Touch **Delete Individual User Data**. A dialog box displays with all of the users that currently have data associated with their log in.
4. Select each user to delete or **Select All** to delete all user data.
5. Touch **Delete** to delete the data.

## Capturing a Log File

1. Touch 🔄 > 🔄.

✓ **NOTE** To capture a log file, the user must have administrator rights. A message displays at the bottom of the screen notifying the user.

2. Touch **Export Log** to copy the log file to the On-device Storage. The log file can be captured when the multi-user feature is in either the enabled or disabled mode.
3. The log file and a backup log file are named `multiuser.log` and `multiuser.log.bak`, respectively.
AppLock Administrator

The Application Lock feature allows the system administrator to restrict application access for specific applications by user or groups of users. The permitted applications are managed using groups of user accounts from Multi-user feature.

The permitted application names are built into an application White List that is used to know which applications are managed by the system.

The Application Lock feature does not prevent execution of native code or plug-ins and it does not prevent applications from accessing public classes within non-permitted applications. The AppLock Administrator application takes advantage of the Application Lock feature allowing an administrator to enable, disable and install White Lists and Groups files.

✓ NOTE To use the AppLock Administrator application, the user must have administrator rights. A message displays at the bottom of the screen notifying the user.

Enabling Application Lock

1. Touch > .
2. Touch Enable Application Lock.

Disabling Application Lock

1. Touch > .
2. Touch Disable Application Lock.

Manual File Configuration

Groups File

A Groups file is a text file that provides a list of groups and assigns users to each group. The text file contains one line for each group. Each line is formatted as follows:

<groupname>:<user1>,<user2>,...<userN>

where:

<groupname> = the name for a group. This is also the name of the White List file for this group. This field uses any alphanumeric character.

<user1> through <userN> = the name of the user assigned to this group. The user name is the same as that defined for the MultiUser feature. See MultiUser Administrator on page 6-8 for more information.

✓ NOTE If the same user is assigned to multiple groups, then that user’s White List will be a logical union of the White Lists for all of the groups that user is assigned.

A line starting with the # character is considered a comment and is ignored.
Examples:

- AdminGroup:alpha
  - The Group name is AdminGroup and assigns user alpha to the group.
- ManagersGroup:beta,gamma
  - The Group name is ManagerGroup and assigns users beta and gamma to the group.

**White List File**

A White List file is a text file that provides a list of allowed packages from that group. The text file contains one line for each allowed package for that user group. Each line is format as follows:

```
<packageName>
.
.
.
<packageName>
```

where:

- `<packageName>` = the package name allowed for this group. Wild cards are allowed for this field.

Example:

Refer to the example of the Groups file above. A White List file of the name AdminGroup could have the following lines:

```
com.companyname.application
com.symbol.*
```

where:

- `com.companyname.application` = the specific application with the package name
- `com.companyname.application` will be permitted for this group.
- `com.symbol.*` = any application that has a package name that starts with
- `com.symbol` will be permitted for this group.

**NOTE** The wildcard “.*” is allowed and indicates that this group is permitted to run any package.

A default White List for use when the MultiUser feature is disabled takes the same form as above but in named default.

To assure that administrative users have access to all device functionality, the White List for the administrative users group should use the wildcard.

At a minimum, the White List for the administrative users group should contain `com.symbol.fusion` to allow administrative users the ability to configure Wi-Fi advanced settings.
Package List File

A Package List file is a text file that lists package names that can be imported into the Packages list. The file makes it easier to enter package name into the application. The text file contains one line for each package name.

Example:

```
com.symbol.example1
com.symbol.example2
com.symbol.example3
com.symbol.example4
```

Groups File

A Groups file is a text file that provides a list of groups and assigns users to each group.

The text file contains one line for each group. Each line is formatted as follows:

```
<groupname>:<user1>,<user2>,...<userN>
```

where:

- `<groupname>` = the name for a group. This is also the name of the White List file for this group. This field uses any alphanumeric character.
- `<user1>` through `<userN>` = the name of the user assigned to this group. The user name is the same as that defined for the MultiUser feature. See MultiUser Administrator on page 6-8 for more information.

✓ **NOTE** If the same user is assigned to multiple groups, then that user’s White List will be a logical union of the White Lists for all of the groups that user is assigned.

A line starting with the # character is considered a comment and is ignored.

Examples:

- AdminGroup:alpha
  - The Group name is AdminGroup and assigns user alpha to the group.
- ManagersGroup:beta,gamma
  - The Group name is ManagerGroup and assigns users beta and gamma to the group.

White List File

A White List file is a text file that provides a list of allowed packages from that group. The text file contains one line for each allowed package for that user group. Each line is format as follows:

```
<package1name>
...
<packageNname>
```

where:

- `<package1Name>` = the package name allowed for this group. Wild cards are allowed for this field.

Example:
Refer to the example of the Groups file above. A White List file of the name AdminGroup could have the following lines:

```
com.companyname.application
com.symbol.*
```

where:

- `com.companyname.application` = the specific application with the package name
- `com.companyname.application` will be permitted for this group.
- `com.symbol.*` = any application that has a package name that starts with
- `com.symbol` will be permitted for this group.

✓ **NOTE** The wildcard ".*" is allowed and indicates that this group is permitted to run any package.

A default White List for use when the MultiUser feature is disabled takes the same form as above but in named default.

To assure that administrative users have access to all device functionality, the White List for the administrative users group should use the wildcard.

At a minimum, the White List for the administrative users group should contain `com.symbol.fusion` to allow administrative users the ability to configure Wi-Fi advanced settings.

**Determining Applications Installed on the Device**

To determine the names of applications installed on the device for use with the Enterprise Administrator application:

1. Connect the device to the host computer.

✓ **NOTE** See Development Tools on page 9-2 for information on installing the USB driver for use with adb.

2. On the host computer, open a command prompt (or a terminal in Ubuntu) and run the following:
   
   ```adb devices. This returns the device id.
   adb shell
   $pm list packages -f > sdcard/pkglist.txt
   $exit
   ```

3. A pkglist.txt file is created in the root of the On-device Storage. The file lists all the .apk files installed with their package names.
Package List File

A Package List file is a text file that lists package names that can be imported into the Packages list. The file makes it easier to enter package name into the application. The text file contains one line for each package name.

Example:

com.symbol.example1
com.symbol.example2
com.symbol.example3
com.symbol.example4
Secure Storage

Secure Storage Administrator application allows:

- installation and deletion of encrypted keys
- creation, mounting, un-mounting and deletion of the encrypted file systems.

Installing a Key

To install a key:

1. Touch ...
2. Touch ...
3. Touch Install Key.
5. Touch OK.

![Enter Key Dialog Box](image_url)

6. In the Enter key text box, enter the key name followed by the key value obtained in step 1, using the following format:
   <Key Name> <Key value in Hex String>
   Example: key2 1234567890abcdef1234567890abcdef1234567890abcdef1234567890abcdef
   The key value must be a 64 hexadecimal character string.
7. Touch OK. The key is imported into the device. The message successfully installed the key appears on the screen.

Viewing Key List

To view a key list:

1. Touch Key List.

![List of Keys](image_url)

2. Touch OK.
Deleting a Key

To delete a key:

1. Touch **Revoke Key**.
2. Touch the key to deleted.
3. Touch **OK**.

✓ **NOTE** If a key is deleted then all the volumes created using that key are un-mounted. The same key is required to re-mount the volume.

Volumes

Creates an encrypted file system (volume) on the device. The user must have Administrative privileges to create a volume.

Creating Volume Using EFS File

1. Create an efs file. See *Creating an EFS File on page 6-18* for instruction on creating the efs file.
2. Copy the keyfile and efsfile files to root of Internal Storage. *Chapter 4, USB Communication*.
3. Touch **Create Volume**.
4. Touch **Import**.
5. Touch **OK**. The message **Successfully Created the Volume** appears briefly.

Creating a Volume Manually

1. Touch **Create Volume**.
2. Touch **Manual**.
3. Touch **OK**.
4. In the **Enter Parameters To Create Volume** text box, enter the parameters in the follow format:
   
   <Volume Name> <Volume Storage Type> Key Name> <Mount Path> <Auto Mount> <Volume size>
   
   where:
   
   •  <Volume Name> = name of the volume.
   •  <Volume Storage Type> = storage location. Options: internal or sdcrad.
   •  <Key Name> = name of the key to use when creating the volume.
   •  <Mount Path> = path where the volume will be located.
   •  <Auto Mount> = Options: 1 = yes, 0 = no.
   •  <Volume size> = size of the volume in Megabytes.

**Figure 6-10** Enter Parameter To Create Volume Dialog Box
5. Touch OK. The message **Successfully Created the Volume** appears briefly. If the size of the volume is very large, a progress bar displays.

### Mounting a Volume

1. Touch **Mount Volume**.
2. Touch **sdcard** or **internal**.
3. Touch OK.
4. Select a volume.
5. Touch OK.

### Listing Volumes

1. Touch **Volume List**.
2. Touch **sdcard** to list volumes on the On-device Storage or **internal** to list volumes on internal storage.
3. Touch OK. The **List of EFS Volumes** dialog box appears with all the volumes of the selected storage location.
4. Touch OK.

### Unmounting a Volume

1. Touch **Unmount Volume**.
2. Touch **sdcard** to list the mounted volumes on the On-device Storage or **internal** to list the mounted volumes on internal storage.
3. Touch OK.
4. Select the volume to un-mount.
5. Touch OK.

### Deleting a Volume

1. If the encrypted volume is mounted, unmount it.
2. Touch **Delete Volume**.
3. Touch **sdcard** to list the unmounted volumes on the On-device Storage or **internal** to list the unmounted volumes on internal storage.
4. Select the volume to delete.
5. Touch OK.

### Creating an EFS File

When creating an encrypted volume, the parameter information can be imported from a file instead of entering manually.

1. On a host computer, create a text file.
2. In the text file enter the following:

   `<Volume Name> <Volume Storage Type> <Key Name> <Mount Path> <Auto Mount> <Volume size>

   where:

   `<Volume Name> = name of the volume`
<Volume Storage Type> = storage location. Options: internal or sdcard.
<Key Name> = name of the key to use when creating the volume.
<Mount Path> = path where the volume will be located.
<Auto Mount> = Options: 1 = yes, 0 = no.
<Volume size> = size of the volume in Megabytes.

Example:
MyVolume sdcard key1 /mnt/sdcard/efsfolder 1 1

3. Save the text file as efsfile.

Off-line Extraction Tool

The Secure Storage feature allows for the usage of an encrypted file system. The off-line extraction tool allows encrypted file systems to be used on an Ubuntu version number 10.04LTS desktop. The off-line extraction tool is a shell script used to create, mount and unmount an encrypted file system used with the Secure Storage feature.

Connect the device to the host computer.

Usage

On a Ubuntu desktop, at a terminal prompt, type: offline_extraction.sh.

The following Main Menu appears:

[ Offline-extraction tool ]
1) Create an image
2) Mount an existing EFS image
3) Unmount final mount location, device mapper and loop device
4) Quit

Please, choose one from the list and press ENTER:

Creating an Image

1. From the Main Menu, select item 1. The following appears:

   Please enter EFS file name (e.g. /tmp/1.efsmot): <volume name>
   Please enter encryption key (64-bytes hex value):
   Please enter the EFS image size (in MB): <volume size in MB>
   Please enter EFS image filesystem type (e.g. ext4, vfat...): ext4

   DONE - OK

2. The utility first prompts for the name of the volume to create. Any ASCII string that meets standard Linux file naming rules is valid. Enter the image name and then press Enter.

3. The utility then prompts for the encryption key. This is a 64 byte hexadecimal value. Enter a string of 64 hexadecimal digits and then press Enter.

4. The utility then prompts for the image size. Enter the size of the volume in MB. A number must be entered without the units. It is understood that MB. A value of 2000, is 2 GB. Note that 4 GB is the largest volume that is supported on the device.

5. The utility lastly prompts for the filesystem type. Enter ext4 and then press Enter.
The utility then creates the volume in the current working directory. The utility then finishes the creation process and then prompts to whether the volume should be mounted. Press [1] if you want to mount or press [2] if you want to exit.

6. Press 1 will prompt for the mount point. For example, /mnt is prompted. Press Enter to mount the encrypted volume at the selected point. After mounting, an option to return to the Main Menu or Exit is provided. Press 2 to exit the utility without mounting.

7. If the volume is mounted on the desktop, then that volume can be provisioned with files for deployment.

8. Unmounted volumes can then be copied to the device and subsequently mounted using the Secure Storage Administrator by providing the encryption key used.

Mounting an Image

1. From the Main Menu, select item 2. The following appears:
   Please enter EFS file name (e.g. /tmp/1.efsmot): <volume name>
   Please enter encryption key (64-bytes hex value):
   Please enter mount path (e.g. /mnt): <existing mount point>

DONE - OK

2. Enter the name of the volume and then press Enter.

3. The utility then prompts for the encryption key. This is a 64 byte hexadecimal value. Enter a string of 64 hexadecimal digits and then press Enter.

4. Enter the mount point where to connect the volume into the file system and then press Enter. The example of /mnt is provided.

Unmounting an Image

1. From the Main Menu, select item 3. The following appears:
   Please enter EFS file name (e.g. /tmp/1.efsmot): <volume name>

DONE - OK

2. Enter the name of the volume to unmount.

3. Press Enter.
CHAPTER 7 APPLICATION DEPLOYMENT FOR WINDOWS CE

Introduction

This chapter describes new features in Windows CE 7.0 including how to package applications, and procedures for deploying applications onto the MC92N0-G.

Packaging

Packaging combines an application's executable files into a single file, called a package. This makes it easier to deploy and install an application to the MC92N0-G. Package new applications and updates, such as new DLL files, as CAB files, then deploy them to the MC92N0-G.

Software Installation on Development PC

To develop applications to run on the MC92N0-G, use one or both of the following:

- Developer Kit (EMDK) for C
- Platform Software Developer Kit (Platform SDK) for MC92N0-G

The EMDK for C is a development tool used to create native C and C++ applications for the Zebra MC92N0-G. It includes documentation, header files (.H), and library files (.LIB) for native code application development that targets Zebra value-add APIs.

The Windows CE Platform SDK for MC92N0c70 is used in conjunction with the EMDK for C to create Windows CE applications for the MC92N0-G. The Platform SDK installs a new Windows CE device type and its associated libraries onto the development PC.

The software requirements to use the EMDK for C are:

- Microsoft ActiveSync 4.5 or higher. (only for Windows XP, Windows Vista and 7 has its own Mobile Device Center)
If developing applications for Windows CE 7.0
- Microsoft® Visual Studio 2005
- Microsoft® Visual Studio 2005 Service Pack1
(or)
- Microsoft® Visual Studio 2008
- Microsoft® Visual Studio 2008 Service Pack1

- One or more of the following Platform SDK’s:
  - Standard Software Development Kits Refresh
- For Windows CE embedded development use the Zebra Platform SDK (PSDK) for your specific device. The PSDK can be found on the device download page at http://www.zebra.com/support.

Platform SDK

![NOTE] Platform SDK is only required for Window CE 7.0 devices.

To download and install the appropriate Platform SDK:

   a. Select MC92N0-G. The MC92N0-G Product page displays.
   b. On the MC92N0-G Product page, select the appropriate Platform SDK for MC92N0 from the Software Downloads section. The Platform SDK page displays.
   c. Save the .exe file to the development computer.
2. Run the file and follow the screen prompts to install.

EMDK for C

To download and install the EMDK for C:

   a. Select MC92N0-G. The MC92N0-G Product page displays.
   b. On the MC92N0-G Product page, select the appropriate Developer Kit for C from the Software Downloads section. The Developer Kit for C page displays.
   c. Select the latest version, and save the .exe file to the development computer.
2. Locate the .exe file on the development computer, double-click the executable file and follow the install screen prompts.
3. Once installed, access the components of the EMDK for C from the Developer Kit for C program group of the Windows Start menu.
4. The sample applications provide examples of how to interface with the Zebra API functions. To build a sample application, open the Samples folder from the Windows Start menu. Open the folder for the desired sample and then open the project file. The project file has an extension of VCP. Microsoft Visual C++ v4.0 automatically launches. Select WinCE as the Active WCE Configuration. Select Win32 (WCE ARMV4) Debug as the active configuration.

![NOTE] If both Microsoft Visual C++ v3.0 and Microsoft Visual C++ v4.0 are installed on the development computer, ensure Microsoft Visual C++ v4.0 launches.
Installing Other Development Software

Developing applications for the MC92N0-G may require installing other development software, such as application development environments, on the development PC. Follow the installation instructions provided with the software.

Software Updates

Download updates to the EMDK for C from the Support Central web site at: http://www.zebra.com/support. Check this site periodically for important updates and new software versions.

Windows CE Flash Storage

In addition to the RAM-based storage standard on Windows CE, the MC92N0-G is also equipped with a non-volatile Flash-based storage area which can store data (partitions) that can not be corrupted by a cold boot. This Flash area is divided into two categories: Flash File System (FFS) Partitions and Non-FFS Partitions.

FFS Partitions

The MC92N0-G includes two FFS partitions. These partitions appear to the MC92N0-G as a hard drive that the OS file system can write files to and read files from. Data is retained even if power is removed.

The two FFS partitions appear as two separate folders in the Windows CE file system and are as follows:

- Platform: The Platform FFS partition contains Zebra-supplied programs and Dynamic Link Libraries (DLLs). This FFS is configured to include DLLs that control system operation. Since these drivers are required for basic MC92N0-G operation, only experienced users should modify the content of this partition.
- Application: The Application FFS partition is used to store application programs needed to operate the MC92N0-G.

Working with FFS Partitions

Because the FFS partitions appear as folders under the Windows CE file system, they can be written to and read like any other folder. For example, an application program can write data to a file located in the Application folder just as it would to the Windows folder. However, the file in the Application folder is in non-volatile storage and is not lost on a cold boot (e.g., when power is removed for a long period of time).

Standard tools such as ActiveSync can be used to copy files to and from the FFS partitions. They appear as the “Application” and “Platform” folders to the ActiveSync explorer. This is useful when installing applications on the MC92N0-G. Applications stored in the Application folder are retained even when the MC92N0-G is cold booted, just as the Sample Applications program is retained in memory.

There are two device drivers included in the Windows CE image to assist developers in configuring the MC92N0-G following a cold boot: RegMerge and CopyFiles.

RegMerge.dll

RegMerge.dll is a built-in driver that allows registry edits to be made to the Windows CE registry. Regmerge.dll runs very early in the boot process and looks for registry files (.reg files) in certain Flash File System folders during a cold boot. It then merges the registry changes into the system registry located in RAM.

Since the registry is re-created on every cold boot from the default ROM image, the RegMerge driver is necessary to make registry modifications persistent over cold boots.
RegMerge is configured to look in the root of two specific folders for .reg files in the following order:

- \Platform
- \Application

Regmerge continues to look for .reg files in these folders until all folders are checked. This allows folders later in the list to override folders earlier in the list. This way, it is possible to override Registry changes made by the Platforms partitions folders. Take care when using Regmerge to make registry changes.

NOTE Regmerge only merges the .reg files on cold boots. The merge process is skipped during a warm boot.

Making modifications to registry values for drivers loaded before RegMerge is not recommended. However, these values may require modification during software development. Since these early loading drivers read these keys before RegMerge gets a chance to change them, the MC92N0-G must be cold booted. The warm boot does not re-initialize the registry and the early loading driver reads the new registry values.

Do not use Regmerge to modify built-in driver registry values, or merge the same registry value to two files in the same folder, as the results are undefined.

CopyFiles

Windows CE expects certain files to be in the Windows folder, residing in volatile storage. Windows CE maintains the System Registry in volatile storage. CopyFiles copies files from one folder to another on a cold boot. Files can be copied from a non-volatile partition (Application or Platform) to the Windows or other volatile partition during a cold boot. During a cold boot CopyFiles looks for files with a .CPY extension in the root of the Platform and Application FFS partitions (Platform first and then Application). These files are text files containing the source and destination for the desired files to be copied separated by “>”.

Files are copied to the Windows folder from the Flash File System using copy files (*.cpy) in the following order:

- \Platform
- \Application

Example:

\Application\ScanSamp2.exe>\Windows\ScanSamp2.exe

This line directs CopyFiles to copy the ScanSamp2.exe application from the \Application folder to the \Windows folder.

Non-FFS Partitions

Non-FFS partitions include additional software and data pre-loaded on the MC92N0-G that can be upgraded. Unlike FFS Partitions, these partitions are not visible when the operating system is running. They also contain system information. Non-FFS partitions include the following:

- Windows CE: The complete Windows CE operating system is stored on Flash devices. If necessary, the entire OS image may be downloaded to the MC92N0-G using files provided by Zebra. Any upgrades must be obtained from Zebra. This partition is mandatory for the MC92N0-G.
- Splash Screen: a bitmap smaller than 16 Kb (and limited to 16 bits per pixel) is displayed as the MC92N0-G cold boots. To download a customized screen to display, see Creating a Splash Screen on page 7-16.
- Bootloader: This program interfaces with the host computer and allows downloading via USB cable any or all of the partitions listed above, as well as updated versions of Bootloader. Use caution downloading updated
Application Deployment for Windows CE 7 - 5

Bootloader versions; incorrect downloading of a Bootloader causes permanent damage to the MC92N0-G. Bootloader is mandatory for the MC92N0-G.

- Partition Table: Identifies where each partition is loaded in the MC92N0-G.

**Downloading Partitions to the MC92N0-G**

USBDownload is used to specify a hex destination file for each partition and download each file to the MC92N0-G. This download requires a program loader stored on the MC92N0-G. The MC92N0-G comes with a program loading utility, Bootloader, stored in the MC92N0-G’s write-protected flash.

**Bootloader**

Bootloader allows the user to upgrade the MC92N0-G with software updates and/or feature enhancements.

**Partition Update vs. File Update**

There are two types of updates supported by the MC92N0-G: partitions and files. The file system used by the MC92N0-G is the same as the file system used on a desktop computer. A file is a unit of data that can be accessed using a file name and a location in the file system. When a file is replaced, only the contents of the previous file are erased. The operating system must be running for a file to be updated, so the Bootloader cannot perform individual file updates as it is a stand-alone program that does not require the operating system to be running.

A typical partition is a group of files, combined into a single “partition” that represents a specific area of storage. Examples of partitions are the flash file systems such as Platform or Application. (Using the desktop computer comparison, these partitions are roughly equivalent to a C: or D: hard disk drive.) In addition to the “hard disk” partitions, some partitions are used for single items such as the operating system, monitor, or splash screen. (Again using a desktop computer comparison, these partitions are roughly the equivalent of the BIOS or special hidden system files.) When a partition is updated, all data that was previously in its storage region is erased - i.e. it is not a merge but rather a replacement operation. Typically, the operating system is not running when partitions are update, so Bootloader can perform partition updates.

All partition images suitable for use by Bootloader are in hex file format for transfer by USBDownloader from the development computer to the MC92N0-G.

**Upgrade Requirements**

Upgrade requirements:

- The hex files to be downloaded (on development computer)
- A connection from the host computer and the MC92N0-G
- USBDownload (on development computer) to download the files.

Once these requirements are satisfied, the MC92N0-G can be upgraded by invoking Bootloader and navigating the menus. See *Bootloader on page 7-5* for procedures on downloading a hex file to the MC92N0-G.

**Deployment**

This section provides information about installing software and files on the MC92N0-G.

Software deployment can be performed by:

- Copying files from a host computer
- Installing programs
• Updating images.

Copying Files from a Host Computer

To copy files from a host computer to the MC92N0-G:

1. Ensure that ActiveSync or Windows Mobile Device Center is installed on the host computer and that a partnership was created. For more information see, Chapter 3, Synchronization.

2. Connect the MC92N0-G to the host computer using a Single Slot Serial/USB cradle or an appropriate cable. See, Chapter 2, Accessories for connection information.

3. On the host computer, select Start > Programs > ActiveSync.

4. Select Explore.

5. Double-click the folder to expand the folder contents.
6. Use Explorer to locate the host computer directory that contains the file to download. Tap that directory in the left pane to display its contents in the right pane.

7. Drag the desired file(s) from the host computer to the desired mobile device folder.

Adding Programs

Install the appropriate software on the host computer before installing it on the MC92N0-G:

1. Download the program to the host computer (or insert the CD or disk that contains the program into the host computer). The program may consist of a single *.*.xip file, *.*.exe file, a *.*.zip file, or a Setup.exe file.

2. Read any installation instructions, ReadMe files, or documentation that comes with the program. Many programs provide special installation instructions.

3. Connect the MC92N0-G to the host computer using an accessory described in Chapter 2, Accessories.

4. Ensure that a connection is established.

5. Double-click the executable file on the host computer.

   If the file is an installer, the installation wizard begins. Follow the directions on the window. Once the software is installed on the host computer, the installer transfers the software to the MC92N0-G.

   If the file is not an installer, an error message states that the program is valid but is designed for a different type of computer. Copy this file to the MC92N0-G. Follow the installation instructions for the program in the ReadMe file or documentation, or use ActiveSync Explore to copy the program file to the Program Files folder on the MC92N0-G as described in Copying Files from a Host Computer on page 7-6. For more information on copying files using ActiveSync, refer to ActiveSync Help.

6. When installation is complete, tap Start > Programs on the MC92N0-G, then tap the program icon.

Adding a Program from the Internet

1. Download the program to the MC92N0-G from the Internet using Internet Explorer.

2. Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide special installation instructions.

3. Tap the file, such as a .xip or .exe file, to launch the installation wizard. Follow the directions on the window.
Updating Images

The MC92N0-G contains tools that update all operating system components. All updates are distributed as packages and/or hex images. Update packages can contain either partial or complete updates for the operating system. Zebra distributes the update packages on the Support Central Web Site, http://www.zebra.com/support.

Update an operating system component using one of the following:

- MSP. See Mobility Services Platform on page 7-15 for more information.
- OS Update
- BootLoader.

Windows CE 7.0 OSUpdate Loader

Operating system component can be downloaded to the MC92N0-G using the MC92N0-G temp directory or an SD card.

Using MC92N0-G Temp Directory

To initiate an update using the MC92N0-G temp directory:

2. Download the appropriate update package.
3. Connect the MC92N0-G to a host computer using the Single Slot Serial/USB Cradle or USB Communication Cable. See Chapter 2, Accessories.
4. On the host computer, use ActiveSync to copy the update package to the temp directory on the MC92N0-G.
5. On the MC92N0-G, use Windows Explorer and navigate to the temp directory.
6. Open the OSUpdate folder.
7. Double tap on the file: 92N0c70Ben_TEMP.lnk.
8. When the OS Update application finds the appropriate file, it loads the package onto the MC92N0-G. A progress bar displays until the update completes.
9. When complete, the MC92N0-G re-boots and the calibration screen appears.

Using an SD Card

To initiate an update using an SD card:

2. Download the appropriate update package.
3. Copy the update package to the root directory of an SD card (using a host computer).
4. Suspend the MC92N0-G.
5. Remove the keypad. See Keypads on page 2-5 for more information.
6. Install the SD card.
7. Replace the keypad. See Keypads on page 2-5 for more information.
8. Connect the MC92N0-G to AC power. See Chapter 2, Accessories.
9. Press the Power button to turn on the MC92N0-G.
10. Use Windows Explorer to navigate to the SD card folder.
11. Open the OSUpdate folder.
12. Double tap on the file: 92N0c70Ben_SD.lnk
13. When the OS Update application finds the appropriate file, it loads the package onto the MC92N0-G. A progress bar displays until the update completes.
14. When complete, the MC92N0-G re-boots and the calibration screen appears.

**Bootloader**

Use Bootloader to download hex files to the MC92N0-G from an SD card or from a host computer via USB.

**Loading Files From an SD Card**

To load the hex files on to the MC92N0-G using an SD card:

1. Copy the files to the root directory of an SD card.
2. Remove the keypad. See *Keypads on page 2-5*.
3. Insert the SD card into the MC92N0-G.
4. Install the keypad. See *Keypads on page 2-5*.
5. Press the primary battery releases. The battery partially ejects from the MC92N0-G.
6. Simultaneously press and release the **Power** button and the trigger.
7. Immediately, as soon as the device starts to boot, press and hold the trigger.
8. Continue to hold the trigger until the Bootloader screen appears.
9. When the **Bootloader** screen appears, release the trigger.

![Figure 7-4](image-url)  
*Figure 7-4  Bootloader Menu*

**CAUTION** To ensure a successful download, do not remove power from the MC92N0-G while in Bootloader.

1. Use the up and down scroll buttons to select **Download from SD card**, then press **Enter**.
2. The Bootloader displays the hex files available on the SD card.
Figure 7-5  Hex File List

3. Use the up and down scroll buttons to select a hex file, then press **Enter**.
4. The hex file is downloaded to the device.

Figure 7-6  Download Complete Screen

5. On completion, press **ENTER** to return to the Bootloader menu to select the next file to download.
6. To exit Bootloader, select **Exit** from the Bootloader main screen and press **ENTER**.

### Loading Files via USB

Use Bootloader to download customized flash file system partitions to the MC92N0-G and load hex files to the flash memory of the MC92N0-G.

To load the hex files on to the MC92N0-G using USB:

1. Download the *WCE USBDownload* application from the Support Central web site. Follow the installation instructions with the application.
2. Connect the MC92N0-G to a host computer using the Single Slot Serial/USB Cradle or USB Cradle Cable.
3. On the host computer, launch the *WCE USBDownload* application.

![USB Download Window](image)

**Figure 7-7  USB Download Window**

4. Press the primary battery release to partially eject the battery from the MC92N0-G.
5. Press and hold the trigger and then press and release the **Power** button.
6. Continue to hold the trigger and push the battery back into the MC92N0-G.
7. When the **Bootloader** screen appears, release the trigger.

![Bootloader Screen](image)

**Figure 7-8  Bootloader Screen**

**CAUTION** To ensure a successful download, do not remove power from the MC92N0-G while in Bootloader.

8. Place the MC92N0-G into a Single Slot Serial/USB Cradle.
9. Use the up and down scroll buttons to select **Download from USB**, then press **ENTER**.
10. The Bootloader displays the following:
11. On the WCE USBDownload application, locate the hex files to download.

   NOTE  One hex file or multiple hex files can be selected. To select multiple files, press the Ctrl key while selecting files.

   If selecting multiple files to download, USBDownload reads the header of the file and identifies the file type. If the Partition table file is among the files selected, then USBDownload downloads that file first. Similarly, USBDownload downloads the CPLD file last.

12. Select the hex files and click Open.

13. Click the SEND DATA button. The hex file is downloaded to the MC92N0-G.
14. On completion, press ENTER to return to the Bootloader main screen to select the next file to download.

15. To exit Bootloader, select Exit from the Bootloader main screen and press ENTER.

Bootloader Error Detection

While receiving data, Bootloader performs many checks on the data to ensure that the data is received correctly. If an error is detected, Bootloader immediately aborts the download, and reports the error on an error screen. This error message screen displays until a key is pressed. Once the screen is acknowledged, Bootloader returns to the main menu to wait for a new selection.

To find the probable cause of the error, use the error number and/or the error text displayed on the screen to look up the error in Table 7-1.

Table 7-1 Bootloader Errors

<table>
<thead>
<tr>
<th>Error Text</th>
<th>Error Number</th>
<th>Probable Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unknown error</td>
<td>-1</td>
<td>A general error occurred. Retry the download. If the failure persists, it is most likely due to a hardware failure; the MC92N0-G requires servicing.</td>
</tr>
<tr>
<td>Cancelled by user</td>
<td>-2</td>
<td>The user cancelled the download.</td>
</tr>
<tr>
<td>Can't open the source</td>
<td>-7</td>
<td>An error occurred opening the source device (either USB or SDMMC). Check source device connectivity and retry.</td>
</tr>
<tr>
<td>Can't open the destination</td>
<td>-8</td>
<td>An error occurred opening the destination device (either NAND, RAM, Power Micro, IST, Keyboard Controller or CPLD). Retry the download. If the failure persists, it is most likely due to a hardware failure; the MC92N0-G requires servicing.</td>
</tr>
<tr>
<td>Can't read from the source device</td>
<td>-9</td>
<td>The source device (either USB or SDMMC) could not be read from. Check source device connectivity and retry.</td>
</tr>
</tbody>
</table>
### Table 7-1  Bootloader Errors (Continued)

<table>
<thead>
<tr>
<th>Error Text</th>
<th>Error Number</th>
<th>Probable Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can't write to the destination device</td>
<td>-10</td>
<td>The destination device (either NAND, RAM, Power Micro, IST, Keyboard Controller or CPLD) could not be written to. Retry the download. If the failure persist, it is most likely due to a hardware failure; the MC92N0-G requires servicing.</td>
</tr>
<tr>
<td>Transmission checksum error</td>
<td>-11</td>
<td>An error occurred during transmission from the source device (either USB or SDMMC) and the checksum check failed. Check source device connectivity and retry.</td>
</tr>
<tr>
<td>Readback checksum error</td>
<td>-12</td>
<td>A checksum, generated from reading back data that was written to the destination device, was incorrect. An error during transmission or a write error to the destination device could cause this.</td>
</tr>
<tr>
<td>There is no more heap space available</td>
<td>-14</td>
<td>There is no more heap space available for the download procedure. Restart Bootloader and retry the download. If the failure persists, contact service with details of what is being downloaded.</td>
</tr>
<tr>
<td>Invalid data in verify file</td>
<td>-19</td>
<td>The file contains invalid data. Check that the file is suitable for downloading on this terminal.</td>
</tr>
<tr>
<td>Insufficient memory for buffering data</td>
<td>-20</td>
<td>There is no more heap space available for the download procedure. Restart Bootloader and retry the download. If the failure persists, contact service with details of what is being downloaded.</td>
</tr>
<tr>
<td>Insufficient data available to complete record</td>
<td>-21</td>
<td>A HEX file download was attempted but the HEX file is invalid. Ensure the file is in proper HEX file format.</td>
</tr>
<tr>
<td>Invalid Symbol HEX file</td>
<td>-23</td>
<td>A HEX file download was attempted but the HEX file is invalid. Ensure the file is in proper HEX file format.</td>
</tr>
<tr>
<td>Unrecognized or unsupported HEX record</td>
<td>-24</td>
<td>The HEX file being downloaded contains an invalid or unrecognized HEX record. Ensure the file is in proper HEX file format.</td>
</tr>
<tr>
<td>Invalid data in HEX file</td>
<td>-25</td>
<td>The HEX file being downloaded contains invalid data. Ensure the file is in proper HEX file format with valid HEX data.</td>
</tr>
<tr>
<td>Exceeded max size</td>
<td>-26</td>
<td>The download file is too large to fit into the space allocated for it. Either make the file smaller or increase the space allocated for it by altering the partition table.</td>
</tr>
<tr>
<td>Partition is not valid on this device</td>
<td>-27</td>
<td>The downloaded file specifies a partition entry that does not exist on the device. Only download files that are valid for this device, or change the partition table so that the new file is valid on the device.</td>
</tr>
<tr>
<td>Wrong destination code</td>
<td>-28</td>
<td>A specific partition was chosen from the Bootloader main menu but the file selected for download was for another partition. Ensure that the partition selected from the Bootloader main menu matches the file selected for download.</td>
</tr>
<tr>
<td>Non-contiguous record found</td>
<td>-30</td>
<td>A HEX file download was attempted but the HEX file is invalid. Ensure the file is in proper HEX file format.</td>
</tr>
</tbody>
</table>
The MSP Client Software is a set of software components that come pre-installed on the MC92N0-G. The MSP Client software consists of the following components:

The RD Client provides support for MSP Staging functionality, provides support for the MSP Legacy Staging process, and provides support for backward-compatible legacy MSP 2.x Legacy Staging functionality.

The MSP Agent provides MSP Provisioning functionality and Control functionality when used with MSP Control Edition.

Refer to the Mobility Services Platform User’s Guide, p/n 72E-100158-06, for instructions for using the Rapid Deployment and MSP Agent clients.

<table>
<thead>
<tr>
<th>Error Text</th>
<th>Error Number</th>
<th>Probable Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timed Out - No data</td>
<td>-31</td>
<td>Bootloader was waiting for data from the source device but timed out before receiving any. Check the source device connectivity and retry.</td>
</tr>
<tr>
<td>Invalid file format</td>
<td>-33</td>
<td>The file format is invalid. Only HEX files are supported by Bootloader.</td>
</tr>
<tr>
<td>Partition Table not Valid</td>
<td>-34</td>
<td>The size of flash memory is different than that described in the partition table. Retry the download with the correct partition table file.</td>
</tr>
<tr>
<td>Invalid data in file</td>
<td>-35</td>
<td>The .bin or .sig file being downloaded contains invalid data. Ensure the file is in proper file format.</td>
</tr>
<tr>
<td>File cannot be loaded to this unit</td>
<td>-38</td>
<td>The file contains valid data that indicates it cannot be loaded onto the device.</td>
</tr>
<tr>
<td>File validation failed</td>
<td>-40</td>
<td>The file has either been signed incorrectly, or contains data that indicates that it cannot be loaded onto the terminal.</td>
</tr>
</tbody>
</table>

Mobility Services Platform

The MSP Client Software is a set of software components that come pre-installed on the MC92N0-G. The MSP Client software consists of the following components:

The RD Client provides support for MSP Staging functionality, provides support for the MSP Legacy Staging process, and provides support for backward-compatible legacy MSP 2.x Legacy Staging functionality.

The MSP Agent provides MSP Provisioning functionality and Control functionality when used with MSP Control Edition.

Refer to the Mobility Services Platform User’s Guide, p/n 72E-100158-06, for instructions for using the Rapid Deployment and MSP Agent clients.
Creating a Splash Screen

A custom splash screen can be created and loaded onto the MC92N0-G. To create a custom splash screen:

1. Create a .bmp file using a graphic program with the following specifications:
   • Size: 296 H x 240 H.
   • Colors: 16 bits per pixel (65536 colors).
2. Modify the bitmap file and save.

To load the splash screen on the MC92N0-G Windows CE device:

1. Convert the bmp file into a hex file using the OSUpdate Package Builder that is part of MSP.
2. Copy the hex file to the MC92N0-G using BootLoader. See *Bootloader on page 7-9.*
CHAPTER 8 APPLICATION DEPLOYMENT FOR WINDOWS EMBEDDED HANDHELDs

Introduction

This chapter describes new features in Windows Embedded Handheld including new security features, how to package applications, and procedures for deploying applications onto the MC92N0-G.

Security

The MC92N0-G implement a set of security policies that determine whether an application is allowed to run and, if allowed, with what level of trust. To develop an application, you must know the security configuration of the device, and how to sign an application with the appropriate certificate to allow the application to run (and to run with the needed level of trust).

Application Security

Application security controls the applications that can run on the MC92N0-G.

- Trusted - All applications must be digitally signed by a certificate on the MC92N0-G.
- Prompted - User is prompted to allow unsigned applications to run.
- Open - All applications run.

Developers can include their own certificates and provision the device to “trusted.”

Digital Signatures

Digital signatures provide a way to authenticate the author of EXEs, DLLs, and packages. Digitally signed applications give users confidence that an application comes from where they think it comes from. For example, if an end-user downloads an update package from the internet that is digitally signed with Zebra’s software certificate, they are assured that the package is authentic and that it was created by Zebra. By enforcing the use of digital signatures, users can also prevent malicious applications from executing on the MC92N0-G. For example, users can provision the MC92N0-G to only execute “trusted” applications (digitally signed).

Zebra ships all Windows Embedded Handheld based products in an “open” state, which means all signed and unsigned applications should work. However, customers can still reconfigure their MC92N0-G to operate in the
“trusted” mode. This means that only applications signed with a certificate from the Privileged Execution Trust Certificate Store can run.

To support the broadest number of deployments, third-party software developers should perform the following when releasing software for a Windows Embedded Handheld devices:

- Sign all their EXEs & DLLs with their private key
- Provide the corresponding public certificate to end-users so that it can be installed into Privileged Execution Trust Certificate Store.

If the software is installed via a .CAB file, developer should also:

- Sign the .CAB file with their private key
- Provide the corresponding public certificate to end-users so that it can be installed into SPC Certificate Store.

**Locking Down a MC92N0-G**

Like most configuration options in Windows Embedded Handheld, security settings are set via XML provisioning. For example, to enforce the “trusted” model and only allow applications signed with a privileged certificate to run, use the following provisioning document:

```xml
<wap-provisioningdoc>
  <characteristic type="SecurityPolicy">
    <!-- Disallow unsigned apps -->
    <parm name="4102" value= "0"/>

    <!-- No Prompt -->
    <parm name="4122" value= "1"/>
  </characteristic>
</wap-provisioningdoc>
```

For more information on various security options, refer to the Security Policy Settings topic in the latest Windows Mobile SDK documentation.
Installing Certificates

Use XML provisioning to query and delete certificates from certificate stores. To add a new certificate the Privileged Execution Trust Certificate Store, use the following sample provisioning document:

```xml
<wap-provisioningdoc>
  <characteristic type="CertificateStore">
    <characteristic type="Privileged Execution Trust Authorities">
      <characteristic type="657141E12FA45786F6A57CA6464032D4B3A55475">
        <parm name="EncodedCertificate" value="This is sample text. This is sample text. This is sample text. This is sample text. This is sample text. This is sample text. This is sample text. This is sample text. This is sample text. This is sample text. This is sample text. This is sample text. This is sample text. = "/>
      </characteristic>
    </characteristic>
  </characteristic>
</wap-provisioningdoc>
```

To create your own provisioning document with real certificate information:

1. Obtain a certificate from a security provider such as VeriSign.
2. Double-click on the certificate file (.CER) to open it.
3. Click on the Details tab and locate the Thumbprint field.
4. Copy the contents of the Thumbprint field and replace the value in the XML example above.
5. Click the Copy to File… button.
6. Click Next to start the Certificate Export Wizard.
7. Select Base-64 encoded X.509 (.CER) and then click Next.
8. Set the File Name to CertOutput.xml and click Next.
9. Click Finish to export the certificate.
10. Open the exported file, CertOutput.xml, in a text editor (i.e., NotePad).
11. Copy the contents of the file (excluding the first line, last line, and CR/LF) and replace the value of the “EncodedCertificate” parameter in the xml example above.

Device Management Security

You can control access to certain device settings and security levels, such as installing applications and changing security settings. Refer to the Windows Mobile SDK documentation for information on device management security.

Remote API Security

The Remote API (RAPI) enables applications that run on a desktop to perform actions on a remote device. RAPI provides the ability to manipulate the file system on the remote device, including the creation and deletion of files and directories. By default, Zebra ships with RAPI in the restricted mode. Certain tools, such as RAPIConfig, may
not work properly. Refer to the Windows Mobile SDK documentation for finding information on Remote API security policies.

**XML Provisioning**

To configure the settings on an MC92N0-G, use XML provisioning. To install an XML provisioning file on the MC92N0-G, create a Cabinet Provisioning File (CPF). A CPF file is similar to a CAB file and contains just one file: _setup.xml. Like a CAB file, the CPF extension is associated with WCELoad.EXE. Opening a CPF extracts the XML code and uses it to provision and configure the MC92N0-G. The user receives an e-mail notification indicating success or failure.

XML provisioning provides the ability to configure various features of the MC92N0-G (i.e., registry and file system). However, some settings require security privileges. To change registry settings via a CPF file, you must have certain privileges (roles). Some registry keys require you to simply be an Authenticated User, while other registry keys require you to be a Manager. Refer to the Windows Mobile SDK documentation for the default role settings in Windows Embedded Handheld.

For those registry settings that require the Manager role, the CPF file must be signed with a privileged certificate installed on the device. Refer to the Windows Mobile SDK documentation for instructions and sample test certificates.

**Creating an XML Provisioning File**

To create a .cpf file:

1. Create a valid provisioning XML file named _setup.xml using an XML editor or the tools supplied with Visual Studio 2005. (For example, use the SampleReg.xml sample created in the RegMerge section and rename it _setup.xml.) Ensure the file contains the required parameters for the operation. Refer to the Windows Mobile SDK documentation for information.

2. In the Windows Embedded Handheld tools directory on the desktop computer (typically \Program Files\Windows CE Tools\wce500\Windows Mobile 6 Pocket PC SDK\Tools), run the Makecab.exe utility, using the following syntax to create a .cpf file from the _setup.xml file:

   MakeCab.exe /D COMPRESS=OFF _setup.xml myOutCpf

   ✓ **NOTICE** COMPRESS=OFF is required for backward compatibility with Pocket PC.

3. Optionally, use the Authenticode tools to sign the .cpf file.
4. Tap the filename to install.
5. Certain applications and settings require a cold boot to take affect. In these cases, cold boot the MC92N0-G. Refer to the Windows Mobile SDK documentation for more information.

**XML Provisioning vs. RegMerge and Copy File**

Prior to Windows Embedded Handheld, Zebra used two drivers (RegMerge and CopyFiles) to update the registry and to copy files during a cold boot. With Embedded Handheld, Zebra recommends using XML provisioning instead. RegMerge and CopyFiles are supported for backward compatibility but Zebra may eliminate support in the future. The following sections provide examples of how RegMerge and CopyFiles were used, and how to perform the same function using XML provisioning.
**RegMerge**

RegMerge.dll is a built-in driver that allows updating the registry during a clean boot. RegMerge runs very early in the boot process and looks for registry files (.reg files) in certain Flash File System folders (i.e., \Application) during a clean boot. It then merges the registry changes into the system registry located in RAM.

The following example uses RegMerge to set a registry key:

SampleReg.reg

```
[HKEY_LOCAL_MACHINE\Hardware\DeviceMap\Backlight]
"BacklightIntensity"=dword:00000036
```

The following example uses XML provisioning to perform the same task:

SampleReg.xml

```
<wap-provisioningdoc>
  <characteristic type= "Registry">
    <characteristic type= "HKLM\Hardware\DeviceMap\Backlight">
      <parm name= "BacklightIntensity" value= "54" datatype= "integer" />
    </characteristic>
  </characteristic>
</wap-provisioningdoc>
```

**CopyFiles**

CopyFiles copies files from one folder to another on a clean boot. During a clean boot CopyFiles looks for files with a .CPY extension in the root of the Application FFS partition. These files are text files containing the source and destination for the desired files to copy, separated by “>”.

The following example uses CopyFiles to copy a file from the \Application folder to the \Windows folder:

SampleCpy.cpy

```
\Application\example.txt > \Windows\example.txt
```

The following example uses XML provisioning to perform the same task:

SampleCpy.xml

```
<wap-provisioningdoc>
  <characteristic type= "FileOperation">
    <characteristic type= "\Windows" translation= "filesystem">
      <characteristic type= "MakeDir"/>
      <characteristic type= "example.txt" translation= "filesystem">
        <characteristic type= "Copy">
          <parm name= "Source" value= "\Application\example.txt" translation= "filesystem"/>
        </characteristic>
      </characteristic>
    </characteristic>
  </characteristic>
</wap-provisioningdoc>
```
Packaging

Packaging combines an application's executable files into a single file, called a package. This makes it easier to deploy and install an application to the MC92N0-G. Package new applications and updates, such as new DLL files, as CAB files, then deploy them to the MC92N0-G. Refer to the Windows Mobile SDK documentation for information on CAB files.

Software Installation on Development PC

To develop applications to run on the MC92N0-G, use the Developer Kit (EMDK) for C.

The EMDK for C is a development tool used to create native C and C++ applications for the Zebra MC92N0-G. It includes documentation, header files (.H), and library files (.LIB) for native code application development that targets Zebra value-add APIs.

The software requirements to use the EMDK for C are:

- Microsoft ActiveSync 4.5 or higher. (only for Windows XP, Windows Vista and 7 has its own Mobile Device Center)
- If developing applications for Windows Embedded Handheld:
  - Microsoft® Visual Studio 2005
  - Microsoft® Visual Studio 2005 Service Pack1
  (or)
  - Microsoft® Visual Studio 2008
  - Microsoft® Visual Studio 2008 Service Pack1
- One or more of the following Platform SDK's:
  - Windows Mobile 6 Professional and Standard Software Development Kits Refresh

EMDK for C

To download and install the EMDK for C:

   b. Select MC92N0-G. The MC92N0-G Product page displays.
   c. On the MC92N0-G Product page, select the appropriate Developer Kit for C from the Software Downloads section. The Developer Kit for C page displays.
   d. Select the latest version, and save the .exe file to the development computer.
2. Locate the .exe file on the development computer, double-click the executable file and follow the install screen prompts.
3. Once installed, access the components of the EMDK for C from the Developer Kit for C program group of the Windows Start menu.
4. The sample applications provide examples of how to interface with the Zebra API functions. To build a sample application, open the Samples folder from the Windows Start menu. Open the folder for the desired sample and then open the project file. The project file has an extension of VCP. Microsoft Visual C++ v4.0
automatically launches. Select WinCE as the Active WCE Configuration. Select Win32 (WCE ARMV4) Debug as the active configuration.

**NOTE** If both Microsoft Visual C++ v3.0 and Microsoft Visual C++ v4.0 are installed on the development computer, ensure Microsoft Visual C++ v4.0 launches.

**Installing Other Development Software**

Developing applications for the MC92N0-G may require installing other development software, such as application development environments, on the development PC. Follow the installation instructions provided with the software.

**Software Updates**

Download updates to the EMDK for C from the Support Central web site at: [http://www.zebra.com/support](http://www.zebra.com/support). Check this site periodically for important updates and new software versions.

**Windows Mobile File Storage**

Windows Embedded Handheld contains three types of file storage:

- Random Access Memory (RAM)
- Persistent Storage
- Application folder.

**Random Access Memory**

Executing programs use RAM to store data. Data stored in RAM is lost upon a warm boot. RAM also included a volatile file storage area called *Cache Disk*.

**Volatile File Storage (Cache Disk)**

Windows Embedded Handheld memory architecture uses persistent storage for all files, registry settings, and database objects to ensure data is retained even after a power failure. Persistent storage is implemented using Flash memory technology which is generally slower than volatile RAM memory. In certain situations the speed of the operation is more important than the integrity of the data. For these situations, Zebra has provided a small volatile File Storage volume, accessed as the *Cache Disk* folder. Disk operations to the *Cache Disk* folder are much faster than to any of the persistent storage volumes, but data is lost across warm boots and power interruptions. Note that a backup battery powers RAM memory, including the *Cache Disk*, when you remove the main battery for a short period of time.

The MC92N0-G uses the *Cache Disk* for temporary data that can be restored from other sources, for example, for temporarily “caching” HTML web pages by a browser or generating formatted files to send to a printer. Both situations benefit from the increased speed of the cache disk, but you can restore the data if needed.

DO NOT use the *Cache Disk* as a method to improve application performance. Analyze applications that perform slower in persistent storage to optimize disk access. Common areas for optimization include minimizing the number of reads and writes to a file, removing unneeded debug logging, and minimizing file flushing or closing files.
Persistent Storage

Windows Embedded Handheld protects all data and applications from power-related loss. Because Windows Embedded Handheld mounts the entire file system and registry in persistent storage (rather than using RAM), MC92N0-G devices provide a reliable storage platform even in the absence of battery power.

Persistent storage provides application developers with a reliable storage system available through the standard file system and registry APIs. Persistent storage is optimized for large reads and writes; therefore, applications reading and writing data in large chunks tend to outperform those applications reading and writing small blocks of data. Data in persistent storage is lost upon a clean boot.

Persistent storage contains all the directories under the root directory except for Application, Cache Disk, and Storage Card (if a storage card is installed). Persistent storage is approximately 1.1 GB (formatted).

Application Folder

The Application folder is a super-persistent storage that is persistent even after a clean boot. Accessing data in the Application folder is slower than accessing persistent storage. The Application folder is used for deployment and device-unique data. For example, network profiles can be stored in the Application folder so that connection to the network is available after a cold boot. The Application folder is approximately 1.218 GB (formatted):

Deployment

To install applications onto the MC92N0-G, developers package the application and all required files into a CAB file, then load the file onto the MC92N0-G using one of the following options:

- Microsoft ActiveSync 4.5 or higher
- Storage Card
- MSP
- Image Loader Image (for updating the operating system).

Refer to the Windows Mobile SDK documentation for information on CAB files.

Installation Using ActiveSync

To install an application package:

- Connect the MC92N0-G to a host computer using ActiveSync. See Chapter 3, Synchronization for more information.
- Locate the package file on the host computer.
- In ActiveSync on the host computer, open Explorer for the MC92N0-G.
- Copy the CAB file from the host computer to the \temp directory on the MC92N0-G.
- On the MC92N0-G, navigate to the \temp directory.
- Tap on the application CAB file. The application installs on the MC92N0-G.

Installation Using Storage Card

To install an application package:

- Copy the package CAB file to an storage card using an appropriate storage card reader.
• Install the storage card into the MC92N0-G. Refer to the MC92N0-G User Guide for more information.
• On the MC92N0-G, open File Explorer.
• Open the Storage Card directory.
• Tap the package CAB file. The application installs on the MC92N0-G.

**Installation Using USB Connection**

To install an application or copy files to the MC92N0-G using a USB connection:


![USBConfig Window](image)

2. Tap USB Client radio button.
3. Select the USB Client Mode tab.
4. Select the Mass Storage checkbox.
5. In the drop-down list, select either \Storage Card, \Application or \Cache Disk.
6. Tap OK.
7. Connect the MC92N0-G to a host computer using either a single slot cradle or a USB cable.
9. Double-click the drive letter to open the folder.
10. On the host computer, open another Windows Explorer window and locate the files to copy to the MC92N0-G.
11. Drag the files from the new window to the MC92N0-G folder window.
12. When complete, disconnect the MC92N0-G from the host computer.

**Installation Using AirBEAM**

The AirBEAM Smart Client provides backward-compatible legacy AirBEAM functionality and backward-compatible legacy MSP 2.x Level 2 Agent functionality.

Refer to the AirBEAM Smart Windows CE Client Product Reference Guide, p/n 72-63060-xx, for instructions for AirBEAM Smart client.
Mobility Services Platform

The Mobility Services Platform (MSP) Client Software is a set of software components that come pre-installed on the MC92N0-G. The MSP 3 Client software consists of the following components:

The RD Client provides support for MSP Staging functionality, provides support for the MSP Legacy Staging process, and provides support for backward-compatible legacy MSP 2.x Legacy Staging functionality.

The MSP Agent provides MSP Provisioning functionality and Control functionality when used with MSP Control Edition.

Refer to the Mobility Services Platform User’s Guide, p/n 72E-100158-xx, for instructions for using the Rapid Deployment and MSP Agent clients.

Update Loader Image

Windows Mobile contains an Image Update feature that updates all operating system components. All updates are distributed as update packages. Update packages can contain either partial or complete updates for the operating system. Zebra distributes the update packages on the Support Central Web Site, http://www.zebra.com/support.

To update an operating system component, copy the update package to the MC92N0-G using one of a variety of transports, including ActiveSync, an SD card or MSP.

Download Update Loader Package

2. Download the appropriate update loader package to a host computer.
3. Locate the update loader package file on the host computer and un-compress the file into a separate directory.

ActiveSync

To install an update loader package using ActiveSync:

1. Connect the MC92N0-G to a host computer using ActiveSync. See Chapter 3, Synchronization for more information.
2. In ActiveSync on the host computer, open Explorer for the MC92N0-G.
3. Copy all the update loader package files from the host computer to the \temp directory on the MC92N0-G.
4. On the MC92N0-G, navigate to the \temp directory.
5. Tap on the update loader file, STARTUPDLDR.EXE. The Update Loader application installs the update loader package on the MC92N0-G.
6. The MC92N0-G re-boots and immediately starts the update.
   A progress bar displays until the update completes.
7. The MC92N0-G re-boots.
8. The calibration screen appears.

SD Card

To install an update loader package using an SD card:

1. Copy all the update loader package files to the root directory of the SD card.
2. Install the SD card into the MC92N0-G.
3. Connect the MC92N0-G to AC power. See Chapter 2, Accessories.
4. Perform a cold boot.

5. Immediately, as soon as the device starts to boot and before the splash screen is visible, press and hold the trigger.

6. The Update Loader application looks for the update loader file in the root directory of the SD card. When it finds the file, it loads the update loader package onto the MC92N0-G. A progress bar displays until the update completes.

7. The MC92N0-G re-boots.

8. The calibration screen appears.

Creating a Splash Screen

Use a bitmap file to create a customized splash screens for the MC92N0-G. Use Image Update with a bitmap file, rather than a package file, to update the splash screen.

To create a custom splash screen:

1. Create a .bmp file using a graphic program with the following specifications:
   - Size: 592 H x 480 W.
   - Colors: 16 bits per pixel (65536 colors) for color displays.
2. Modify the bitmap file and save.

To load the splash screen on the MC92N0-G:

1. Create a text file named pkgs.lst which contains the name of the bmp file. For example, mysplash.bmp.
2. Copy the bmp file and the pkgs.lst file to one of the following:
   - SD card root directory
   - MC92N0-G’s \temp directory.
3. If using the SD card, insert the SD card into the MC92N0-G.
4. Perform a cold boot.
5. Immediately, as soon as the device starts to boot and before the splash screen is visible, press and hold the trigger.
CHAPTER 9 APPLICATION DEPLOYMENT FOR ANDROID DEVICES

Security

The device implements a set of security policies that determine whether an application is allowed to run and, if allowed, with what level of trust. To develop an application, you must know the security configuration of the device, and how to sign an application with the appropriate certificate to allow the application to run (and to run with the needed level of trust).

*NOTE* Ensure the date is set correctly before installing certificates or when accessing secure web sites.

Secure Certificates

If the VPN or Wi-Fi networks rely on secure certificates, obtain the certificates and store them in the device’s secure credential storage, before configuring access to the VPN or Wi-Fi networks.

If downloading the certificates from a web site, set a password for the credential storage. The device supports X.509 certificates saved in PKCS#12 key store files with a .p12 extension (if key store has a .pfx or other extension, change to .p12).

The device also installs any accompanying private key or certificate authority certificates contained in the key store.

Installing a Secure Certificate

1. Copy the certificate from the host computer to the root of the On-device Storage. See *Chapter 4, USB Communication* for information about connecting the device to a host computer and copying files.


3. Touch Install from sd card.

4. Navigate to the location of the certificate file.

5. Touch the filename of the certificate to install. Only the names of certificates not already installed display.

6. If prompted, enter the certificate’s password and touch OK.

7. Enter a name for the certificate and touch OK. If a password has not been set for the credential storage, enter a password for it twice and then touch OK.
The certificate can now be used when connecting to a secure network. For security, the certificate is deleted from the On-device Storage.

---

**Development Tools**


To start developing applications for the device, download the development SDK and the Eclipse IDE. Development can take place on a Microsoft® Windows®, Mac® OS X®, or Linux® operating system.

Applications are written in the Java language, but compiled and executed in the Dalvik VM (a non-Java virtual machine). Once the Java code is compiled cleanly, the developer tools make sure the application is packaged properly, including the `AndroidManifest.xml` file.

The development SDK is distributed as a ZIP file that unpacks to a directory on the host computer hard drive. The SDK includes:

- `android.jar`
  - Java archive file containing all of the development SDK classes necessary to build an application.
- `documentation.html` and `docs` directory
  - The SDK documentation is provided locally and on the Web. It's largely in the form of JavaDocs, making it easy to navigate the many packages in the SDK. The documentation also includes a high-level Development Guide and links to the broader community.
- `Samples` directory
  - The samples subdirectory contains full source code for a variety of applications, including `ApiDemo`, which exercises many APIs. The sample application is a great place to explore when starting application development.
- `Tools` directory
  - Contains all of the command-line tools to build applications. The most commonly employed and useful tool is the `adb` utility.
- `usb_driver`
  - Directory containing the necessary drivers to connect the development environment to an enabled device. These files are only required for developers using the Windows platform.

Open the Developer options screen to set development related settings.

On the Home screen, touch >  

**Developer options.** Slide the switch to the **ON** position to enable developer options.

---

**ADB USB Setup**

To use the ADB, install the USB driver. This assumes that the development SDK has been installed on the host computer. Go to http://developer.android.com/sdk/index.html for details on setting up the development SDK.

ADB driver for Windows and Linux are available on the Zebra Support Central web site at http://www.zebra.com/support. Download the ADB and USB Driver Setup package. Following the instructions with the package to install the ADB and USB drivers for Windows and Linux.
Application Installation

After an application is developed, install the application onto the device using one of the following methods:

- USB connection, see Installing Applications Using an SD Card on page 9-4.
- SD Card, see Installing Applications Using an SD Card on page 9-4.
- Android Debug Bridge, see Installing Applications Using the Android Debug Bridge on page 9-4.
- Mobile device management (MDM) platforms that have application provisioning. Refer to the MDM software documentation for details.

Installing Applications Using the USB Connection

CAUTION When connecting the device to a host computer and mounting its On-device Storage, follow the host computer’s instructions for connecting and disconnecting USB devices, to avoid damaging or corrupting files.

1. Connect the device to a host computer using USB. See Chapter 4, USB Communication.
2. On the host computer, copy the application .apk file from the host computer to the device.
3. Disconnect the device from the host computer. See Chapter 4, USB Communication.
4. On the device, touch 📦.
5. Touch 📦 to view files on the On-device Storage or Internal Storage.
7. Touch the application file to begin the installation process.
8. To confirm installation and accept what the application affects, touch Install otherwise touch Cancel.

![Accept Installation Screen](image)

Figure 9-1 Accept Installation Screen

9. Touch Open to open the application or Close to exit the installation process. The application appears in the App list.
Installing Applications Using an SD Card

To install an application using an SD card:

1. Copy the application .apk file to the root of an SD card.
2. Install the SD card into the MC92N0-G. See Secure Device (SD) Card on page 2-6.
3. On the device, touch 📁.
4. Touch 📁 to view files on the SD card.
5. Locate the application .apk file.
6. Touch the application file to begin the installation process.
7. To confirm installation and accept what the application affects, touch Install otherwise touch Cancel.

![Accept Installation Screen](image)

8. Touch Open to open the application or Done to exit without opening the application. The application appears in the App list.

Installing Applications Using the Android Debug Bridge

Use ADB commands to install application onto the device.

![CAUTION] When connecting the device to a host computer and mounting its On-device Storage, follow the host computer’s instructions for connecting and disconnecting USB devices, to avoid damaging or corrupting files.

Ensure that the ADB drivers are installed on the host computer. See ADB USB Setup on page 9-2.

1. Connect the device to a host computer using USB. See Chapter 4, USB Communication.
2. Touch 📲.
3. Touch \{ \} Developer options.
4. Slide the switch to the ON position.
6. Touch OK.
7. On the host computer, open a command prompt window and use the adb command:
8. adb install <application>
9. where: <application> = the path and filename of the apk file.
10. Disconnect the device from the host computer. See Chapter 4, USB Communication.

Uninstalling an Application

To uninstall an application:

1. Touch \(\text{ }\).
2. Touch Apps.
3. Swipe left or right until the Downloaded screen displays.

Figure 9-3 Downloaded Screen

4. Touch the application to uninstall.
5. Touch Uninstall.
6. Touch OK to confirm.

System Update

System Update packages can contain either partial or complete updates for the operating system. We distribute the System Update packages on the Support Central web site.

1. Download the system update package:
   b. Download the appropriate System Update package to a host computer.

2. Copy the M92N0XXXR0xxxxxxxx.zip file to the root of the Internal Storage (see Chapter 4, USB Communication) or an SD card.
3. Press the red **Power** button.
4. Touch **Reset**.
5. Press and hold the trigger.
6. When the System Recovery screen appears, release the trigger.

![System Recovery Screen](image)

**Figure 9-4  System Recovery Screen**

7. Use the arrow key to select **apply update from emulated storage** or **apply update from sdcard**.
8. Press the **Enter** key.
9. Use the arrow key to select **M92N0KXXXRUxxxxxxx.zip** file is highlighted.
10. Press the **Enter** key. The System Update installs and then the device resets.

### Storage

The device contains four types of file storage:

- Random Access Memory (RAM)
- External Storage
- Internal storage
- Enterprise folder.

### Random Access Memory

Executing programs use RAM to store data. Data stored in RAM is lost upon a reset.

The operating system manages how applications use RAM. It only allows applications and component processes and services to use RAM when required. It may cache recently used processes in RAM, so they restart more quickly when opened again, but it will erase the cache if it needs the RAM for new activities.

To view the amount of free and used memory, touch 📈 > **Apps**. Swipe the screen until the **Running** screen appears.
The bar at the bottom of the screen displays the amount of used and free RAM.

External Storage

The MC92N0-G can have a removable SD card. The SD card content can be viewed and files copied to and from when the MC92N0-G is connected to a host computer. Some applications are designed to be stored on the SD card rather than in internal memory.

To view the used and available space on the SD card, touch > > Storage.

- **Total space** - Displays the total amount of space on the installed SD card.
- **Apps** - Displays the available space used for applications and media content on the installed SD card.
- **Pictures, videos** - Displays the available space used for pictures and videos on the installed SD card.
- **Available** - Displays the available space on the installed SD card.
- **Unmount SD card** - Unmounts the installed SD card from the MC92N0-G so that it can be safely removed. This setting is dimmed if there is no SD card installed, if it has already been unmounted or if it has been mounted on a host computer.
- **Erase SD card** - Permanently erases everything on the installed SD card.
Internal Storage

The MC92N0-G has internal storage. The internal storage content can be viewed and files copied to and from when the MC92N0-G is connected to a host computer. Some applications are designed to be stored on the internal storage rather than in internal memory.

To view the used and available space on the internal storage, touch Storage.

Figure 9-7 Internal Storage Screen

- Internal Storage
  - **Total space** - Displays the total amount of space on internal storage (approximately 1.0 GB).
  - **Available** - Displays the available space on internal storage.
  - **Apps** - Displays the available space used for applications and media content on internal storage.
  - **Cached data** - Displays the amount of cached data on internal storage.

Enterprise Folder

The Enterprise folder (within internal flash) is a super-persistent storage that is persistent after a reset and an Enterprise Reset. The Enterprise folder is erased during a Factory Reset. The Enterprise folder is used for deployment and device-unique data. The Enterprise folder is approximately 128 MB (formatted). Applications can persist data after an Enterprise Reset by saving data to the enterprise/user folder. The folder is ext4 formatted and is only accessible from a host computer using ADB or from an MDM.

Application Management

Applications use two kinds of memory: storage memory and RAM. Applications use storage memory for themselves and any files, settings, and other data they use. They also use RAM when they are running.

From the Home screen touch Apps.
The **Apps** screen has four tabs, with lists of applications and their components in each. At the bottom of each tab is a graph of the memory used by the items in the list and amount of free memory.

Touch an application, process, or service in a list to open a screen with details about it and, depending on the item, to change its settings, stop it or uninstall it:

- Slide the screen to the **Downloaded** tab to view the applications downloaded to the device.
- Touch the **Running** tab to view the applications and their processes and services that are running or cached.
- Slide the screen to the **All** tab to view all the applications installed on the device, including factory installed applications and downloaded applications.

When on the **Downloaded** or **All** tab, press > Sort by size to switch the order of the list.

### Viewing Application Details

Applications have different kinds of information and controls, but commonly include:

- Touch **Force stop** to stop an application.
- Touch **Uninstall** to remove the application and all of its data and settings from the device. See *Uninstalling an Application on page 9-5* for information about uninstalling applications.
- Touch **Clear data** to delete an application’s settings and associated data.
- Cache If the application stores data in a temporary area, lists how much information is stored, and includes a button for clearing it.
- **Launch by default** clears If you have configured an application to launch certain file types by default, you can clear that setting here.
- **Permissions** lists the areas on the device that the application has access to.

### Stopping an Application

To monitor how much RAM running applications and cached processes are using and if necessary, stop them.

1. Touch 🕒 > **Apps**.
2. Swipe the screen to display the **Running** tab.
3. Touch **Show cached processes** or **Show running services** to switch back and forth. The **Running** tab lists the applications, processes, and services that are currently running or that have cached processes and how much RAM they are using.

![Running Applications](image)

**Figure 9-9**  *Running Applications*

4. The graph at the bottom of the screen displays the total RAM in use and the amount free. Touch an application, process, or service.

**NOTE** Stopping an application or operating system processes and services disables one or more dependent functions on the device. The device may need to be reset to restore full functionality.

5. Touch **Stop**.

---

**Managing Downloads**

Files and applications downloaded using the Browser or Email are stored on On–device Storage in the Download directory. Use the Downloads application to view, open, or delete downloaded items.

1. Touch ✗ > 📋.
2. Touch an item to open it.
3. Touch headings for earlier downloads to view them.
4. Check items to delete; then touch 🗑️. The item is deleted from storage.
5. Touch **Sort by size** or **Sort by time** to switch back and forth.

When an application is opened, the other applications being used do not stop. The operating system and applications work together to ensure that applications not being used do not consume resources unnecessarily, stopping and starting them as needed. For this reason, there’s no need to stop applications unless it is not functioning properly.
CHAPTER 10 DATALWEDGE CONFIGURATION

DataWedge Configuration

This chapter applies to DataWedge on Android devices. DataWedge is an application that reads data, processes the data and sends the data to an application.

Basic Scanning

Scanning can be performed using the imager.

Using the Imager

To capture bar code data:

1. Ensure that an application is open on the MC92N0-G and a text field is in focus (text cursor in text field).
2. Aim the exit window at a bar code.
3. Press and hold the a Scan key. The red aiming dot turns on to assist in aiming. Ensure that the aiming dot is over the bar code. The Data Capture LED lights red to indicate that data capture is in process.
4. The Data Capture LED lights green, a beep sounds and theMC92N0-G vibrates, by default, to indicate the bar code was decoded successfully. The captured data appears in the text field.

Profiles

DataWedge is based on profiles and plug-ins. A profile contains information on how DataWedge should behave with different applications.

Profile information consists of:

- Associated application
- Input plug-in configurations
- Data capture panel plug-in configuration
- Output plug-in configurations
- Process plug-in configurations.
Using profiles, each application can have a specific DataWedge configuration. For example, each user application can have a profile which outputs scanned data in the required format when that application comes to the foreground. DataWedge can be configured to process the same set of captured data differently based on the requirements of each application.

DataWedge includes the following pre-configured profiles which support specific built-in applications:

- **Visible profiles:**
  - **Profile0** - created automatically the first time DataWedge runs. Generic profile used when there are no user created profiles associated with an application.
  - **Launcher** - disables scanning when the Launcher is in foreground.
  - **DWDemo** - provides support for the DWDemo application.

Some Zebra applications are capable of capturing data by scanning. DataWedge is pre-loaded with private and hidden profiles for this purpose. There is no option to modify these private profiles.

**Profile0**

**Profile0** can be edited but cannot be associated with an application. That is, DataWedge allows manipulation of plug-in settings for **Profile0** but it does not allow assignment of a foreground application. This configuration allows DataWedge to send output data to any foreground application other than applications associated with user-defined profiles when **Profile0** is enabled.

**Profile0** can be disabled to allow DataWedge to only send output data to those applications which are associated in user-defined profiles. For example, create a profile associating a specific application, disable **Profile0** and then scan. DataWedge only sends data to the application specified in the user-created profile. This adds additional security to DataWedge enabling the sending of data only to specified applications.

**Plug-ins**

A plug-in is a software module utilized in DataWedge to extend its functionality to encompass technologies such as bar code scanning. The plug-ins can be categorized into three types based on their operations:

- **Input Plug-ins**
- **Output Plug-ins**
- **Process Plug-ins**

**Input Plug-ins**

An Input Plug-in supports an input device, such as a bar code scanner contained in, or attached to the device. DataWedge contains base plug-ins for these input devices.

- **Bar Code Scanner Input Plug-in** – The Bar Code Scanner Input Plug-in is responsible for reading data from the integrated bar code scanner and supports different types of bar code readers including laser, imager and internal camera. Raw data read from the bar code scanner can be processed or formatted using Process Plug-ins as required. DataWedge has built-in feedback functionality for the bar code scanner to issue user alerts. The feedback settings can be configured according to user requirement.

- **MSR Input Plug-in** – The Magnetic Stripe Reader (MSR) Input Plug-in is responsible for reading data from an MSR. Raw data read from the MSR can be processed or formatted using Process Plug-ins as required. DataWedge has built-in feedback functionality for the MSR to issue user alerts. The feedback settings can be configured according to user requirement.
Process Plug-ins

Process Plug-ins are used in DataWedge to manipulate the received data according to the requirement, before sending to the foreground application via the Output Plug-in.

- **Basic Data Formatting Process Plug-in** – The Basic Data Formatting Plug-in allows DataWedge to add a prefix and/or a suffix to the captured data before passing it to an Output Plug-in.
- **Advanced Data Formatting Process Plug-in** – The Advanced Data Formatting Plug-in allows DataWedge to apply rules (actions to be performed based on defined criteria) to the data received via an input plug-in before passing it to an Output Plug-in.

Output Plug-ins

Output Plug-ins are responsible for sending the data from Input Plug-ins to a foreground application on the device.

- **Keystroke Output Plug-in** – The Keystroke Output Plug-in collects and sends data received from the Input Plug-in to the foreground applications by emulating keystrokes.
- **Intent Output Plug-in** – The Intent Output Plug-in collects and sends data received from the Input Plug-ins to foreground applications using the Android Intent mechanism.
- **IP Output Plug-in** – The IP Output Plug-in collects and sends data received from the Input Plug-ins to a host computer via a network connection. Captured data can be sent over an IP network to a specified IP address and port using either TCP or UDP transport protocols.

Profiles Screen

To launch DataWedge, touch 🔄 > DataWedge. By default, three profiles appear:

- Profile0
- Launcher
- DWDemo.

Profile0 is the default profile and is used when no other profile can be applied.

![DataWedge Profiles Screen](image)

**Figure 10-1** DataWedge Profiles Screen

Profile names are color coded. Enabled profiles are white and disabled profiles are gray.

To configure a profile touch the profile name.
Profile Context Menu

Touch and hold a profile to open a context menu that allows additional actions to be performed on the selected profile.

The profile context menu allows the profile to be edited (same as just tapping on a profile), renamed or deleted.

Options Menu

Touch \( \text{\textcircled{3}} \) to open the options menu.

The menu provides options to create a new profiles, access to general DataWedge settings and DataWedge version information.

Disabling DataWedge

1. Touch \( \text{\textcircled{2}} \) > \( \text{\textcircled{3}} \) > \( \text{\textcircled{3}} \).
2. Touch Settings.
3. Touch DataWedge enabled.

The blue check disappears from the checkbox indicating that DataWedge is disabled.

Creating a New Profile

1. Touch \( \text{\textcircled{2}} \) > \( \text{\textcircled{3}} \) > \( \text{\textcircled{3}} \).
2. Touch New profile.
3. In the New profile dialog box, enter a name for the new profile. It is recommended that profile names be unique and made up of only alpha-numeric characters (A-Z, a-z, 0-9).
4. Touch OK. The new profile name appears in the DataWedge profile screen.

Profile Configuration

To configure the Profile0 or a user-created profile, touch the profile name.

The configuration screen lists the following sections:

- Profile enabled
- Applications
- Data Capture panel (DCP)
- Barcode Input
- Keystroke output
- Intent Output
- IP Output.

Associating Applications

Use Applications option to associate applications with this profile. User created profiles should be associated with one or more applications and its activities.

1. Touch Associated apps. A list of applications/activities associated with the profile displays. Initially the list does not contain any applications/activities.
2. Touch .

3. Touch New app/activity.

4. In the Select application screen, select the desired application from the list.

5. In the Select activity menu, selecting the activity adds that application/activity combination to the associated application list for that profile. Selecting * as the activity results in all activities within that application being associated to the profile. During operation, DataWedge tries to match the specific application/activity combinations with the foreground application/activity before trying to match the general application/* combinations.

6. Touch .
Data Capture Panel

The Data Capture panel (DCP) is a DataWedge feature that enables the user to initiate data capture by touching a designated part of the screen. A variable screen overlay acts like a scan button.

The DataWedge profile configuration screen allows the user to configure how the DCP appears on the screen once the particular profile is enabled. The DCP is hidden by default. Enabling DCP option displays seven additional configuration parameters.
Figure 10-11  Data Capture Panel Settings

- **Enable** - Select to enable Data Capture Plus (default - disabled).
- **Dock button on** - Select position of the button.
  - **Left or right** - Allows user to place the button on either the right or left edge of the screen.
  - **Left only** - Places the button on left edge of the screen.
  - **Right only** - Places the button on the right edge of the screen.
- **Start in** - Select the initial DCP state.
  - **Fullscreen mode** - DCP covers the whole screen.
  - **Button mode** - DCP displays as a circular button on the screen and can be switched to fullscreen mode.
  - **Button only mode** - DCP displays as a circular button on the screen and cannot be switched to fullscreen mode.
- **Button highest position** - Select the top of the range the user is allowed to move the DCP, given as a percent of the screen height (default - 0).
- **Button lowest position** - Select the bottom of the range the user is allowed to move the DCP, given as a percent of the screen height (default - 100).
- **Drag detect time** - Select the time in milliseconds that the scanner waits before activating scanner. This allows the user to drag the button without initiating scanner (default - 100 ms, maximum 1000 ms).

**NOTE**  The DCP does not appear if the scanner is disabled in the profile even though the **Enabled** option is set.

In Button mode, the user can place DCP in full screen mode by dragging the button over **Fullscreen mode**. The overlay covers the screen.
Figure 10-12  *Maximized DCP*

Swipe down to return to button mode.

**Bar Code Input**

Use the **Bar Code Input** options to configure the Bar Code Scanner Input Plug-in for the profile.

**Enabled**

Enables or disables this plug-in. A check in the checkbox indicates that the plug-in is enabled.

**Scanner Selection**

Configures which scanning device to use for bar code data capture when the profile is active.

- **Auto** - The software automatically selects the 2D Imager.
- **2D Imager** - Scanning is performed using the 2D Imager.
- **Bluetooth Scanner** - Scanning is performed using the option Bluetooth scanner.

**Decoders**

Configures which bar code decoders are enabled or disabled. For best performance disable all unnecessary decoders.

Touch **Decoders**. The **Barcode input** screen appears. A check in the checkbox indicates that the decoder is enabled. By default the most commonly used decoders are enabled (shown below with an asterisk). The supported decoders are:

✅ **NOTE** DataWedge supports the decoders listed below but not all are validated on this device.

Touch ✅ to return to the previous screen.

<table>
<thead>
<tr>
<th>UPC-A*</th>
<th>UPC-E0*</th>
<th>EAN-13*</th>
</tr>
</thead>
<tbody>
<tr>
<td>EAN-8*</td>
<td>Code 128*</td>
<td>Code 39*</td>
</tr>
<tr>
<td>Interleaved 2 of 5</td>
<td>GS1 DataBar*</td>
<td>GS1 DataBar Limited</td>
</tr>
</tbody>
</table>
Use **Decode Params** to configure individual decoder parameters.

**UPCA**
- **Report Check Digit** - The check digit is the last character of the symbol used to verify the integrity of the data. Enables or disables this option. A check in the checkbox indicates that the option is enabled (default - enabled).
- **Preamble** - Preamble characters are part of the UPC symbol consisting of Country Code and System Character. Select the appropriate option to match the host system.
  - **Preamble None** - Transmit no preamble.
  - **Preamble Sys Char** - Transmit System Character only (default).
  - **Preamble Country and Sys Char** - Transmit System Character and Country Code ("0" for USA). Select the appropriate option to match the host system.

**UPCE0**
- **Report Check Digit** - The check digit is the last character of the symbol used to verify the integrity of the data. Enables or disables this option. A check in the checkbox indicates that the option is enabled (default - disabled).
- **Preamble** - Preamble characters are part of the UPC symbol consisting of Country Code and System Character. Select the appropriate option to match the host system.
  - **Preamble Sys Char** - Transmit System Character only.
  - **Preamble Country and Sys Char** - Transmit System Character and Country Code ("0" for USA).
  - **Preamble None** - Transmit no preamble (default).
- **Convert UPCE0 To UPC-A** - Enable to convert UPCE0 (zero suppressed) decoded data to UPC-A format before transmission. After conversion, the data follows UPC-A format and is affected by UPC-A programming selections. Disable to transmit UPCE0 decoded data as UPCE0 data, without conversion (default - disabled).

---

<table>
<thead>
<tr>
<th>GS1 DataBar Expanded*</th>
<th>Datamatrix*</th>
<th>QR Code*</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF417*</td>
<td>Composite AB</td>
<td>Composite C</td>
</tr>
<tr>
<td>MicroQR</td>
<td>Aztec*</td>
<td>Maxicode*</td>
</tr>
<tr>
<td>MicroPDF</td>
<td>US Postnet</td>
<td>US Planet</td>
</tr>
<tr>
<td>UK Postal</td>
<td>Japanese Postal</td>
<td>Australian Postal</td>
</tr>
<tr>
<td>Canadian Postal</td>
<td>Dutch Postal</td>
<td>US4state</td>
</tr>
<tr>
<td>US4state FICS</td>
<td>Codabar*</td>
<td>MSI</td>
</tr>
<tr>
<td>Code 93</td>
<td>Trioptic 39</td>
<td>Discrete 2 of 5</td>
</tr>
<tr>
<td>Chinese 2 of 5</td>
<td>Korean 3 of 5</td>
<td>Code 11</td>
</tr>
<tr>
<td>TLC 39</td>
<td>MAIL MARK</td>
<td>HAN XIN</td>
</tr>
<tr>
<td>Matrix 2 of 5</td>
<td>UPC-E1</td>
<td></td>
</tr>
</tbody>
</table>
• Code128
  • **Length1** - Use to set decode lengths (default - 0). See *Decode Lengths on page 10-15* for more information.
  • **Length2** - Use to set decode lengths (default - 55). See *Decode Lengths on page 10-15* for more information.
  • **Redundancy** - Sets the reader to read the bar code twice before accepting data. A check in the checkbox indicates that redundancy is enabled (default - disabled).
  • **Enable Plain Code 128** - Flag to enable other 128 sub types (besides GS1-128 and ISBT-128).
  • **Enable GS1-128** - Set the GS1 128 subtype. A check in the checkbox indicates that the option is enabled (default - enabled).
  • **Enable ISBT128** - Set the ISBT128 subtype. A check in the checkbox indicates that the option is enabled (default - enabled).
  • **ISBT128 Concatenation Mode** - Select an option for concatenating pairs of ISBT code types:
    • **Concat Mode Never** - Do not concatenate pairs of ISBT codes encountered (default).
    • **Concat Mode Always** - There must be two ISBT codes in order to decode and perform concatenation. Does not decode single ISBT symbols.
    • **Concat Mode Auto** - Decodes and concatenates pairs of ISBT codes immediately. If only a single ISBT symbol is present, the device must decode the symbol the number of times set via DataWedge Configuration 4 - 11 Redundancy - Code128 before transmitting its data to confirm that there is no additional ISBT symbol.
  • **Check ISBT Table** - The ISBT specification includes a table that lists several types of ISBT bar codes that are commonly used in pairs. If ISBT128 Concat Mode is set, enable Check ISBT Table to concatenate only those pairs found in this table. Other types of ISBT codes are not concatenated. A check in the checkbox indicates that redundancy is enabled (default - disabled).
  • **Security Level** - The scanner offers four levels of decode security for Code 128 bar codes. Select increasing levels of security for decreasing levels of bar code quality. There is an inverse relationship between security and scanner aggressiveness, so choose only that level of security necessary for any given application.
    • **Security Level 0** - This setting allows the scanner to operate in its most aggressive state, while providing sufficient security in decoding most “in-spec” bar codes.
    • **Security Level 1** - This setting eliminates most misdecodes (default).
    • **Security Level 2** - Select this option if Security level 1 fails to eliminate misdecodes.
    • **Security Level 3** - If Security Level 2 is selected and misdecodes still occur, select this security level. Be advised, selecting this option is an extreme measure against mis-decoding severely out of spec bar codes. Selecting this level of security significantly impairs the decoding ability of the scanner. If this level of security is needed, try to improve the quality of the bar codes.
  • **Code128 Reduced Quiet Zone** - Enables decoding of margin-less Code 128 bar codes.
  • **Ignore Code128 FCN4** - When enabled, and a Code 128 bar code has an embedded FNC4 character, it will be removed from the data and the following characters will not be changed. When the feature is disabled, the FNC4 character will not be transmitted but the following character will have 128 added to it.
• Code39
  • **Length1** - Use to set decode lengths (default - 0). See *Decode Lengths on page 10-15* for more information.
  • **Length2** - Use to set decode lengths 4 (default - 55). See *Decode Lengths on page 10-15* for more information.
  • **Verify Check Digit** - Enable this feature to check the integrity of all Code 39 symbols to verify that the data complies with a specified check digit algorithm. The digital scanner decodes only those Code 39
symbols that include a modulo 43 check digit. Enable this feature only if the Code 39 symbols contain a modulo 43 check digit (default - disabled).


- **Full ASCII** - Code 39 Full ASCII is a variant of Code 39 that pairs characters to encode the full ASCII character set. To enable or disable Code 39 Full ASCII (default - disabled),

- **Redundancy** - Sets the reader to read the bar code twice before accepting data. A check in the checkbox indicates that redundancy is enabled (default - disabled).

- **Convert Code39 To Code32** - Code 32 is a variant of Code 39 used by the Italian pharmaceutical industry. Scan the appropriate bar code below to enable or disable converting Code 39 to Code 32 (default - disabled).

- **Report Code32 Prefix** - Scan the appropriate bar code to enable or disable adding the prefix character “A” to all Code 32 bar codes (default - disabled).

- **Security Level** - Options: Security level 0, Security Level 1, Security Level 2 and Security Level 3 (default - Security level 1).
  - **Security Level 0** - This setting allows the scanner to operate in its most aggressive state, while providing sufficient security in decoding most “in-spec” bar codes.
  - **Security Level 1** - This setting eliminates most misdecodes (default).
  - **Security Level 2** - Select this option if Security level 1 fails to eliminate misdecodes.
  - **Security Level 3** - If Security Level 2 is selected and misdecodes still occur, select this security level. Be advised, selecting this option is an extreme measure against mis-decoding severely out of spec bar codes. Selecting this level of security significantly impairs the decoding ability of the scanner. If this level of security is needed, try to improve the quality of the bar codes.

- **Code39 Reduced Quiet Zone** - Enables decoding of margin-less Code 39 bar codes.

- **Interleaved 2 of 5**
  - **Length1** - Use to set decode lengths (default - 14). See Decode Lengths on page 10-15 for more information.
  - **Length2** - Use to set decode lengths (default - 10). See Decode Lengths on page 10-15 for more information.

- **Redundancy** - Sets the reader to read the bar code twice before accepting data. A check in the checkbox indicates that redundancy is enabled (default - enabled).

- **Check Digit**
  - **No Check Digit** - A check digit is not used. (default)
  - **USS Check Digit** - Select to check the integrity of all Interleaved 2 of 5 symbols to verify the data complies with either the Uniform Symbology Specification (USS) check digit algorithm.
  - **OPCC Check Digit** - Select to check the integrity of all Interleaved 2 of 5 symbols to verify the data complies with either the Optical Product Code Council (OPCC) check digit algorithm.

- **Report Check Digit** - Transmit Interleaved 2 of 5 data with or without the check digit. A check in the checkbox indicates to send Interleaved 2 of 5 data with check digit (default - disabled).

- **Convert ITF-14 To EAN13** - Convert 14-character Interleaved 2 of 5 bar codes to EAN-13, and transmit as EAN-13. The Interleaved 2 of 5 bar code must be enabled and must have a leading zero and a valid EAN-13 check digit. A check in the checkbox indicates that the option is enabled (default - disabled).


- **I2of5 Reduced Quiet Zone** - Enables decoding of margin-less I2of5 bar codes.
• GS1 DataBar Limited
  • GS1 Limited Security Level -
    • Security Level 0 - This setting allows the scanner to operate in its most aggressive state, while providing sufficient security in decoding most “in-spec” bar codes.
    • Security Level 1 - This setting eliminates most misdecodes (default).
    • Security Level 2 - Select this option if Security level 1 fails to eliminate misdecodes.
    • Security Level 3 - If Security Level 2 is selected and misdecodes still occur, select this security level. Be advised, selecting this option is an extreme measure against mis-decoding severely out of spec bar codes. Selecting this level of security significantly impairs the decoding ability of the scanner. If this level of security is needed, try to improve the quality of the bar codes.
  • Composite AB
    • UCC Link Mode
      • Link Flag ignored - 1D component is transmitted regardless of whether a 2D component is detected.
      • Always Linked - 1D and the 2D components are transmitted. If 2D is not present, the 1D component is not transmitted.
      • Auto Discriminate - the digital scanner determines if there is a 2D portion, then transmits the 1D component, as well as the 2D portion if present. (default).
  • UK Postal
    • Report Check Digit - Transmit UK Postal data with or without the check digit. A check in the checkbox indicates to send UK Postal data with check digit (default - disabled).
  • Codabar
    • Length1 - Use to set decode lengths (default - 6). See Decode Lengths on page 10-15 for more information.
    • Length2 - Use to set decode lengths (default - 55). See Decode Lengths on page 10-15 for more information.
    • Redundancy - Sets the reader to read the bar code twice before accepting data. A check in the checkbox indicates that redundancy is enabled (default - enabled).
    • CLSI Editing - Enable this parameter to strip the start and stop characters and insert a space after the first, fifth, and tenth characters of a 14-character Codabar symbol. Enable this feature if the host system requires this data format (default - disabled).
    • NOTIS Editing - Enable this parameter to strip the start and stop characters from a decoded Codabar symbol. Enable this feature if the host system requires this data format (default - disabled).
  • MSI
    • Length 1 - Use to set decode lengths (default - 4). See Decode Lengths on page 10-15 for more information.
    • Length 2 - Use to set decode lengths (default - 55). See Decode Lengths on page 10-15 for more information.
    • Redundancy - Sets the reader to read the bar code twice before accepting data. A check in the checkbox indicates that redundancy is enabled (default - enabled).
    • Check Digit - With MSI symbols, one check digit is mandatory and always verified by the reader. The second check digit is optional.
      • One Check Digit - Verify one check digit (default).
      • Two Check Digits - Verify two check digits.
    • Check Digit Scheme - Two algorithms are possible for the verification of the second MSI check digit. Select the algorithm used to encode the check digit.
• **Mod-11-10** - First check digit is MOD 11 and second check digit is MOD 10 (default).
• **Mod-10-10** - Both check digits are MOD 10.

- **Report Check Digit** - Transmit MSI data with or without the check digit. A check in the checkbox indicates to send MSI data with check digit (default - disabled).

- **Code93**
  - **Length1** - Use to set decode lengths (default - 0). See *Decode Lengths on page 10-15* for more information.
  - **Length2** - Use to set decode lengths (default - 55). See *Decode Lengths on page 10-15* for more information.
  - **Redundancy** - Sets the reader to read the bar code twice before accepting data. A check in the checkbox indicates that redundancy is enabled (default - disabled).

- **Discrete 2 of 5**
  - **Length1** - Use to set decode lengths (default - 0). See *Decode Lengths on page 10-15* for more information.
  - **Length2** - Use to set decode lengths (default - 14). See *Decode Lengths on page 10-15* for more information.
  - **Redundancy** - Sets the reader to read the bar code twice before accepting data. A check in the checkbox indicates that redundancy is enabled (default - enabled).

- **Code 11**
  - **Length1** - Use to set decode lengths (default - 4). See *Decode Lengths on page 10-15* for more information.
  - **Length2** - Use to set decode lengths (default - 55). See *Decode Lengths on page 10-15* for more information.
  - **Redundancy** - Sets the reader to read the bar code twice before accepting data. A check in the checkbox indicates that redundancy is enabled (default - enabled).
  - **Verify Check Digit** - Check the integrity of all Code 11 symbols to verify that the data complies with the specified check digit algorithm. This selects the check digit mechanism for the decoded Code 11 bar code.
    - **No Check Digit** - Do not verify check digit.
    - **1 Check Digit** - Bar code contains one check digit (default).
    - **2 Check Digits** - Bar code contains two check digits.
  - **Report Check Digit** - Transmit Code 11 data with or without the check digit. A check in the checkbox indicates to send Code 11 data with check digit (default - disabled).

- **HAN XIN**
  - **HAN XIN Inverse**
    - **Disable** - Disables decoding of HAN XIN inverse bar codes (default).
    - **Enable** - Enables decoding of HAN XIN inverse bar codes.
    - **Auto** - Decodes both HAN XIN regular and inverse bar codes.
• Matrix 2 of 5
  • **Length1** - Use to set decode lengths (default - 10). See *Decode Lengths on page 10-15* for more information.
  • **Length2** - Use to set decode lengths (default - 0). See *Decode Lengths on page 10-15* for more information.
  • **Redundancy** - Sets the reader to read the bar code twice before accepting data. A check in the checkbox indicates that redundancy is enabled (default - disabled).
  • **Report Check Digit** - Transmit Matrix 2 of 5 data with or without the check digit. A check in the checkbox indicates to send Matrix 2 of 5 data with check digit (default - enabled).
  • **Verify Check Digit** - Enable this feature to check the integrity of all Matrix 2 of 5 symbols to verify that the data complies with a specified check digit algorithm (default - enabled).

**UPCE1**

  • **Report Check Digit** - The check digit is the last character of the symbol used to verify the integrity of the data. Enables or disables this option. A check in the checkbox indicates that the option is enabled (default - disabled).
  • **Preamble** - Preamble characters are part of the UPC symbol consisting of Country Code and System Character. Select the appropriate option to match the host system.
    There are three options for transmitting a UPCE1 preamble:
    • **Preamble Sys Char** - Transmit System Character only.
    • **Preamble Country and Sys Char** - Transmit System Character and Country Code ("0" for USA).
    • **Preamble None** - Transmit no preamble (default).
  • **Convert UPCE1 To UPCA** - Enable this to convert UPCE1 decoded data to UPC-A format before transmission. After conversion, the data follows UPC-A format and is affected by UPC-A programming selections. Disable this to transmit UPCE1 decoded data as UPCE1 data, without conversion (default - disabled).

**Decode Lengths**

  • The allowable decode lengths are specified by options **Length1** and **Length2** as follows:
  • Variable length: Decode symbols containing any number of characters.
    • Set both **Length1** and **Length2** to 0.
  • Range: Decode a symbol with a specific length range (from a to b, including a and b).
    • Set **Length1** to a and set **Length2** to b.
  • Two Discrete Lengths: Decode only symbols containing either of two selected lengths.
    • Set both **Length1** or **Length2** to the specific lengths. **Length1** must be greater than **Length2**.
  • One Discrete Length: Decode only symbols containing a specific length.
    • Set both **Length1** and **Length2** to the specific length.

**UPC EAN Params**

  Allows the configuration of the parameters that apply to more than one UPC or EAN decoder.
• **Security Level** - The scanner offers four levels of decode security for UPC/EAN bar codes. Select higher security levels for lower quality bar codes. There is an inverse relationship between security and decode speed, so be sure to choose only that level of security necessary for the application.

• **Level 0** - This default setting allows the scanner to operate fastest, while providing sufficient security in decoding “in-spec” UPC/EAN bar codes (default).

• **Level 1** - As bar code quality levels diminish, certain characters become prone to misdecodes before others (i.e., 1, 2, 7, 8). If the scanner is misdecoding poorly printed bar codes, and the misdecodes are limited to these characters, select this security level.

• **Level 2** - If the scanner is misdecoding poorly printed bar codes, and the misdecodes are not limited to characters 1, 2, 7, and 8, select this security level.

• **Level 3** - If the scanner is still misdecoding, select this security level. Be advised, selecting this option is an extreme measure against misdecoding severely out of spec bar codes. Selecting this level of security can significantly impair the decoding ability of the scanner. If this level of security is necessary, try to improve the quality of the bar codes.

• **Supplemental2** - Enables or disables this option. A check in the checkbox indicates that the option is enabled.

• **Supplemental5** - Enables or disables this option. A check in the checkbox indicates that the option is enabled.

• **Supplemental Mode**
  
  • **No Supplementals** - the scanner is presented with a UPC/EAN plus supplemental symbol, the scanner decodes UPC/EAN and ignores the supplemental characters (default).
  
  • **Supplemental Always** - the scanner only decodes UPC/EAN symbols with supplemental characters, and ignores symbols without supplementals.
  
  • **Supplements Auto** - the scanner decodes UPC/EAN symbols with supplemental characters immediately. If the symbol does not have a supplemental, the scanner must decode the bar code the number of times set via UPC/EAN Supplemental Redundancy before transmitting its data to confirm that there is no supplemental.
  
  • **Supplemental Smart** - Enables smart supplementals. In this mode the decoder returns the decoded value of the main block right away if it does not belong to one of the following supplemental types: 378, 379, 977, 978, 979, 414, 419, 434 or 439. If the bar code starts with one of the prefixes it searches the image more aggressively for a supplemental. Tries to scan the supplemental if it is present. If the supplemental scanning failed, then the main bar code is returned.
  
  • **Supplemental 378-379** - Enables (auto-discriminate) supplemental for UPC/EAN codes starting with 378 or 379. Disables reading of supplementals for any other UPC/EAN bar code not starting with 378 or 379. Tries to scan the supplemental if it is present. If the supplemental scanning failed, then the main bar code is returned.
  
  • **Supplemental 978-979** - Enables (auto-discriminate) supplemental for UPC/EAN codes starting with 978 or 979. Disables reading of supplementals for another UPC/EAN bar code not starting with 978 or 979. Tries to scan the supplemental if it is present. If the supplemental scanning failed, then the main bar code is returned.
  
  • **Supplemental 414-419-434-439** - Enables (auto-discriminate) supplemental for UPC/EAN codes starting with 414, 419, 434 or 439. Disables reading of supplementals for another UPC/EAN bar code 4 - 16 not starting with 414, 419, 434 or 439. Tries to scan the supplemental if it is present. If the supplemental scanning failed, then the main bar code is returned.
  
  • **Supplemental 977** - Enables (auto-discriminate) supplemental for UPC/EAN codes starting with 977. Disables reading of supplementals for another UPC/EAN bar code not starting with 977. Tries to scan the supplemental if it is present. If the supplemental scanning failed, then the main bar code is returned.

• **Retry Count** - Retry count for auto-discriminating for supplementals. Possible values are 2 to 20 inclusive. Note that this flag is only considered if Supplemental Mode - UPC EAN is set to one of the following values:
**Supplementals Auto, Supplementals Smart, Supplementals 378-379, Supplementals 978-979, Supplementals 977 or Supplementals 414-419-434-439** (2 to 20, default 10).

- **Bookland** - Enable Bookland decoding. A check in the checkbox indicates that the option is enabled.
- **Coupon** - Enables Coupon code decoding. Note that in order to successfully decode Coupon codes, all of the correct decoders must be enabled. A check in the checkbox indicates that the option is enabled.
- **Coupon Repost Mode** - Traditional coupon symbols are composed of two bar code: UPC/EAN and Code 128. A new coupon symbol is composed of a single Data Expanded bar code. The new format offers more options for purchase values (up to $999,999) and supports complex discount offers as a second purchase requirement. An interim coupon symbol also exists that contain both types of bar codes: UPC/EAN and Databar Expanded. This format accommodates both retailers that do not recognize or use the additional information included in the new coupon symbol, as well as those who can process new coupon symbols.
  - **Old Coupon Report Mode** - Scanning an old coupon symbol reports both UPC and Code 128, scanning is interim coupon symbol reports UPC, and scanning a new coupon symbol reports nothing (no decode).
  - **New Coupon Report Mode** - Scanning an old coupon symbol reports either UPC or Code 128, and scanning an interim coupon symbol or a new coupon symbol reports Databar Expanded.
  - **Both Coupon Report Modes** - Scanning an old coupon symbol reports both UPC and Code 128, and scanning an interim coupon symbol or a new coupon symbol reports Databar Expanded.

- **Ean Zero Extended** – Enable this parameter to add five leading zeros to decoded EAN-8 symbols to make them compatible in format to EAN-13 symbols. Disable this to transmit EAN-8 symbols as is. Default – disabled.
- **Bookland Format** - If Bookland EAN is enabled, select one of the following formats for Bookland data:
  - **Format ISBN-10** - The decoder reports Bookland data starting with 978 in traditional 10-digit format with the special Bookland check digit for backward-compatibility. Data starting with 979 is not considered Bookland in this mode. (default)
- **Convert DataBar To UPC EAN** - If this is set it converts DataBar bar codes to UPC/EAN format. For this setting to work UPC/EAN symbologies must be enabled. A check in the checkbox indicates that the option is enabled.
- **UPC Reduced Quiet Zone** - Enables decoding of margin-less UPC bar codes.

**Reader Params**

Allows the configuration of parameters specific to the selected bar code reader.

- **Beam Timer** - Sets the maximum amount of time that the reader remains on (0 - 60,000 ms in increments of 100 ms). A value of 0 sets the reader to stay on indefinitely (default -15000).
- **Image Capture Mode** -
  - **None**
  - **Single Capture on Decode**
  - **Image Capture only**
- **Linear Security Level** - Sets the number of times a bar code is read to confirm an accurate decode.
  - **Security Short or Codabar** - Two times read redundancy if short bar code or Codabar.
  - **Security All Twice** - Two times read redundancy for all bar codes (default).
  - **Security Long and Short** - Two times read redundancy for long bar codes, three times for short bar codes.
  - **Security All Thrice** - Three times read redundancy for all bar codes.
• **Picklist** - Allows the imager to decode only the bar code that is directly under the cross-hair/reticle (+) part of the pattern. This feature is useful in applications where multiple bar codes may appear in the field of view during a decode session and only one of them is targeted for decode.
  - **Disable** – Disables Picklist mode. Any bar code within the field of view can be decoded (default).
  - **Hardware Picklist** – Enables Picklist mode so that only the bar code under the projected reticle can be decoded.
  - **Software Picklist** - Enables Picklist mode so that only the bar code in the center of the image is decoded.

• **Aiming Pattern Options: On or Off.**

• **AIM Type**
  - **Trigger** - The device decodes a bar code on each Scan button press. (default).
  - **Timed Hold** - A trigger pull and hold activates the laser for aiming, which continues until the trigger is released, a valid decode, or the decode session time-out is expired.
  - **Timed Release** - A trigger pull activates the laser for aiming, which continues until a valid decode or the remaining decode session time has expired.
  - **Press and Release** - A trigger pull and release activates the laser for aiming, which continues until a trigger is pressed again, a valid decode, or the decode session time-out is expired.
  - **Continuous Read** - The device continuously decodes bar codes as long as the Scan button is held down and the previous bar code decoding is complete. This mode is useful when the user wants to perform rapid scanning.

• **Aim Timer** - Sets the maximum amount of time that aiming remains on (0 - 60,000 ms in increments of 100 ms). A value of 0 sets the aim to stay on indefinitely (default - 500).

• **Reflective Preference**
  - **Optimized paper** - (default).
  - **Optimized reflective** -

• **Same Symbol Timeout** - Use to prevent the device from decoding the same bar code within a specific time interval (applicable only when Aim Type is set to **Continuous Read**). The user can perform rapid scanning and prevents the user from decoding the same bar code twice. Set this value to an appropriate interval (in milliseconds). A value of 0 indicates no interval is required between two successive reads (default - 500).

• **Different Symbol Timeout** - Use to prevent the device from decoding another bar code within a specific interval (applicable only when aim type is set to **Continuous Read**). The user may want to prevent decoding too quickly and set an interval that the user can aim before scanning the next bar code. A value of 0 indicates no interval is required between two successive reads (default - 500).

• **Illumination mode** - Turns camera illumination on and off. This option is only available when camera is selected in the Barcode input Scanner selection option.
  - **On** - Illumination is on.
  - **Off** - Illumination is off (default).

• **LCD Mode** - Enables or disables LCD mode. LCD mode enhances the ability of the imager to read bar codes from LCD displays such as cellphones.
  - **Disable** - Disables the LCD mode (default).
  - **Enable** - Enables LCD mode.

• **Hardware Engine Low Power Timeout** -

• **Inverse 1D Mode** - This parameter allows the user to select decoding on inverse 1D bar codes.
  - **Disable** - Disables decoding of inverse 1D bar codes (default).
  - **Enable** - Enables decoding of only inverse 1D bar codes.
  - **Auto** - Allows decoding of both twice positive and inverse 1D bar codes.
• **1D Quiet Zone Level** - Sets the effort the decoder performs to decode margin-less bar codes. Applies to any symbology with margin-less bar code decode enabled parameter. Since higher margin-less levels will increase the mis-decode risk and decoding time, we strongly recommend the user only enable the symbologies which needs to choose higher margin-less level, and leave all other symbologies at low default level 1.

• **Poor Quality Decode Effort** - Enable poor quality bar code decoding enhancement feature.

• **Character Set Selection**
  - **ISO-8859-1** - part of the ISO/IEC 8859 series of ASCII-based standard character encodings. It is generally intended for Western European languages.
  - **Shift_JIS** - Shift Japanese Industrial Standards (JIS) is a character encoding for the Japanese language.
  - **UTF-8** - A character encoding capable of encoding all possible characters, or code points, defined by Unicode (default).

**Scan Params**

Allows the configuration of Code ID and decode feedback options.

• **Code ID Type** - A Code ID character identifies the code type of a scanned bar code. This is useful when the reader is decoding more than one code type. Select a code ID character to insert between the prefix and the decoded symbol.
  - **Code ID Type None** - No prefix (default).
  - **Code ID Type Aim** - A standards based three character prefix.
  - **Code ID Type Symbol** - A Symbol defined single character prefix.

**NOTE** Not all ringtones are fully supported as decode tones and those of longer length may be truncated when used as a decode tone. The recommendation is to test the selected tone for operation before deployment to a customer site.

• **Volume Type** - Set the good decode beep to a system or other sound. This allows for independent control of the good beep volume.
  - **Ringer and Notifications** - Set the good decode beep to the ringer and notifications sound. (default)
  - **Music and media** - Set the good decode beep to the music and media sound
  - **Alarms** - Set the good decode beep to the alarm sound

• **Decode Audio Feedback** - Select an audio tone to sound upon a good decode.

• **Decode Haptic Feedback** - Enable the device to vibrate upon a good decode (default - enabled).

• **Decode Feedback LED Timer** - Set the amount of time (in milliseconds) that the green Data Capture LED stays lit after a good decode. (default - 75 msec.)

• **Decoding LED Notification** - Enable the device to light the red Data Capture LED when data capture is in progress. (default - disabled).

**MSR Input**

Use MSR Input options to configure the MSR Input Plug-in for the profile.

• **Enabled** — Enables or disables this plug-in. A check in the checkbox indicates that the plug-in is enabled.

**Keystroke Output**

Use to configure the Keystroke Output Plug-in for the profile.
- **Enabled** — Enables or disables this plug-in. A check in the checkbox indicates that the plug-in is enabled (default - enabled).
- **Action key character** - Enables decoding of a special character embedded within a bar code data for use in native Android applications. This feature is helpful when populating or executing a form.
  - **None** - Action key character feature is disabled (default).
  - **Tab** - Tab character code in a bar code is processed. When DataWedge detects this character code in a bar code, move the focus to the next field.
  - **Line feed** - Line feed character code in a bar code is processed. When DataWedge detects this character code in a bar code, move the focus to the next field.
  - **Carriage return** - Carriage return character code in a bar code is processed. When DataWedge detects this character code in a bar code, move the focus to the next field.
- **Advanced data formatting** - is a way to customizing data before transmission. Use advanced data formatting (ADF) to edit scan data to suit requirements.
  - **Enable** - Enables or disables ADF. A check in the checkbox indicates that ADF is enabled (default - disabled).
  - **Rules** - ADF uses rules to customize data. These rules perform detailed actions when the data meets certain criteria. One rule may consist of single or multiple criteria applied to single or multiple actions. See [*Generating Advanced Data Formatting Rules on page 10-25*](#) for more information.
- **Basic data formatting** - Allows the configuration of any data formatting for the related Output Plug-in. When the plug-in is disabled, any data is passed on without modification.
  - **Enabled** - Enables or disables Basic Data Formatting. A check in the checkbox indicates that it is enabled (default - enabled).
  - **Prefix to data** - Add characters to the beginning of the data when sent.
  - **Suffix to data** - Add characters to the end of the data when sent.
  - **Send data** - Set to transfer the captured data to the foreground application. Disabling this option prevents the actual data from being transmitted. However, the prefix and suffix strings, if present, are still transmitted even when this option is disabled (default - enabled).
  - **Send as hex** - Set to send the data in hexadecimal format. A check in the checkbox indicates that the plug-in is enabled (default - disabled).
  - **Send TAB key** - Set to append a tab character to the end of the processed data. A check in the checkbox indicates that the plug-in is enabled (default - disabled).
  - **Send ENTER key** - Set to append an Enter character to the end of the processed data. A check in the checkbox indicates that the plug-in is enabled (default - disabled).

**Intent Output**

Allows configuration of the Intent Output Plug-in for the profile. The Intent Output Plug-in allows the captured data to be sent to an application in the form of an implicit Intent. Refer to the Android Developer web site for more information, [http://developer.android.com](http://developer.android.com).

- **Enabled** - Enables or disables this plug-in. A check in the checkbox indicates that the plug-in is enabled (default - disabled).
- **Intent action** - Enter the Intent Action name (required).
- **Intent category** - Enter the Intent Category name (required).
- **Intent delivery** - Select the method by which the intent is delivered:
  - Send via StartActivity
  - Send via startService (default)
  - Broadcast intent

- **Advanced data formatting** - is a way to customizing data before transmission. Use advanced data formatting (ADF) to edit scan data to suit requirements.
  - **Enable** - Enables or disables ADF. A check in the checkbox indicates that ADF is enabled (default - disabled).
  - **Rules** - ADF uses rules to customize data. These rules perform detailed actions when the data meets certain criteria. One rule may consist of single or multiple criteria applied to single or multiple actions. See [Generating Advanced Data Formatting Rules on page 10-25](#) for more information.

- **Basic data formatting** - Allows configuration of any data formatting for the related Output Plug-in. When the plug-in is disabled any data is passed on without modification.
  - **Enabled** - Enables or disables Basic Data Formatting. A check in the checkbox indicates that it is enabled (default - enabled).
  - **Prefix to data** - Add characters to the beginning of the data when sent.
  - **Suffix to data** - Add characters to the end of the data when sent.
  - **Send data** - Set to transfer the captured data to the foreground application. Disabling this option prevents the actual data from being transmitted. However, the prefix and suffix strings, if present, are still transmitted even when this option is disabled (default - enabled).
  - **Send as hex** - Set to send the data in hexadecimal format. A check in the checkbox indicates that the plug-in is enabled (default - disabled).
  - **Send TAB key** - Set to append a tab character to the end of the processed data. A check in the checkbox indicates that the plug-in is enabled (default - disabled).
  - **Send ENTER key** - Set to append an Enter character to the end of the processed data. A check in the checkbox indicates that the plug-in is enabled (default - disabled).

### Intent Overview

The core components of an Android application (its activities, services, and broadcast receivers) are activated by intents. An intent is a bundle of information (an Intent object) describing a desired action - including the data to be acted upon, the category of component that should perform the action, and other pertinent instructions. Android locates an appropriate component to respond to the intent, launches a new instance of the component if one is needed, and passes it the Intent object.

Components advertise their capabilities, the kinds of intents they can respond to, through intent filters. Since the system must learn which intents a component can handle before it launches the component, intent filters are specified in the manifest as `<intent-filter>` elements. A component may have any number of filters, each one describing a different capability. For example, if the manifest contains the following:

```
<intent-filter . . . >
  <action android:name="android.intent.action.DEFAULT" />
  <category android:name="android.intent.category.MAIN" />
</intent-filter>
```
In the Intent output plug-in configuration, the **Intent action** would be:

`android.intent.category.DEFAULT`

and the Intent category would be:

`android.intent.category.MAIN`.

The **Intent delivery** option allows the method by which the intent is delivered to be specified. The delivery mechanisms are **Send via startActivity**, **Send via startService** or **Broadcast intent**.

The decode related data added to the Intent’s bundle can be retrieved using the `Intent.getStringExtra()` and `Intent.getSerializableExtra()` calls, using the following String tags:

- String `LABEL_TYPE_TAG = “com.symbol.emdk.datawedge.label_type”;` - String contains the label type of the bar code.
- String `DATA_STRING_TAG = “com.symbol.emdk.datawedge.data_string”;` - String contains the output data as a String. In the case of concatenated bar codes, the decode data is concatenated and sent out as a single string.
- String `DECODE_DATA_TAG = “com.symbol.emdk.datawedge.decode_data”;` - Decode data is returned as a list of byte arrays. In most cases there will be one byte array per decode. For bar code symbologies that support concatenation e.g. Codabar, Code128, MicroPDF, etc., the decoded data is stored in multiple byte arrays (one byte array per bar code). Clients can get data in each byte array by passing an index.

Most scanning applications might want the user to be able to decode data and for that decode data to be sent to the *current* activity but not necessarily displayed. If this is the case, then the activity needs to be marked as 'singleTop' in its AndroidManifest.xml file. If your activity is not defined as singleTop, then on every decode, the system will create another copy of your Activity and send the decode data to this second copy.

Finally there will be a configuration option for each process plug-in so that the process plug-in can be configured specifically for the intent output, which in this case is the basic data formatting process plug-in.

**IP Output**

**NOTE** IPWedge application is required on a host computer. Download the IPWedge application from the Support Central web site: http://www.zebra.com/support.

IP Output allows DataWedge to send captured data to a host computer via a network connection. Captured data can be sent over an IP network to a specified IP address and port using either TCP or UDP transport protocols.

- **Enabled** - Enables or disables this plug-in. A check in the checkbox indicates that the plug-in is enabled (default - disabled).
- **Remote Wedge** - Enable or disable the Remote Wedge option (default - enabled). Remote Wedge is used with the IPWedge application.
- **Protocol** - Select the protocol used by the remote application. Options: TCP (default) or UDP.
- **IP address** - Enter the IP address used by the remote application (default - 0.0.0.0).
- **Port** - Enter the port number used by the remote application (default - 58627).
• **Advanced data formatting** - is a way of customizing data before transmission. Use advanced data formatting (ADF) to edit scan data to suit requirements.
  
  • **Enable** - Enables or disables ADF. A check in the checkbox indicates that ADF is enabled (default - disabled).
  
  • **Rules** - ADF uses rules to customize data. These rules perform detailed actions when the data meets certain criteria. One rule may consist of single or multiple criteria applied to single or multiple actions. See *Generating Advanced Data Formatting Rules on page 10-25* for more information.
  
  • **Basic data formatting** - Allows configuration of any data formatting for the related Output Plug-in. When the plug-in is disabled any data is passed on without modification.
    
    • **Enabled** - Enables or disables Basic Data Formatting. A check in the checkbox indicates that it is enabled (default - enabled).
    
    • **Prefix to data** - Add characters to the beginning of the data when sent.
    
    • **Suffix to data** - Add characters to the end of the data when sent.
    
    • **Send data** - Set to transfer the captured data to the foreground application. Disabling this option prevents the actual data from being transmitted. However, the prefix and suffix strings, if present, are still transmitted even when this option is disabled (default - enabled).
    
    • **Send as hex** - Set to send the data in hexadecimal format. A check in the checkbox indicates that the plug-in is enabled (default - disabled).
    
    • **Send TAB key** - Set to append a tab character to the end of the processed data. A check in the checkbox indicates that the plug-in is enabled (default - disabled).
    
    • **Send ENTER key** - Set to append an Enter character to the end of the processed data. A check in the checkbox indicates that the plug-in is enabled (default - disabled).

**Usage**

This section provides information on how to configure IP Output using the DataWedge configuration user interface. To use IP Output in a particular DataWedge profile (for example: Profile0), scroll downward on IP Output.

![Figure 10-13  IP Output Screen](image)

**Using IP Output with IPWedge**

IPWedge is a computer application that can be easily configured to retrieve data sent over network by DataWedge IP Output. Refer to the *IPWedge User Manual* on how to install and configure in a host computer. To enable IP Output to send captured data to a remote computer that is installed with IPWedge:

1. In **IP Output**, touch **Enabled**.
2. Ensure **Remote Wedge** option is enabled.

3. Touch **Protocol**.

4. In the **Choose protocol** dialog box, touch the same protocol selected for the IPWedge computer application. (TCP is the default).

   ![Choose protocol](Figure 10-14 Protocol Selection)

5. Touch **IP Address**.

6. In the **Enter IP Address** dialog box, enter the IP address of host computer to send data to.

   ![Enter IP address](Figure 10-15 IP Address Entry)

7. Touch **Port**.

8. In the **Enter port number** dialog box, enter same port number selected for IPWedge computer application.

   ![Enter port number](Figure 10-16 Port Number Entry)

9. Configure **Advanced data formatting** and **Basic data formatting** Plug-in if any required modification to be done to captured data before sending to remote computer.

**Using IP Output without IPWedge**

IP Output Plug-in can be used to send captured data from DataWedge to a remote device or host computer without using IPWedge. At the data receiving end, the host computer or mobile device should have an application, that listens to TCP or UDP data coming from a configured port and IP address in the IP Output plug-in. To enable IP Output to send captured data to a remote computer:

1. In **IP Output**, touch **Enabled**.

2. A check appears in the checkbox.

3. Ensure **Remote Wedge** option is disabled.

4. Touch **Protocol**.

5. In the **Choose protocol** dialog box, touch the same protocol selected in the client application. (TCP is the default).
6. Touch **IP Address**.
7. In the **Enter IP address** dialog box, enter the IP address of host computer to send data to.

8. Touch **Port**.
9. In the **Enter port number** dialog box, enter the port number that the host computer application is listening on.

10. Configure **Advanced Data Formatting** and **Basic Data Formatting** Plug-in if any required modification to be done to captured data before sending to remote computer.

---

**Generating Advanced Data Formatting Rules**

The ADF plug-in applies rules (actions to be performed based on defined criteria) to the data received via an input plug-in before sending it to the output plug-in.

- **Rules** - The ADF process plug-in consists of one or more rules. DataWedge formats the output data according to the first matching rule. A rule is a combination of criteria and a set of actions to be performed, upon fulfillment of the criteria set in the rule.
- **Criteria** - Criteria can be set according to Input plug-in, symbology, matching string within the data (at the specified position) and/or data length. Received data must match the defined criteria in order for the data to be processed.
- **Actions** - A set of procedures defined to format data. There are four types of actions which are for formatting cursor movement, data modification, data sending and delay specifications. An action can be defined to send the first number of characters to the Output plug-in, pad the output data with spaces or zeros, remove spaces in data, etc.
Configuring ADF Plug-in

Configuring the ADF plug-in consists of creating a rule, defining the criteria and defining the actions.

1. Touch >.
2. Touch a DataWedge profile.
3. In Keystroke Output, touch Advanced data formatting.
4. Touch the Enable checkbox to enable ADF.

Creating a Rule

**NOTE** By default, Rule0, is the only rule in the Rules list.

1. Touch .
2. Touch New rule.
3. Touch the Enter rule name text box.
4. In the text box, enter a name for the new rule.
5. Touch Done.
6. Touch OK.

Deleting a Rule

1. Touch and hold on a rule until the context menu appears.
2. Touch Delete to delete the rule from the Rules list.

**NOTE** When there is no rule available for ADF plug-in or all rules are disabled, DataWedge passes decoded data to the output plug-in without processing the data.

Defining Criteria

1. Touch Criteria.
2. Touch **String to check for** option to specify the string that must be present in the data.

3. In the **Enter the string to check for** dialog box, enter the string.

4. Touch **OK**.

5. Touch **String position** option to specify the position of the string specified in the **String to check for** option. The ADF rule is only applied if the specific string in **String to check for** is found at the specified **String position** location (zero for the start of the string).

6. Touch the + or - to change the value.

7. Touch **OK**.

8. Touch **String length option** to specify a length for the received data. The ADF rule only applies to the bar code data with that specified length.

9. Touch the + or - to change the value.

10. Touch **OK**.

11. Touch **Source criteria** option to associate an input device to an ADF rule. The ADF rule only applies to data received from associated input devices.

12. Touch **Barcode input**.

13. Touch the **Source enabled** checkbox to accept data from this source.

14. For **Barcode inputs**, touch the **All decoders enabled** checkbox to select all bar code symbologies. Deselect the **All decoders enabled** checkbox to individually select the symbologies.
15. Touch \( \text{Rule} \) until the Rule screen appears.

16. If required, repeat steps to create another rule.

17. Touch \( \text{Rule} \) until the Rule screen appears.

### Defining an Action

**NOTE** By default the Send remaining action is in the Actions list.

1. Touch \( \text{Rule} \).
2. Touch New action.
3. In the New action menu, select an action to add to the Actions list. See Table 10-1 on page 10-29 for a list of supported ADF actions.
4. Some Actions require additional information. Touch the Action to display additional information fields.
5. Repeat steps to create more actions.

6. Touch \( \text{Rule} \).
7. Touch \( \text{Rule} \).

### Deleting a Rule

1. Touch and hold on a rule until the context menu appears.
2. Touch Delete to delete the rule from the Rules list.

**NOTE** When there is no rule available for ADF plug-in or all rules are disabled, DataWedge passes decoded data to the output plug-in without processing the data.

### Order Rules List

**NOTE** When there are no rules defined, ADF passes the captured data through as is. In contrast, when rules are defined but all are disabled, ADF does not pass any captured data through.

Rules are processed in top-down order. The rules that are on top of the list are processed first. Use the icon next to the rule to move it to another position in the list.
<table>
<thead>
<tr>
<th>Type</th>
<th>Actions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cursor Movement</td>
<td>Skip ahead</td>
<td>Moves the cursor forward by a specified number of characters. Enter the number of characters to move the cursor ahead.</td>
</tr>
<tr>
<td></td>
<td>Skip back</td>
<td>Moves the cursor back by a specified number of characters. Enter the number of characters to move the cursor back.</td>
</tr>
<tr>
<td></td>
<td>Skip to start</td>
<td>Moves the cursor to the beginning of the data.</td>
</tr>
<tr>
<td></td>
<td>Move to</td>
<td>Moves the cursor forward until the specified string is found. Enter the string in the data field.</td>
</tr>
<tr>
<td></td>
<td>Move past a</td>
<td>Moves the cursor forward past the specified string. Enter the string in the data field.</td>
</tr>
<tr>
<td>Data Modification</td>
<td>Crunch spaces</td>
<td>Remove spaces between words to one and remove all spaces at the beginning and end of the data.</td>
</tr>
<tr>
<td></td>
<td>Stop space crunch</td>
<td>Stops space crunching. This disables the last Crunch spaces action.</td>
</tr>
<tr>
<td></td>
<td>Remove all spaces</td>
<td>Remove all spaces in the data.</td>
</tr>
<tr>
<td></td>
<td>Stop space removal</td>
<td>Stop removing spaces. This disables the last Remove all spaces action.</td>
</tr>
<tr>
<td></td>
<td>Remove leading zeros</td>
<td>Remove all zeros at the beginning of data.</td>
</tr>
<tr>
<td></td>
<td>Stop zero removal</td>
<td>Stop removing zeros at the beginning of data. This disables the previous Remove leading zeros action.</td>
</tr>
<tr>
<td></td>
<td>Pad with zeros</td>
<td>Left pad data with zeros to meet the specified length. Enter the number zeros to pad.</td>
</tr>
<tr>
<td></td>
<td>Stop pad zeros</td>
<td>Stop padding with zeros. This disables the previous Pad with zeros action.</td>
</tr>
<tr>
<td></td>
<td>Pad with spaces</td>
<td>Left pad data with spaces to meet the specified length. Enter the number spaces to pad.</td>
</tr>
<tr>
<td></td>
<td>Stop pad spaces</td>
<td>Stop padding with spaces. This disables the previous Pad with spaces action.</td>
</tr>
<tr>
<td></td>
<td>Replace string</td>
<td>Replaces a specified string with a new string. Enter the string to replace and the string to replace it with.</td>
</tr>
<tr>
<td></td>
<td>Stop all replace string</td>
<td>Stop all Replace string actions.</td>
</tr>
</tbody>
</table>
Deleting an Action

1. Touch and hold the action name.
2. Select Delete action from the context menu.

ADF Example

The following illustrates an example of creating Advanced Data Formatting:

When a user scans a bar code with the following criteria:

- Code 39 bar code.
- length of 12 characters.
- contains 129 at the start position.

Modify the data as follows:

- Pad all sends with zeros to length 8.
- send all data up to character X.
- send a space character.

To create an ADF rule for the above example:

1. Touch 
2. Touch DataWedge.
3. Touch Profile0.
5. Touch Enable.
6. Touch Rule0.
7. Touch Criteria.
8. Touch String to check for.
9. In the Enter the string to check for text box, enter 129 and then touch OK.
10. Touch **String position**.
11. Change the value to **0**.
12. Touch **OK**.
13. Touch **String length**.
14. Change value to **12**.
15. Touch **OK**.
16. Touch **Source criteria**.
17. Touch **Barcode input**.
18. Touch **All decoders enabled** to disable all decoders.
19. Touch **Code 39**.
20. Touch three times.
21. Touch and hold on the **Send remaining rule** until a menu appears.
22. Touch **Delete action**.
23. Touch .
24. Touch **New action**.
25. Select **Pad with zeros**.
26. Touch the **Pad with zeros** rule.
27. Touch **How many**.
28. Change value to **8** and then touch **OK**.
29. Touch three times.
30. Touch .
31. Touch **New action**.
32. Select **Send up to**.
33. Touch **Send up to** rule.
34. Touch **String**.
35. In the **Enter a string** text box, enter **X**.
36. Touch **OK**.
37. Touch three times.
38. Touch .
39. Touch **New action**.
40. Select **Send char**.
41. Touch **Send char** rule.
42. Touch **Character code**.
43. In the **Enter character code** text box, enter **32**.
44. Touch **OK**.
45. Touch .
46. Ensure that an application is open on the device and a text field is in focus (text cursor in text field).

47. Aim the exit window at the bar code.

48. Press and hold the scan key.

   The red laser aiming pattern turns on to assist in aiming. Ensure that the bar code is within the area formed by
   the aiming pattern. The LED light red to indicate that data capture is in process.

49. The LED lights green, a beep sounds and the device vibrates, by default, to indicate the bar code was decoded
    successfully. The LED lights green and a beep sounds, by default, to indicate the bar code was decoded
    successfully. The formatted data 000129X<space>appears in the text field.

   Scanning a Code 39 bar code of 1299X15598 does not transmit data (rule is ignored) because the bar code
   data did not meet the length criteria.
DataWedge Settings

The DataWedge Settings screen provides access to general, non-profile related options. Touch ⏏ > Settings.

Figure 10-26   DataWedge Settings Window

- **DataWedge enabled** - Enables or disables DataWedge. To disable DataWedge uncheck this option.
- **Enable logging** - Enables or disables debug output file to logcat. To enable logging check this option.
- **Import** - allows import of a DataWedge configuration file. The imported configuration replaces the current configuration.
- **Export** - allows export of the current DataWedge configuration.
- **Import Profile** - allows import of a DataWedge profile file.
- **Export Profile** - allows export of a DataWedge profile.
- **Restore** - return the current configuration back to factory defaults.

Importing a Configuration File

1. Copy the configuration file to the On Device Storage /Android/data/com.symbol.datawedge folder.
2. Touch ⏏ > >.
3. Touch Settings.
4. Touch Import.
5. Touch filename to import.
6. Touch Import. The configuration file (datawedge.db) is imported and replaces the current configuration.

Exporting a Configuration File

1. Touch ⏏ > >.
2. Touch Settings.
3. Touch Export.
4. In the Export to dialog box, select the location to save the file.
5. Touch Export. The configuration file (datawedge.db) is saved to the selected location.
Importing a Profile File

**NOTE** Do not change the filename of the profile file. If the filename is changed, the file will not be imported.

1. Copy the profile file to the On Device Storage `/Android/data/com.symbol.datawedge` folder.
2. Touch > .
3. Touch .
4. Touch Settings.
5. Touch Import Profile.
6. Touch the profile file to import.
7. Touch Import. The profile file (`dwprofile_x.db`, where `x` = the name of the profile) is imported and appears in the profile list.

Exporting a Profile

1. Touch > > .
2. Touch Settings.
3. Touch Export Profile.
4. Touch the profile to export.
5. Touch Export.

The profile file (`dwprofile_x.db`, where `x` = name of the profile) is saved to the root of the MC92N0-G On-device Storage.

Restoring DataWedge

To restore DataWedge to the factory default configuration:

1. Touch > > .
2. Touch Settings.
3. Touch Restore.
4. Touch Yes.

Configuration and Profile File Management

The configuration or profile settings for DataWedge can be saved to a file for distribution to other devices.

After making configuration or profile changes, export the new configuration or profile to the root of the On-device Storage. The configuration file created is automatically named `datawedge.db`. The profile file created is automatically named `dwprofile_x.db`, where `x` is the profile name. The files can then be copied to the On—device Storage of other devices and imported into DataWedge on those devices. Importing a configuration or profile replaces the existing settings.

Enterprise Folder

Internal storage contains the Enterprise folder (`/enterprise`). The Enterprise folder is persistent and maintains data after an Enterprise reset. After an Enterprise Reset, DataWedge checks folder
/enterprise/device/settings/datawedge/enterprisereset/ for a configuration file, datawedge.db or a profile file, dwprofile_x.db. If the file is found, it imports the file to replace any existing configuration or profile.

![NOTE] A Factory Reset deletes all files in the Enterprise folder.

**Auto Import**

DataWedge supports remote deployment of a configuration to a device, using tools such as MSP. DataWedge monitors the /enterprise/device/settings/datawedge/autoimport folder for the DataWedge configuration file (datawedge.db) or a profile file (dwprofile_x.db). When DataWedge launches it checks the folder. If a configuration or profile file is found, it imports the file to replace any existing configuration or profile. Once the file has been imported it is deleted from the folder.

While DataWedge is running it receives a notification from the system that a file has been placed into the /enterprise/device/settings/datawedge/autoimport folder. When this occurs, DataWedge imports this new configuration or profile, replacing the existing one and delete the file. DataWedge begins using the imported configuration immediately.

![NOTE] A Factory Reset deletes all files in the Enterprise folder.

It is strongly recommended that the user exits DataWedge before remotely deploying any configuration or profile. It is required that the file permissions are set to 666.

---

**Programming Notes**

The following paragraphs provide specific programming information when using DataWedge.

**Overriding Trigger Key in an Application**

To override the trigger key in an application, create a profile for the application that disables the Barcode input. In the application, use standard APIs, such as onKeyDown() to listen for the KEYCODE_BUTTON_L1 and KEYCODE_BUTTON_R1 presses.

**Capture Data and Taking a Photo in the Same Application**

To be able to capture bar code data and take a photo in the same application:

- Create a Datawedge profile pertaining to the picture taking Activity in your application that disables scanning and use standard Android SDK APIs to control the Camera.
- The default Datawedge profile takes care of the scanning in the application. You might want to create another DataWedge profile that caters to any specific scanning needs, associated to your Application's Activity pertaining to scanning.

**Soft Scan Feature**

DataWedge allows a native Android application to programmatically start, stop, or toggle the scan trigger state. The application can issue an Android Broadcast Intent, to control the scanner, without requiring the scan key to be pressed. The active DataWedge profile is required to control all the parameters during a scan operation.
The structure of the broadcast intent that resolves to the soft scan is:

**action:** "com.symbol.emdk.datawedge.api.ACTION_SOFTSCANTRIGGER"

**extras:** This is a String name/value pair that contains trigger state details.

**name:** "com.symbol.emdk.datawedge.api.EXTRA_PARAMETER"

**value:** "START_SCANNING" or "STOP_SCANNING" or "TOGGLE_SCANNING"

Sample

```java
Intent sendIntent = new Intent();
sendIntent.setAction("com.symbol.emdk.datawedge.api.ACTION_SOFTSCANTRIGGER");
sendIntent.putExtra("com.symbol.emdk.datawedge.api.EXTRA_PARAMETER", "TOGGLE_SCANNING");
sendBroadcast(sendIntent);
```

**Scanner Input Plugin**

The ScannerInputPlugin API command can be used to enable/disable the scanner plug-in being used by the currently active Profile. Disabling the scanner plug-in effectively disables scanning in that Profile, regardless of whether the Profile is associated or unassociated. Valid only when Barcode Input is enabled in the active Profile.

![NOTE](image)

**NOTE** Use of this API changes only the runtime status of the scanner; it does not make persistent changes to the Profile.

**Function Prototype**

```java
Intent i = new Intent();
i.setAction(ACTION);
i.putExtra(EXTRA_DATA, "<parameter>");
```

**Parameters**

**action:** String "com.symbol.datawedge.api.ACTION_SCANNERINPUTPLUGIN"

**extra_data:** String "com.symbol.datawedge.api.EXTRA_PARAMETER"

**<parameter>:** The parameter as a string, using either of the following:

- "ENABLE_PLUGIN" - enables the plug-in
- "DISABLE_PLUGIN" - disables the plug-in

**Return Values**

None.

Error and debug messages will be logged to the Android logging system which then can be viewed and filtered by the logcat command. You can use logcat from an ADB shell to view the log messages, e.g.
Error messages will be logged for invalid actions and parameters.

Example

```java
// define action and data strings
String scannerInputPlugin = "com.symbol.datawedge.api.ACTION_SCANNERINPUTPLUGIN";
String extraData = "com.symbol.datawedge.api.EXTRA_PARAMETER";

public void onResume() {
    // create the intent
    Intent i = new Intent();
    // set the action to perform
    i.setAction(scannerInputPlugin);
    // add additional info
    i.putExtra(extraData, "DISABLE_PLUGIN");
    // send the intent to DataWedge
    context.this.sendBroadcast(i);
}
```

Comments

This Data Capture API intent allows the scanner plug-in for the current Profile to be enabled or disabled. For example, activity A launches and uses the Data Capture API intent to switch to ProfileA in which the scanner plug-in is enabled, then at some point it uses the Data Capture API to disable the scanner plug-in. Activity B is launched. In DataWedge, ProfileB is associated with activity B. DataWedge switches to ProfileB. When activity A comes back to the foreground, in the `onResume` method, activity A needs to use the Data Capture API intent to switch back to ProfileA, then use the Data Capture API intent again to disable the scanner plug-in, to return back to the state it was in.

**NOTE** Use of this API changes only the runtime status of the scanner; it does not make persistent changes to the Profile.

The above assumes that ProfileA is not associated with any applications/activities, therefore when focus switches back to activity A, DataWedge will not automatically switch to ProfileA therefore activity A must switch back to ProfileA in its `onResume` method. Because DataWedge will automatically switch Profile when an activity is paused, it is recommended that this API function be called from the `onResume` method of the activity.

Enumerate Scanners

Use the `enumerateScanners` API command to get a list of scanners available on the device.
Function Prototype

```java
Intent i = new Intent();
i.setAction(ACTION);
```

Parameters

**action**: String "com.symbol.datawedge.api.ACTION_ENUMERATESCANNERS"

Return Values

The enumerated list of scanners will be returned via a broadcast Intent. The broadcast Intent action is "com.symbol.datawedge.api.ACTION_ENUMERATEDSCANNERLIST" and the list of scanners is returned as a string array (see the example below).

Error and debug messages will be logged to the Android logging system which then can be viewed and filtered by the logcat command. You can use logcat from an ADB shell to view the log messages, e.g.

```bash
$ adb logcat -s DWAPI
```

Error messages will be logged for invalid actions and parameters
Example

```java
// first send the intent to enumerate the available scanners on the device
// define action string
String enumerateScanners = "com.symbol.datawedge.api.ACTION_ENUMERATESCANNERS";
// create the intent
Intent i = new Intent();
// set the action to perform
i.setAction(enumerateScanners);
// send the intent to DataWedge
context.this.sendBroadcast(i);

// now we need to be able to receive the enumerate list of available scanners
String enumeratedList = "com.symbol.datawedge.api.ACTION_ENUMERATEDSCANNERLIST";
String KEY_ENUMERATEDSCANNERLIST = "DataWedgeAPI_KEY_ENUMERATEDSCANNERLIST";
// Create a filter for the broadcast intent
IntentFilter filter = new IntentFilter();
filter.addAction(enumeratedList);
registerReceiver(myBroadcastReceiver, filter);

// now we need a broadcast receiver
private BroadcastReceiver myBroadcastReceiver = new BroadcastReceiver() {
    @Override
    public void onReceive(Context context, Intent intent) {
        String action = intent.getAction();
        if (action.equals(enumeratedList)) {
            Bundle b = intent.getExtras();
            String[] scanner_list = b.getStringArray(KEY_ENUMERATEDSCANNERLIST);
        }
    }
};
```

Comments

The scanner and its parameters are set based on the currently active Profile.

Set Default Profile

Use the setDefaultProfile API function to set the specified Profile as the default Profile.

Default Profile Recap

Profile0 is the generic Profile used when there are no user created Profiles associated with an application.
Profile0 can be edited but cannot be associated with an application. That is, DataWedge allows manipulation of plug-in settings for Profile0 but it does not allow assignment of a foreground application. This configuration allows DataWedge to send output data to any foreground application other than applications associated with user-defined Profiles when Profile0 is enabled.

Profile0 can be disabled to allow DataWedge to only send output data to those applications which are associated in user-defined Profiles. For example, create a Profile associating a specific application, disable Profile0 and then scan. DataWedge only sends data to the application specified in the user-created Profile. This adds additional security to DataWedge enabling the sending of data only to specified applications.

Usage Scenario

A launcher application has a list of apps that a user can launch and that none of the listed apps has an associated DataWedge Profile. Once the user has selected an app, the launcher needs to set the appropriate DataWedge Profile for the selected app. This could be done by using setDefaultProfile to set the default Profile to the required Profile. Then when the user launches the selected app, DataWedge auto Profile switching switches to the default Profile (which is now the required Profile for that app).

If, for some reason, the launched app has an associated DataWedge Profile then that will override the set default Profile.

When control is returned to the launcher application, resetDefaultProfile can be used to reset the default Profile.

Function Prototype

```java
Intent i = new Intent();
i.setAction(ACTION);
i.putExtra(EXTRA_DATA, "<profile name>");
```

Parameters

- **action**: String "com.symbol.datawedge.api.ACTION_SETDEFAULTPROFILE"
- **extra_data**: String "com.symbol.datawedge.api.EXTRA_PROFILENAME"
- **<profile name>**: The Profile name to set as the default Profile as a string (case-sensitive).

Return Values

None.

Error and debug messages will be logged to the Android logging system which then can be viewed and filtered by the logcat command. You can use logcat from an ADB shell to view the log messages, e.g.

```
$ adb logcat -s DWAPI
```

Error messages will be logged for invalid actions, parameters and failures (e.g. Profile not found or associated with an application).
Example

```java
// define action and data strings
String setDefaultProfile = "com.symbol.datawedge.api.ACTION_SETDEFAULTPROFILE";
String extraData = "com.symbol.datawedge.api.EXTRA_PROFILENAME";

public void onResume() {
    // create the intent
    Intent i = new Intent();
    // set the action to perform
    i.setAction(setDefaultProfile);
    // add additional info
    i.putExtra(extraData, "myProfile");
    // send the intent to DataWedge
    context.this.sendBroadcast(i);
}
```

Comments

The API command will have no effect if the specified Profile does not exist or if the specified Profile is already associated with an application. DataWedge will automatically switch Profiles when the activity is paused, so it is recommended that this API function be called from the onResume method of the activity.

Zebra recommends that this Profile be created to cater to all applications/activities that would otherwise default to using Profile0. This will ensure that these applications/activities continue to work with a consistent configuration. For example, let’s say that initially Profile0 is the default Profile using the camera as the barcode scanner. Using the Browser application and scanning a barcode with the camera, DataWedge enters the data into the Browser. Now launch an application that changes the default Profile to a Profile using the blockbuster as the barcode scanner. When returning to the Browser application, since it is using the default Profile, scanning will now be via the blockbuster not the camera as previously. To ensure that the Browser continues to use the camera as the barcode scanner a Profile should be created and associated with the Browser that specifies the camera as the barcode scanner.
Reset Default Profile

Use the resetDefaultProfile API function to reset the default Profile back to Profile0.

Function Prototype

```java
Intent i = new Intent();

i.setAction(ACTION);
i.putExtra(EXTRA_DATA, "<Profile name>");
```

Parameters

- **action**: String "com.symbol.datawedge.api.ACTION_RESETDEFAULTPROFILE"
- **extra_data**: String "com.symbol.datawedge.api.EXTRA_PROFILENAME"
- **<Profile name>**: The Profile name to set as the default Profile as a string (case-sensitive).

Return Values

None.

Error and debug messages will be logged to the Android logging system which then can be viewed and filtered by the logcat command. You can use logcat from an ADB shell to view the log messages, e.g.

```
$ adb logcat -s DWAPI
```

Error messages will be logged for invalid actions, parameters and failures (e.g. Profile not found or associated with an application).

Example

```java
// define action string
String resetDefaultProfile =
"com.symbol.datawedge.api.ACTION_RESETDEFAULTPROFILE";

public void onResume() {
    // create the intent
    Intent i = new Intent();
    // set the action to perform
    i.setAction(resetDefaultProfile);
    context.this.sendBroadcast(i);
}
```

Comments

None.
Switch To Profile

Use the SwitchToProfile API action to switch to the specified Profile.

Profiles Recap

DataWedge is based on Profiles and plug-ins. A Profile contains information on how DataWedge should behave with different applications.

Profile information consists of:

- Associated application
- Input plug-in configurations
- Output plug-in configurations
- Process plug-in configurations

DataWedge includes a default Profile, Profile0, that is created automatically the first time DataWedge runs.

Using Profiles, each application can have a specific DataWedge configuration. For example, each user application can have a Profile which outputs scanned data in the required format when that application comes to the foreground. DataWedge can be configured to process the same set of captured data differently based on the requirements of each application.

NOTE

A single Profile may be associated with one or many activities/apps, however, given an activity, only one Profile may be associated with it.

Usage Scenario

An application has two activities. Activity A only requires EAN13 bar codes to be scanned. Activity B only requires MSR card data. Profile B is configured to only scan EAN13 bar codes and is left unassociated. Profile M is configured to only accept MSR input and is left unassociated. When Activity A launches it uses SwitchToProfile to activate Profile B. Similarly, when Activity B launches it uses switchToProfile to activate Profile M.

If another activity/app comes to the foreground, DataWedge auto Profile switching will set the DataWedge Profile accordingly either to the default Profile or to an associated Profile.

When Activity A (or Activity B) comes back to the foreground it will use switchToProfile to reset the Profile back to Profile B (or Profile M).

Function Prototype

```java
Intent i = new Intent();
i.setAction(ACTION);  
i.putExtra(EXTRA_DATA, "<profile name>");
```

Parameters

- **action**: String "com.symbol.datawedge.api.ACTION SWITCHTOPROFILE"
**extra_data**: String "com.symbol.datawedge.api.EXTRA_PROFILENAME"

<profile name>: The Profile name to switch to as a string (case-sensitive).

**Return Values**

None.

Error and debug messages will be logged to the Android logging system which then can be viewed and filtered by the logcat command. You can use logcat from an ADB shell to view the log messages, e.g.

```
$ adb logcat -s DWAPI
```

Error messages will be logged for invalid actions, parameters and failures (e.g. Profile not found or associated with an application).

**Example**

```java
// define action and data strings
String switchToProfile = "com.symbol.datawedge.api.ACTION_SWITCHTOPROFILE";
String extraData = "com.symbol.datawedge.api.EXTRA_PROFILENAME";

public void onResume() {
    super.onResume();
    // create the intent
    Intent i = new Intent();
    // set the action to perform
    i.setAction(switchToProfile);
    // add additional info
    i.putExtra(extraData, "myProfile");
    // send the intent to DataWedge
    context.this.sendBroadcast(i);
}
```

**Comments**

This API function will have no effect if the specified Profile does not exist or is already associated with an application.

DataWedge has a one-to-one relationship between Profiles and activities; a Profile can be associated only with a single activity. When a Profile is first created, it's not associated with any application, and will not be activated until associated. This makes it possible to create multiple unassociated Profiles.

This API function activates such Profiles.

For example, Profile A is unassociated and Profile B is associated with activity B. If activity A is launched and uses `SwitchToProfile` function to switch to Profile A, then Profile A will be active whenever activity A is in the foreground. When activity B comes to the foreground, DataWedge will automatically switch to Profile B.
When activity A returns to the foreground, the app must use `SwitchToProfile` again to switch back to Profile A. This would be done in the `onResume` method of activity A.

**NOTE** Because DataWedge will automatically switch Profile when the activity is paused, Zebra recommends that this API function be called from the `onResume` method of the activity.

After switching to a Profile, this unassociated Profile does not get assigned to the application/activity and is available to be used in the future with a different app/activity.

For backward compatibility, DataWedge’s automatic Profile switching is not affected by the above API commands. This why the commands work only with unassociated Profiles and apps.

DataWedge auto Profile switching works as follows:

Every second…

- Sets `newProfileId` to the associated Profile ID of the current foreground activity.
- If no associated Profile is found, sets `newProfileId` to the associated Profile ID of the current foreground app.
- If no associated Profile is found, sets `newProfileId` to the current default Profile (which MAY NOT be Profile0).
- Checks the `newProfileId` against the `currentProfileId`. If they are different:
  - deactivates current Profile
  - activates new Profile (newProfileId)
  - sets `currentProfileId` = `newProfileId`
Introduction

NOTE  Windows devices only.

This chapter provides information for configuring the Interactive Sensor Technology (IST) settings.

IST Settings

IST settings can be accessed:

- On Windows Embedded Handheld devices, tap Start > Settings > System > IST Settings.
- On Windows CE devices, tap Start > Settings > Control Panel > IST Settings.
IST Info

Use the IST Info tab to view IST software information.

![IST Info Tab](image)

Table 11-1  IST Info Tab Information

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware Version</td>
<td>Displays the version information of IST device firmware.</td>
</tr>
<tr>
<td>Driver Version</td>
<td>Displays the version information of IST driver.</td>
</tr>
<tr>
<td>CPL Version</td>
<td>Displays the version information of IST control panel.</td>
</tr>
<tr>
<td>API Version</td>
<td>Displays the version information of IST application programming interface.</td>
</tr>
<tr>
<td>Service Version</td>
<td>Displays the version information of IST service</td>
</tr>
<tr>
<td>HAL Version</td>
<td>Displays the version information of IST hardware abstraction layer.</td>
</tr>
</tbody>
</table>

Power Management Tab

Use the Power Management tab to configure power management settings.

![Power Management Tab](image)
On Face Down

The **On Face Down** section provides configurable options to control what happens when the MC92N0-G is placed with the display face down.

Select the **Display Off** checkbox to turn off the backlight when the MC92N0-G is placed face-down. The backlight automatically powers on when the MC92N0-G is tuned face-up.

Select the **Suspend** checkbox to suspend the MC92N0-G when it placed face-down. To wake the MC92N0-G use the controls listed in the **Wake Up on Motion** section below.

Keep Alive On Motion

Select the **Enabled** checkbox to prevent the MC92N0-G from going into suspend mode while it is in motion. The motion sensitivity is configurable. To set the sensitivity, tap the **Change Sensitivity...** button.

![Set IST Sensitivity Window](image)

**NOTE** There is no time out defined for suspend due to IST inactivity. To aggressively manage power, while there is no motion, set the MC92N0-G suspend time out to a very short time using system power settings. This setting suspends the MC92N0-G when there is no motion activity or any other activity within this set time out.

Wake Up on Motion

The **Wake Up on Motion** section provides configurable options for waking the MC92N0-G from suspend mode by shaking the MC92N0-G.

Select **Inactivity** checkbox to allow IST to wake the MC92N0-G when it was suspended due to inactivity.

Use the **Change Sensitivity...** button to configure the sensitivity settings.

Setting Sensitivity

Use the slider to set the sensitivity. A low setting indicates that a harder shake (faster movement) is required for the IST to initiate a wake up action. The sensitivity can be set from “0” to “10” and when the sensitivity is set to lower values a simple shake/motion can be detected by IST. A high setting allows IST to issue a wake up action when an easier movement to the MC92N0-G is detected. Shake the MC92N0-G to test the set sensitivity. An audio sound is heard and a message is displayed on screen when the shaking level reaches the set sensitivity level.
Display Tab

Use the **Display** tab to configure display interaction settings.

![Display Tab](image)

**Figure 11-4  Display Tab**

The Auto Orientation parameter controls the display rotation according to the MC92N0-G orientation. Select the **Auto Orientation** checkbox to enable this feature. Auto orientation is disabled by default.

Events Tab

Use the **Events** tab to notify any motion event. This feature in IST mainly focuses on abuse by dropping the device.

![Events Tab](image)

**Figure 11-5  Events Tab**

Use the Audible Notification panel to enable playing of a wave file when the MC92N0-G is dropped. Select a desired .wav file from the Sounds: drop-down list.

Sensors Tab

Use the **Sensors** tab to display the list of sensors available in IST:

- Orientation
- Motion
- Accelerometer
- Tilt Angle
Tap on each sensor to view the **Sensor Info**.

**Sensor Info**

The **Sensor Info** list displays the name, ID, range, unit, scale, connectivity and status of the sensor.

Tap **Menu** to select **VisualizeView** or **GraphView** for the sensor.
Figure 11-9  GraphView Window
CHAPTER 12 MAINTENANCE AND TROUBLESHOOTING

Introduction

This chapter includes instructions on cleaning and storing the MC92N0-G, and provides troubleshooting solutions for potential problems during MC92N0-G operating.

Maintaining the MC92N0-G

For trouble-free service, observe the following tips when using the MC92N0-G:

- Protect the MC92N0-G from temperature extremes. Do not leave it on the dashboard of a car on a hot day, and keep it away from heat sources.
- Do not store or use the MC92N0-G in any location that is extremely dusty, damp, or wet.
- Use a soft lens cloth to clean the MC92N0-G. If the surface of the MC92N0-G screen becomes soiled, clean it with a soft cloth moistened with a diluted window-cleaning solution.
- Periodically replace the rechargeable Li-ion battery to ensure maximum battery life and product performance. Battery life depends on individual usage patterns.
- Take care not to scratch the screen of the MC92N0-G. When working with the MC92N0-G, use the supplied stylus or plastic-tipped pens intended for use with a touch-sensitive screen. Never use an actual pen or pencil or other sharp object on the surface of the MC92N0-G screen.
- The touch-sensitive screen of the MC92N0-G contains glass. Take care not to drop the MC92N0-G or subject it to strong impact.

Battery Safety Guidelines

- The area in which the units are charged should be clear of debris and combustible materials or chemicals. Particular care should be taken where the device is charged in a non commercial environment.
- Follow battery usage, storage, and charging guidelines found in the user’s guide.
- Improper battery use may result in a fire, explosion, or other hazard.
- To charge the mobile device battery, the battery and charger temperatures must be between +32 ºF and +104 ºF (0 ºC and +40 ºC)
• Do not use incompatible batteries and chargers. Use of an incompatible battery or charger may present a risk of fire, explosion, leakage, or other hazard. If you have any questions about the compatibility of a battery or a charger, contact Zebra Global Customer Support.

• For devices that utilize a USB port as a charging source, the device shall only be connected to products that bear the USB-IF logo or have completed the USB-IF compliance program.

• Do not disassemble or open, crush, bend or deform, puncture, or shred.

• Severe impact from dropping any battery-operated device on a hard surface could cause the battery to overheat.

• Do not short circuit a battery or allow metallic or conductive objects to contact the battery terminals.

• Do not modify or remanufacture, attempt to insert foreign objects into the battery, immerse or expose to water or other liquids, or expose to fire, explosion, or other hazard.

• Do not leave or store the equipment in or near areas that might get very hot, such as in a parked vehicle or near a radiator or other heat source. Do not place battery into a microwave oven or dryer.

• Battery usage by children should be supervised.

• Please follow local regulations to promptly dispose of used rechargeable batteries.

• Do not dispose of batteries in fire.

• Seek medical advice immediately if a battery has been swallowed.

• In the event of a battery leak, do not allow the liquid to come in contact with the skin or eyes. If contact has been made, wash the affected area with large amounts of water and seek medical advice.

• If you suspect damage to your equipment or battery, contact Zebra support to arrange for inspection.

Cleaning

**CAUTION** Always wear eye protection.

Read warning label on compressed air and alcohol product before using.

If you have to use any other solution for medical reasons please contact Zebra for more information.

**WARNING!** Avoid exposing this product to contact with hot oil or other flammable liquids. If such exposure occurs, unplug the device and clean the product immediately in accordance with these guidelines.

Approved Cleanser Active Ingredients

100% of the active ingredients in any cleaner must consist of one or some combination of the following: isopropyl alcohol, bleach/sodium hypochlorite, hydrogen peroxide or mild dish soap.

Harmful Ingredients

The following chemicals are known to damage the plastics on the MC92N0-G and should not come in contact with the device: ammonia solutions, compounds of amines or ammonia; acetone; ketones; ethers; aromatic and chlorinated hydrocarbons; acqueous or alcoholic alkaline solutions; ethanolamine; toluene; trichloroethylene; benzene; carboxylic acid and TB-lysoform.
Cleaning Instructions

Do not apply liquid directly to the MC92N0-G. Dampen a soft cloth or use pre-moistened wipes. Do not wrap the device in the cloth or wipe, but gently wipe the unit. Be careful not to let liquid pool around the display window or other places. Allow the unit to air dry before use.

Special Cleaning Notes

Many vinyl gloves contain phthalate additives, which are often not recommended for medical use and are known to be harmful to the housing of the MC92N0-G. The MC92N0-G should not be handled while wearing vinyl gloves containing phthalates, or before hands are washed to remove contaminant residue after gloves are removed. If products containing any of the harmful ingredients listed above are used prior to handling the MC92N0-G, such as hand sanitizer that contain ethanolamine, hands must be completely dry before handling the MC92N0-G to prevent damage to the plastics.

Materials Required

- Alcohol wipes
- Lens tissue
- Cotton tipped applicators
- Isopropyl alcohol
- Can of compressed air with a tube.

Cleaning the MC92N0-G

Housing
Using the alcohol wipes, wipe the housing including keys and in-between keys.

Display
The display can be wiped down with the alcohol wipes, but care should be taken not to allow any pooling of liquid around the edges of the display. Immediately dry the display with a soft, non-abrasive cloth to prevent streaking.

Scanner Exit Window
Wipe the scanner exit window periodically with a lens tissue or other material suitable for cleaning optical material such as eyeglasses.

Battery Contacts
1. Remove the battery from MC92N0-G.
2. Dip the cotton portion of the cotton tipped applicator in isopropyl alcohol.
3. Rub the cotton portion of the cotton tipped applicator back-and-forth across the battery contacts on the bottom of the battery. Do not leave any cotton residue on the contacts.
4. Repeat at least three times.
5. Use the cotton tipped applicator dipped in alcohol to remove any grease and dirt near the contact area.
6. Use a dry cotton tipped applicator and repeat steps 3 through 5.
7. Spray compressed air on the contact area by pointing the tube/nozzle about ½ inch away from the surface.
8. Inspect the area for any grease or dirt, repeat if required.
9. Replace the battery in the MC92N0-G.

Cleaning Cradle Connectors

To clean the connectors on a cradle:

1. Remove the DC power cable from the cradle.
2. Dip the cotton portion of the cotton tipped applicator in isopropyl alcohol.
3. Rub the cotton portion of the cotton tipped applicator along the pins of the connector(s). Slowly move the applicator back-and-forth from one side of the connector to the other. Do not let any cotton residue on the connector.
4. All sides of the connector should also be rubbed with the cotton tipped applicator.
5. Spray compressed air in the connector area by pointing the tube/nozzle about ½ inch away from the surface.

CAUTION Do not point nozzle at yourself and others, ensure the nozzle or tube is away from your face.

6. Ensure that there is no lint left by the cotton tipped applicator, remove lint if found.
7. If grease and other dirt can be found on other areas of the cradle, use lint free cloth and alcohol to remove.
8. Allow at least 10 to 30 minutes (depending on ambient temperature and humidity) for the alcohol to air dry before applying power to cradle.
   If the temperature is low and humidity is high, longer drying time is required. Warm temperature and dry humidity requires less drying time.

CAUTION Do not point nozzle at yourself and others, ensure the nozzle or tube is away from your face.

Cleaning Frequency

The cleaning frequency is up to the customer’s discretion due to the varied environments in which the mobile devices are used. They may be cleaned as frequently as required. However when used in dirty environments it may be advisable to periodically clean the scanner exit window to ensure optimum scanning performance.
## Troubleshooting

### MC92N0-G

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC92N0-G does not turn on.</td>
<td>Lithium-ion battery not charged.</td>
<td>Charge or replace the battery in the MC92N0-G.</td>
</tr>
<tr>
<td></td>
<td>Lithium-ion battery not installed properly.</td>
<td>Ensure battery is installed properly.</td>
</tr>
<tr>
<td></td>
<td>System crash.</td>
<td>Perform a warm boot. If the MC92N0-G still does not turn on, perform a cold boot. See <em>Resetting the MC92N0-G on page 1-2</em>.</td>
</tr>
<tr>
<td>Rechargeable lithium-ion battery did not charge.</td>
<td>Battery failed.</td>
<td>Replace battery. If the MC92N0-G still does not operate, try a warm boot, then a cold boot. See <em>Resetting the MC92N0-G on page 1-2</em>.</td>
</tr>
<tr>
<td></td>
<td>MC92N0-G removed from cradle while battery was charging.</td>
<td>Insert MC92N0-G in cradle and begin charging. The battery requires approximately four hours to recharge fully.</td>
</tr>
<tr>
<td>Cannot see characters on display.</td>
<td>MC92N0-G not powered on.</td>
<td>Press the <strong>Power</strong> button.</td>
</tr>
<tr>
<td>During data communication, no data was transmitted, or transmitted data was incomplete.</td>
<td>MC92N0-G removed from cradle or unplugged from host computer during communication.</td>
<td>Replace the MC92N0-G in the cradle, or reattach the Synchronization cable and re-transmit.</td>
</tr>
<tr>
<td></td>
<td>Incorrect cable configuration.</td>
<td>See the System Administrator.</td>
</tr>
<tr>
<td></td>
<td>Communication software was incorrectly installed or configured.</td>
<td>Perform setup. See <em>Chapter 2, Accessories</em> for details. Ensure that Microsoft ActiveSync 4.5 or greater or Windows Mobile Device Center (WMDC) is installed on the host computer. For Android devices, ensure that MTP driver is installed.</td>
</tr>
<tr>
<td>No sound is audible.</td>
<td>Volume setting is low or turned off.</td>
<td>Turn on or increase volume.</td>
</tr>
</tbody>
</table>
Table 12-1  Troubleshooting the MC92N0-G (Continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Battery is depleted.</td>
<td></td>
<td>Replace the battery.</td>
</tr>
<tr>
<td>Tapping the window buttons or icons does not activate the corresponding feature.</td>
<td>LCD screen not aligned correctly.</td>
<td>Re-calibrate the screen.</td>
</tr>
<tr>
<td>The system is hung.</td>
<td></td>
<td>Warm boot the system. To perform a warm boot (see Resetting the MC92N0-G on page 1-2).</td>
</tr>
<tr>
<td>A message appears stating that the MC92N0-G memory is full.</td>
<td>Too many files stored on the MC92N0-G.</td>
<td>Delete unused memos and records. You can save these records on the host computer.</td>
</tr>
<tr>
<td></td>
<td>Too many applications installed on the MC92N0-G.</td>
<td>If you have installed additional applications on the MC92N0-G, remove them to recover memory. On Windows Embedded Handheld devices, tap Start &gt; Settings &gt; System &gt; Remove Programs. On Windows CE devices, tap Start &gt; Settings &gt; Control Panel &gt; Remove Programs. Select the unused program and tap Remove. On Android devices, touch Settings &gt; App &gt; Downloaded. Select the unused downloaded application and touch Uninstall.</td>
</tr>
</tbody>
</table>
### Table 12-1  Troubleshooting the MC92N0-G (Continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The MC92N0-G does not accept scan input.</td>
<td>Scanning application is not loaded.</td>
<td>Verify that the MC92N0-G is loaded with a scanning application. See the System Administrator.</td>
</tr>
<tr>
<td></td>
<td>Unreadable bar code.</td>
<td>Ensure the symbol is not defaced.</td>
</tr>
<tr>
<td></td>
<td>Distance between exit window and bar code is incorrect.</td>
<td>Ensure MC92N0-G is within proper scanning range.</td>
</tr>
<tr>
<td></td>
<td>MC92N0-G is not programmed for the bar code.</td>
<td>Ensure the MC92N0-G is programmed to accept the type of bar code being scanned.</td>
</tr>
<tr>
<td></td>
<td>MC92N0-G is not programmed to generate a beep.</td>
<td>If a beep on a good decode is expected and a beep is not heard, check that the application is set to generate a beep on good decode.</td>
</tr>
<tr>
<td></td>
<td>Battery is low.</td>
<td>If the scanner stops emitting a laser beam when the trigger is pressed, check the battery level. When the battery is low, the scanner shuts off before the MC92N0-G low battery condition notification. Note: If the scanner is still not reading symbols, contact the distributor or Zebra.</td>
</tr>
<tr>
<td>WLAN connection is lost when the MC92N0-G is connected to a host computer using ActiveSync. (Windows devices only)</td>
<td>Microsoft security feature prevents connection to two separate networks.</td>
<td>Disconnect from the WLAN network prior to connecting to a host computer using ActiveSync.</td>
</tr>
<tr>
<td>MC92N0-G cannot find any Bluetooth devices nearby.</td>
<td>Too far from other Bluetooth devices.</td>
<td>Move closer to the other Bluetooth device(s), within a range of 10 meters.</td>
</tr>
<tr>
<td></td>
<td>The Bluetooth device(s) nearby are not turned on.</td>
<td>Turn on the Bluetooth device(s) you wish to find.</td>
</tr>
<tr>
<td></td>
<td>The Bluetooth device(s) are not in discoverable mode.</td>
<td>Set the Bluetooth device(s) to discoverable mode. If needed, refer to the device’s user documentation for help.</td>
</tr>
<tr>
<td>MC92N0-G keeps powering down to protect memory contents.</td>
<td>The MC92N0-G’s battery is low.</td>
<td>Recharge the battery.</td>
</tr>
<tr>
<td>Cannot extract Real-time data.</td>
<td>MC92N0-G is not responding.</td>
<td>Perform a warm boot then press F9 to extract data.</td>
</tr>
</tbody>
</table>
Four Slot Charge Only Cradle

Table 12-2  Troubleshooting the Four Slot Charge Only Cradle

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC92N0-G charge indicator LED does not light.</td>
<td>Cradle is not receiving power.</td>
<td>Ensure the power supply is securely connected and receiving power.</td>
</tr>
<tr>
<td>MC92N0-G is not seated correctly in the cradle.</td>
<td></td>
<td>Ensure the battery is properly installed in the MC92N0-G, and re-seat the MC92N0-G in the cradle.</td>
</tr>
<tr>
<td>The battery is not properly installed in the MC92N0-G.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The battery in the MC92N0-G is faulty.</td>
<td></td>
<td>Verify that other batteries charge properly. If so, replace the faulty battery.</td>
</tr>
</tbody>
</table>

Note: The Four Slot Charge Only Cradle has no power indication.

Four Slot Ethernet Cradle

Table 12-3  Troubleshooting the Four Slot Ethernet Cradle

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attempt by the MC92N0-G to ActiveSync failed.</td>
<td>Cannot perform ActiveSync connection.</td>
<td>ActiveSync over an Ethernet connection is not available with Windows Embedded Handheld or Windows CE and ActiveSync 4.5.</td>
</tr>
<tr>
<td>During communications, no data was transmitted, or transmitted data was incomplete.</td>
<td>MC92N0-G removed from cradle during communications.</td>
<td>Replace MC92N0-G in cradle and retransmit.</td>
</tr>
<tr>
<td></td>
<td>MC92N0-G has no active connection.</td>
<td>An icon will be visible in the status bar if a connection is currently active.</td>
</tr>
<tr>
<td>MC92N0-G has successfully connected through the cradle, but no data is being transmitted over the connection.</td>
<td>Data is being transferred over the wireless link.</td>
<td>Temporarily disable the WLAN connection to force data transmission through the cradle. Once you have completed your data transmission, re-enable the WLAN connection.</td>
</tr>
</tbody>
</table>
### Table 12-3  Troubleshooting the Four Slot Ethernet Cradle (Continued)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Communication Status LEDs are flashing red.</td>
<td>The cradle could not configure itself, or it has lost the lease on its IP address.</td>
<td>Connect the cradle to an Ethernet network with a correctly functioning DHCP server.</td>
</tr>
<tr>
<td></td>
<td>Failed automatic cradle configuration via local DHCP service.</td>
<td>Connect a properly configured DHCP server or DHCP relay agent to the subnet, and power cycle the cradle. Check the DHCP server log to verify that the cradle is receiving a response to its DHCP request.</td>
</tr>
<tr>
<td></td>
<td>The Ethernet link may be down.</td>
<td>Ensure the Ethernet cable is connected to an active hub.</td>
</tr>
<tr>
<td>Communication Status LED does not light up.</td>
<td>MC92N0-G has been inserted incorrectly into the cradle.</td>
<td>Remove, wait a minute, and then reinsert the MC92N0-G, ensuring it fits snugly onto the connector at the bottom of the cradle.</td>
</tr>
<tr>
<td></td>
<td>Cradle is not receiving power.</td>
<td>Ensure the power supply is securely connected and receiving power.</td>
</tr>
</tbody>
</table>
| Battery is not recharging.                        | MC92N0-G removed from the cradle too soon.                           | Replace the MC92N0-G into the cradle. It can take up to four hours to recharge a completely depleted battery pack if MC92N0-G is suspended or longer if the MC92N0-G is on.  
On Windows Embedded Handheld devices, view battery status by tapping **Start > Settings > System > Power**.  
On Windows CE devices, view battery status by tapping **Start > Settings > Control Panel > Power**.  
On Android devices, touch **Settings > Battery**. |
|                                                   | Battery is faulty.                                                   | Verify that other batteries charge properly. If so, replace the faulty battery.               |
|                                                   | MC92N0-G is not inserted correctly into the cradle.                 | Remove the MC92N0-G and reinsert it correctly. Verify charging is active.  
On Windows Embedded Handheld devices, view battery status by tapping **Start > Settings > System > Power**.  
On Windows CE devices, view battery status by tapping **Start > Settings > Control Panel > Power**.  
On Android devices, touch **Settings > Battery**. |
| Warning Message - "! Unable to obtain a server assigned IP address. Try again later or enter an IP address in Network Settings." | This message occurs if a suspend/resume cycle is performed and the MC92N0-G radio is not associated (e.g. due to being out of range). | Tap **OK** to close the message. The MC92N0-G will obtain address information and communicate through the Ethernet cradle. |
Four Slot Spare Battery Charger

Table 12-4  Troubleshooting The Four Slot Spare Battery Charger

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batteries not charging.</td>
<td>Battery was removed from the charger or charger was unplugged from AC power too soon.</td>
<td>Ensure the charger is receiving power. Confirm main battery is charging. If a battery is fully depleted, it can take up to four hours to fully recharge a battery.</td>
</tr>
<tr>
<td></td>
<td>Battery is faulty.</td>
<td>Verify that other batteries charge properly. If so, replace the faulty battery.</td>
</tr>
<tr>
<td></td>
<td>Battery contacts not connected to charger.</td>
<td>Verify that the battery is seated in the battery well correctly with the contacts facing down.</td>
</tr>
</tbody>
</table>

Single Slot Serial/USB Cradle

Table 12-5  Troubleshooting the Single Slot Serial/USB Cradle

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>LEDs do not light when MC92N0-G or spare battery is inserted.</td>
<td>Cradle is not receiving power.</td>
<td>Ensure the power cable is connected securely to both the cradle and to AC power.</td>
</tr>
<tr>
<td></td>
<td>MC92N0-G is not seated firmly in the cradle.</td>
<td>Remove and re-insert the MC92N0-G into the cradle, ensuring it is firmly seated.</td>
</tr>
<tr>
<td></td>
<td>Spare battery is not seated firmly in the cradle.</td>
<td>Remove and re-insert the spare battery into the charging slot, ensuring it is firmly seated.</td>
</tr>
<tr>
<td>MC92N0-G battery is not charging.</td>
<td>MC92N0-G was removed from cradle or cradle was unplugged from AC power too soon.</td>
<td>Ensure cradle is receiving power. Ensure MC92N0-G is seated correctly. Confirm that the battery is charging. If a MC92N0-G battery is fully depleted, it can take up to four hours to fully recharge a battery (if the MC92N0-G is off and longer if the MC92N0-G is operating).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>On Windows Embedded Handheld devices, view battery status by tapping <strong>Start &gt; Settings &gt; System</strong> tab &gt; <strong>Power</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>On Windows CE devices, view battery status by tapping <strong>Start &gt; Settings &gt; Control Panel &gt; Power</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>On Android devices, touch 🌅 &gt; <strong>Battery</strong>.</td>
</tr>
<tr>
<td></td>
<td>Battery is faulty.</td>
<td>Verify that other batteries charge properly. If so, replace the faulty battery.</td>
</tr>
<tr>
<td></td>
<td>The MC92N0-G is not fully seated in the cradle.</td>
<td>Remove and re-insert the MC92N0-G into the cradle, ensuring it is firmly seated.</td>
</tr>
</tbody>
</table>
Table 12-5  Troubleshooting the Single Slot Serial/USB Cradle (Continued)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spare battery is not charging.</td>
<td>Battery not fully seated in charging slot.</td>
<td>Remove and re-insert the spare battery into the cradle, ensuring it is firmly seated.</td>
</tr>
<tr>
<td></td>
<td>Battery inserted incorrectly.</td>
<td>Ensure the contacts are facing down and toward the back of the cradle.</td>
</tr>
<tr>
<td></td>
<td>Battery is faulty.</td>
<td>Verify that other batteries charge properly. If so, replace the faulty battery.</td>
</tr>
<tr>
<td>During data communications, no data was transmitted, or transmitted data was incomplete.</td>
<td>MC92N0-G removed from cradle during communications.</td>
<td>Replace MC92N0-G in cradle and retransmit.</td>
</tr>
<tr>
<td></td>
<td>Incorrect cable configuration.</td>
<td>See the System Administrator.</td>
</tr>
<tr>
<td></td>
<td>Communications software is not installed or configured properly.</td>
<td>Perform setup as described in <em>Chapter 2, Accessories.</em></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ensure that Microsoft ActiveSync 4.5 or greater is installed on the host computer. For Android devices, ensure that MTP driver is installed.</td>
</tr>
</tbody>
</table>

Cable Adapter Module

Table 12-6  Troubleshooting The Cable Adapter Module

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC92N0-G battery is not charging.</td>
<td>MC92N0-G was removed from CAM or CAM was unplugged from AC power too soon.</td>
<td>Ensure CAM is receiving power. Ensure MC92N0-G is attached correctly. Confirm that the battery is charging. If a MC92N0-G battery is fully depleted, it can take up to four hours to fully recharge a battery (if the MC92N0-G is off and longer if the MC92N0-G is operating). On Windows Embedded Handheld devices, view battery status by tapping Start &gt; Settings &gt; System &gt; Power. On Windows CE devices, view battery status by tapping Start &gt; Settings &gt; Control Panel &gt; Power. On Android devices, touch Battery.</td>
</tr>
<tr>
<td>Battery is faulty.</td>
<td></td>
<td>Verify that other batteries charge properly. If so, replace the faulty battery.</td>
</tr>
<tr>
<td>The MC92N0-G is not fully attached to the CAM.</td>
<td></td>
<td>Detach and re-attach the CAM to the MC92N0-G, ensuring it is firmly connected.</td>
</tr>
</tbody>
</table>
During data communications, no data was transmitted, or transmitted data was incomplete.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC92N0-G detached from CAM during communications.</td>
<td>Re-attach MC92N0-G to CAM and retransmit.</td>
<td></td>
</tr>
<tr>
<td>Incorrect cable configuration.</td>
<td>See the System Administrator.</td>
<td></td>
</tr>
<tr>
<td>Communications software is not installed or configured properly.</td>
<td>Perform setup as described in Chapter 2, Accessories.</td>
<td>Ensure that Microsoft ActiveSync 4.5 or greater or WMDC is installed on the host computer. For Android devices, ensure that MTP driver is installed.</td>
</tr>
<tr>
<td>Android devices do not support serial communication.</td>
<td>Use USB communication.</td>
<td></td>
</tr>
</tbody>
</table>

**Magnetic Stripe Reader**

**Table 12-7  Troubleshooting the Magnetic Stripe Reader**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSR cannot read card.</td>
<td>MC92N0-G detached from MSR during card swipe.</td>
<td>Re-attach MC92N0-G to MSR and reswipe the card.</td>
</tr>
<tr>
<td>Faulty magnetic stripe on card.</td>
<td>See the System Administrator.</td>
<td></td>
</tr>
<tr>
<td>MSR application is not installed or configured properly.</td>
<td>Ensure the MSR application is installed on the MC92N0-G.</td>
<td>Ensure the MSR application is configured correctly.</td>
</tr>
</tbody>
</table>
**Table 12-7  Troubleshooting the Magnetic Stripe Reader (Continued)**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC92N0-G battery is not charging.</td>
<td>MC92N0-G was removed from MSR or MSR was unplugged from AC power too soon.</td>
<td>Ensure MSR is receiving power. Ensure MC92N0-G is attached correctly. Confirm that the battery is charging. If a MC92N0-G battery is fully depleted, it can take up to four hours to fully recharge a battery (if the MC92N0-G is off and longer if the MC92N0-G is operating). On Windows Embedded Handheld devices, view battery status by tapping <strong>Start &gt; Settings &gt; System &gt; Power</strong>. On Windows CE devices, view battery status by tapping <strong>Start &gt; Settings &gt; Control Panel &gt; Power</strong>. On Android devices, touch <strong>Battery</strong>.</td>
</tr>
<tr>
<td>Battery is faulty.</td>
<td></td>
<td>Verify that other batteries charge properly. If so, replace the faulty battery.</td>
</tr>
<tr>
<td>The MC92N0-G is not fully attached to the MSR.</td>
<td></td>
<td>Detach and re-attach the MSR to the MC92N0-G, ensuring it is firmly connected.</td>
</tr>
<tr>
<td>During data communications, no data was transmitted, or transmitted data was incomplete.</td>
<td>MC92N0-G detached from MSR during communications.</td>
<td>Reattach MC92N0-G to MSR and retransmit.</td>
</tr>
<tr>
<td></td>
<td>Incorrect cable configuration.</td>
<td>See the System Administrator.</td>
</tr>
<tr>
<td></td>
<td>Communications software is not installed or configured properly.</td>
<td>Perform setup as described in <em>Chapter 2, Accessories</em>.</td>
</tr>
<tr>
<td></td>
<td>Android devices do not support serial communication.</td>
<td>Use USB communication.</td>
</tr>
</tbody>
</table>
## Modem Module

### Table 12-8  Troubleshooting the Modem Module

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC92N0-G is not communicating through the modem.</td>
<td>The modem cable is not fully connected.</td>
<td>Connect the modem cable securely to both the modem and the telephone jack.</td>
</tr>
<tr>
<td>Modem is not securely connected to the MC92N0-G.</td>
<td>Reconnect the modem firmly to the MC92N0-G.</td>
<td></td>
</tr>
<tr>
<td>Communication software is not installed or configured properly.</td>
<td>Set up the communication software as described in Chapter 2, Accessories.</td>
<td></td>
</tr>
<tr>
<td>Problem in the telephone lines.</td>
<td>Connect a conventional telephone and dial the remote modem to verify the telephone lines are functioning. If the remote modem does not answer the call and emit answering tones, contact the remote System Administrator.</td>
<td></td>
</tr>
<tr>
<td>MC92N0-G’s battery is low or discharged, which shuts off power to the modem.</td>
<td>Install a charged battery in the MC92N0-G, or use an external DC power adapter to recharge the battery.</td>
<td></td>
</tr>
<tr>
<td>ActiveSync fails (Windows devices only).</td>
<td>A partnership was not established with the host computer.</td>
<td>Establish a partnership with the host computer (see Chapter 2, Accessories).</td>
</tr>
<tr>
<td>Host computer is not selected in the ActiveSync window on the MC92N0-G.</td>
<td>Select a host computer in the ActiveSync window, and perform setup (see Chapter 2, Accessories).</td>
<td></td>
</tr>
<tr>
<td>Modem RAS connection not allowed by host computer.</td>
<td>Select RAS connection in the host computer (File &gt; Connection Settings window). Refer to the ReadMe files located in the Microsoft ActiveSync folder on the host computer.</td>
<td></td>
</tr>
<tr>
<td>MC92N0-G or modem was disconnected from the telephone line while ActiveSync was in progress.</td>
<td>Disconnect the modem cable for 30 seconds to hang up the local telephone connection. Close any open windows on the MC92N0-G and any modem connections.</td>
<td></td>
</tr>
<tr>
<td>Synchronization occurred, but the session is configured to close immediately after synchronization is complete.</td>
<td>Verify the setting of the When manually synchronizing disconnect when complete checkbox by tapping Start &gt; ActiveSync &gt; Menu &gt; Options &gt; Schedule tab.</td>
<td></td>
</tr>
</tbody>
</table>
Table 12-8  Troubleshooting the Modem Module (Continued)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dial-out fails</td>
<td>Location setting is incorrect.</td>
<td>Verify Dialing Locations. Verify Dialing Patterns are correct for the current location. For example, enter ‘G’ in the For local calls, dial: field to dial directly, or ‘9,G’ if the telephone system requires dialing ‘9’ first to access an outside line.</td>
</tr>
<tr>
<td>Incorrect server phone number.</td>
<td></td>
<td>Verify the connection phone number in the Connecting window.</td>
</tr>
<tr>
<td>Pulse dialing not supported for country.</td>
<td></td>
<td>Use a connection within a tone-dialing system.</td>
</tr>
<tr>
<td>The Connection Manager routes are incorrect.</td>
<td></td>
<td>Warm boot the MC92N0-G and confirm the connection settings.</td>
</tr>
</tbody>
</table>
MC92N0-G Specifications

The following table summarizes the MC92N0-G’s technical specifications.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Physical and Environmental Characteristics</strong></td>
<td></td>
</tr>
<tr>
<td>Dimensions</td>
<td>9.1 in. L x 3.6 in. W x 7.6 in. H</td>
</tr>
<tr>
<td></td>
<td>23.1 cm L x 9.1 cm H x 19.3 cm H</td>
</tr>
<tr>
<td>Weight (includes battery, scanner and radio)</td>
<td>709 g (25 oz.)</td>
</tr>
<tr>
<td>Keyboard</td>
<td>28-key; 43-key; 53-key; High Visibility and Terminal Emulation (5250, 3270, VT)</td>
</tr>
<tr>
<td>Display</td>
<td>16 bit color 3.7 in with backlight, 65K colors</td>
</tr>
<tr>
<td></td>
<td>QVGA Mode: 240 W x 320 L (Windows CE only)</td>
</tr>
<tr>
<td></td>
<td>VGA Mode 480 W x 640 L</td>
</tr>
<tr>
<td>Power</td>
<td>Removable, rechargeable 7.4 V Lithium Ion 2600 mAh battery pack, 19.3 watt hours</td>
</tr>
<tr>
<td><strong>Performance Characteristics</strong></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>Texas Instruments OMAP 4430 processor at 1 GHz</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows Embedded Compact 7.0 (Windows CE 7.0)</td>
</tr>
<tr>
<td></td>
<td>Windows Embedded Handheld</td>
</tr>
<tr>
<td></td>
<td>Android-based Android Open Source Project (AOSP) version 4.4.4.</td>
</tr>
<tr>
<td>Memory</td>
<td><strong>Standard</strong>: 512 MB RAM/2 GB FLASH (Windows only)</td>
</tr>
<tr>
<td></td>
<td><strong>Premium</strong>: 1 GB RAM/2 GB FLASH</td>
</tr>
<tr>
<td>Expansion</td>
<td>SD Card (up to 32 GB)</td>
</tr>
</tbody>
</table>
## Application Development
For Windows development, PSDK and EMDK or for Android development, Android EMDK. Available through Zebra Support Central Web site.

## Data Capture Options
- **SE965**: 1D standard range scan engine.
- **SE1524-ER**: 1D extended range scan engine (Windows only).
- **SE4600-LR**: Extended range omnidirectional 1D/2D imaging engine reads 1D and 2D symbols (Windows only).
- **SE4500-SR**: Omnidirectional 1D/2D imaging engine reads 1D and 2D symbols.
- **SE4500-DL**: 1D/2D DL imaging engine reads all 1D and 2D codes as well as the PDF codes found on driver’s licenses and other identification documents (Windows Premium only).
- **SE4500-HD**: 1D/2D DPM imaging engine reads a wide variety of DPM marks on metal, plastic and glass surfaces, including: dot peening, laser etching, molding, stamping or casting (Windows Premium only).
- **SE4750-SR**: Standard Range omnidirectional 1D/2D imaging engine reads 1D and 2D symbols (Premium only).
- **SE4750-MR**: Mid-Range omnidirectional 1D/2D imaging engine reads 1D and 2D symbols (Premium only).
- **SE4580-ER**: Extended range omnidirectional 1D/2D imaging engine reads 1D and 2D symbols (Windows only).

## Voice and Audio
High quality speaker and 2.5 mm headset jack.

## User Environment

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operating Temperature</strong></td>
<td>-4°F to 122°F (-20°C to 50°C)</td>
</tr>
<tr>
<td><strong>Storage Temperature</strong></td>
<td>-25°F to 160°F (-30°C to 60°C)</td>
</tr>
<tr>
<td><strong>Battery Charging Temperature</strong></td>
<td>32 °F to 104 °F (0 °C to +40 °C)</td>
</tr>
<tr>
<td><strong>Humidity</strong></td>
<td>5% to 95% non condensing</td>
</tr>
<tr>
<td><strong>Drop Specification</strong></td>
<td>Multiple drops to concrete: 6 ft./1.8 m across the operating temperature range; meets and exceeds MIL-STD 810G, 8 ft./2.4 m drop at room temperature per MIL-STD810G.</td>
</tr>
<tr>
<td><strong>Tumble</strong></td>
<td>2,000 one-meter tumbles at room temperature (4,000 hits) per IEC Tumble Specification</td>
</tr>
<tr>
<td><strong>Environmental Sealing</strong></td>
<td>IP64 (electronic enclosure, display and keypad) per IEC Sealing Specification</td>
</tr>
<tr>
<td><strong>ESD</strong></td>
<td>+/-15kVdc air discharge</td>
</tr>
<tr>
<td></td>
<td>+/-8kVdc direct discharge</td>
</tr>
<tr>
<td></td>
<td>+/-8kVdc indirect discharge</td>
</tr>
</tbody>
</table>

## WLAN Wireless Data Communications
- **WLAN radio**: 802.11a/b/g/n. Note: 802.11a not available in Thailand.
Table A-1  Technical Specifications (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Power</td>
<td>100mW U.S. and International</td>
</tr>
<tr>
<td>Data Rate</td>
<td>802.11a: up to 54Mb per second</td>
</tr>
<tr>
<td></td>
<td>802.11b: up to 11Mb per second</td>
</tr>
<tr>
<td></td>
<td>802.11g: up to 54Mb per second</td>
</tr>
<tr>
<td></td>
<td>802.11n: up to 72.2Mb per second</td>
</tr>
<tr>
<td>Frequency Range</td>
<td>All country dependent: 802.11a - 5 GHz; 802.11b – 2.4 GHz; 802.11g – 2.4</td>
</tr>
<tr>
<td></td>
<td>GHz / 5.0 GHz</td>
</tr>
<tr>
<td>Antenna</td>
<td>Internal diversity antenna</td>
</tr>
<tr>
<td>WLAN Security</td>
<td>WPA2 Enterprise, 802.1x; EAP-TLS; TTLS (CHAP, MS-CHAP, MS-CHAPv2, PAP or MD5);</td>
</tr>
<tr>
<td></td>
<td>PEAP (TLS, MSCHAPv2, EAP-GTC); LEAP, EAP-FAST (TLS, MS-CHAPv2, EAP-GTC),</td>
</tr>
<tr>
<td></td>
<td>WPA2/AES, CCX v4, FIPS 140-2 compliant and IPv6</td>
</tr>
</tbody>
</table>

WPAN Wireless Data Communications

| Bluetooth          | Windows devices with Microsoft Bluetooth Stack: Bluetooth Version 2.1 with EDR |
|                    | Windows devices with StoneStreet One Bluetooth Stack: Bluetooth Version 4.0 with Low Energy |
|                    | Android devices: Bluetooth Version 4.0 with Low Energy                      |

Peripherals and Accessories

| Cradles            | Single-slot serial/USB, 4-slot Ethernet and 4-slot charge only               |
| Printers           | Supports extensive line of Zebra approved printers and cables               |
| Charger            | 4-Slot universal battery charger, 4-slot battery charger                    |
| Other Accessories  | Cable Adapter Module; full set of holsters; Keypad Module; full set of stylus; full set of cables; Zebra approved CAC Reader for government applications; GSM, Rugged and Cabled Headset |

Table A-2  Data Capture Options

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
Decode Zones

SE965 Standard Range Laser Decode Zones

Figure A-1 shows the decode zone for the SE965 scan engine. The figures are typical values. Table A-3 lists the typical distances for selected bar code densities. The minimum element width (or “symbol density”) is the width in mils of the narrowest element (bar or space) in the symbol.

Note: Typical performance at 73.4°F (23°C) on high quality symbols.

Figure A-1  SE965 Decode Zone
## Table A-3  SE965 Decode Distances

<table>
<thead>
<tr>
<th>Symbol Density/Bar Code Type/W-N Ratio</th>
<th>Bar Code Content/Contrast(^{Note 1})</th>
<th>Typical Working Ranges</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Near</td>
<td>Far</td>
</tr>
<tr>
<td>5.0 mil Code 128</td>
<td>1234</td>
<td>1.2 in</td>
<td>7.7 in</td>
</tr>
<tr>
<td></td>
<td>80% MRD</td>
<td>3.05 cm</td>
<td>19.56 cm</td>
</tr>
<tr>
<td>5.0 mil Code 39; 2.5:1</td>
<td>ABCDEFGH</td>
<td>1.2 in</td>
<td>12.5 in</td>
</tr>
<tr>
<td></td>
<td>80% MRD</td>
<td>3.05 cm</td>
<td>31.75 cm</td>
</tr>
<tr>
<td>7.5 mil Code 39; 2.5:1</td>
<td>ABCDEF</td>
<td>1.1 in</td>
<td>18.5 in</td>
</tr>
<tr>
<td></td>
<td>80% MRD</td>
<td>2.79 cm</td>
<td>46.99 cm</td>
</tr>
<tr>
<td>10 mil Code 128</td>
<td>1234</td>
<td>1.2 in</td>
<td>19.0 in</td>
</tr>
<tr>
<td></td>
<td>80% MRD</td>
<td>3.05 cm</td>
<td>48.26 cm</td>
</tr>
<tr>
<td>13 mil 100% UPC</td>
<td>12345678905</td>
<td>1.6 in</td>
<td>27.0 in</td>
</tr>
<tr>
<td></td>
<td>80% MRD</td>
<td>4.06 cm</td>
<td>68.58 cm</td>
</tr>
<tr>
<td>15 mil Code 128</td>
<td>1234</td>
<td>1.0 in</td>
<td>29.5 in</td>
</tr>
<tr>
<td></td>
<td>80% MRD</td>
<td>2.54 cm</td>
<td>74.93 cm</td>
</tr>
<tr>
<td>20 mil Code 39; 2.2:1</td>
<td>123</td>
<td>1.4 in</td>
<td>52.0 in</td>
</tr>
<tr>
<td></td>
<td>80% MRD</td>
<td>3.56 cm</td>
<td>132.08 cm</td>
</tr>
<tr>
<td>55 mil Code 39; 2.2:1</td>
<td>CD</td>
<td>3.4 in</td>
<td>100.0 in</td>
</tr>
<tr>
<td></td>
<td>80% MRD</td>
<td>8.64 cm</td>
<td>254.00 cm</td>
</tr>
<tr>
<td>100 mil Code 39; 3.0:1 reflective</td>
<td>123456</td>
<td>2 ft</td>
<td>17 ft</td>
</tr>
<tr>
<td></td>
<td>80% MRD</td>
<td>60.96 cm</td>
<td>518.16 cm</td>
</tr>
</tbody>
</table>

Notes:
1. Contrast measured as Mean Reflective Difference (MRD) at 650 nm.
2. Working range specifications at ambient temperature (23°C), photographic quality symbols. Pitch=10°, roll=0°, skew=0°, ambient light < 150 ft-candles using Symbol or equivalent decoder.
3. Dependent on width of bar code.
4. Distances measured from front edge of scan engine chassis.
SE1524 Long Range Laser Decode Zones

Typical decode ranges are shown in Figure A-2. Table A-4 on page A-7 lists the typical distances for the SE1524 for selected bar code densities. The minimum element width (or "symbol density") is the width in mils of the narrowest element (bar or space) in the symbol. The maximum usable length of a symbol at any given range is shown.

Note: Typical performance at 73.4°F (23°C) on high quality symbols.
<table>
<thead>
<tr>
<th>Symbol Density/ p/n / Bar Code Type/ W-N Ratio</th>
<th>Bar Code Content/ Contrast(^\text{Note 1})</th>
<th>Typical Working Ranges</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Near</td>
</tr>
<tr>
<td>7.5 mil</td>
<td>ABCDEF 80% MRD</td>
<td>2.0 in</td>
</tr>
<tr>
<td>64-17452-01 Code 39; 2.5:1</td>
<td></td>
<td>5.08 cm</td>
</tr>
<tr>
<td>10 mil</td>
<td>ABCDE 80% MRD</td>
<td>4.0 in</td>
</tr>
<tr>
<td>64-17454-01 Code 39; 2.5:1</td>
<td></td>
<td>10.16 cm</td>
</tr>
<tr>
<td>15 mil</td>
<td>ABCD 80% MRD</td>
<td>5.0 in</td>
</tr>
<tr>
<td>64-17417-01 Code 39; 2.5:1</td>
<td></td>
<td>12.70 cm</td>
</tr>
<tr>
<td>20 mil</td>
<td>123 80% MRD</td>
<td>5.0 in</td>
</tr>
<tr>
<td>64-17456-01 Code 39; 2.2:1</td>
<td></td>
<td>12.70 cm</td>
</tr>
<tr>
<td>55 mil</td>
<td>CD 80% MRD</td>
<td>15.0 in</td>
</tr>
<tr>
<td>64-17458-01 Code 39; 2.2:1</td>
<td></td>
<td>38.10 cm</td>
</tr>
<tr>
<td>70 mil reflective</td>
<td>123477 Reflective 80% MRD</td>
<td>Note 4</td>
</tr>
<tr>
<td>64-08780-01 Code 39; 3:1</td>
<td></td>
<td>367.0 in</td>
</tr>
<tr>
<td>100 mil reflective</td>
<td>123456 Reflective 80% MRD</td>
<td>Note 4</td>
</tr>
<tr>
<td>64-16990-01 Code 39; 3:1</td>
<td></td>
<td>542.0 in</td>
</tr>
</tbody>
</table>

Notes:
1. CONTRAST measured as Mean Reflective Difference (MRD) at 670 nm.
2. Near ranges are largely dependent upon the width of the bar code.
3. Working range specifications at temperature 23 °C.
4. Near range on reflective bar codes determined by degree of reflectivity and width of bar code.
SE4500 Standard Range Imager Decode Zones

SE4500-SR

Figure A-3 shows the decode zone for the SE4500-SR. Typical values appear. Table A-5 lists the typical distances for selected bar code densities. The minimum element width (or “symbol density”) is the width in mils of the narrowest element (bar or space) in the symbol.

Note: Typical performance at 73˚F (23˚C) on high quality symbols in normal room light.

Vcc = 3.3V

Depth of Field

* Minimum distance determined by symbol length and scan angle.

Figure A-3 SE4500-SR Decode Zone
<table>
<thead>
<tr>
<th>Symbol Density/Bar Code Type</th>
<th>Bar Code Content/Contrast&lt;sup&gt;Note 2&lt;/sup&gt;</th>
<th>Typical Working Ranges</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Near</td>
<td>Far</td>
<td></td>
</tr>
<tr>
<td>5.0 mil Code 39</td>
<td>ABCDEFGH 80% MRD</td>
<td>2.1 in 5.33 cm</td>
<td>7.5 in 19.05 cm</td>
<td></td>
</tr>
<tr>
<td>6.67 mil PDF417</td>
<td>4 Col, 20 Rows 80% MRD</td>
<td>3.4 in 8.64 cm</td>
<td>7.1 in 18.03 cm</td>
<td></td>
</tr>
<tr>
<td>7.5 mil Code 39</td>
<td>ABCDEF 80% MRD</td>
<td>Note 1</td>
<td>10.6 in 26.92 cm</td>
<td></td>
</tr>
<tr>
<td>10 mil PDF417</td>
<td>3 Col, 17 Rows 80% MRD</td>
<td>Note 1</td>
<td>10.1 in 25.65 cm</td>
<td></td>
</tr>
<tr>
<td>13 mil UPC-A</td>
<td>012345678905 80% MRD</td>
<td>1.6 in 5.08 cm</td>
<td>15.5 in 39.37 cm</td>
<td></td>
</tr>
<tr>
<td>15 mil PDF417</td>
<td>80% MRD</td>
<td>Note 1</td>
<td>14.7 in 37.34 cm</td>
<td></td>
</tr>
<tr>
<td>15 mil Data Matrix</td>
<td>18 x 18 Modules 80% MRD</td>
<td>2.8 in 7.11 cm</td>
<td>12.4 in 31.50 cm</td>
<td></td>
</tr>
<tr>
<td>20 mil Code 39</td>
<td>123 80% MRD</td>
<td>Note 1</td>
<td>24.7 in 62.74 cm</td>
<td></td>
</tr>
</tbody>
</table>

Notes:
1. Near distances are field-of-view (FOV) limited.
2. Contrast is measured as Mean Reflective Difference (MRD) at 670 nm.
3. Working range specifications at temperature = 23°C, pitch=18°, roll=0°, skew=0°, photographic quality, ambient light ~30 ft-c, humidity 45-70% RH.
4. Distances measured from front edge of scan engine chassis.
SE4500-DL

*Figure A-4* shows the decode zone for the SE4500-DL. Typical values appear. *Table A-6* lists the typical distances for selected bar code densities. The minimum element width (or “symbol density”) is the width in mils of the narrowest element (bar or space) in the symbol.

**Note:** Typical performance at 73°F (23°C) on high quality symbols in normal room light. Vcc = 3.3V

* Figure A-4  SE4500-DL Decode Zone

* Minimum distance determined by symbol length and scan angle.
### Table A-6  SE4500-DL Decode Distances

<table>
<thead>
<tr>
<th>Symbol Density/Bar Code Type</th>
<th>Bar Code Content/Contrast&lt;sup&gt;Note 2&lt;/sup&gt;</th>
<th>Typical Working Ranges</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Near</td>
</tr>
<tr>
<td>3.0 mil Code 39</td>
<td>80% MRD</td>
<td>2.7 in</td>
</tr>
<tr>
<td>5.0 mil Code 39</td>
<td>ABCDEFGH 80% MRD</td>
<td>1.4 in</td>
</tr>
<tr>
<td>5.0 mil PDF417</td>
<td>80% MRD</td>
<td>2.8 in</td>
</tr>
<tr>
<td>6.67 mil PDF417</td>
<td>4 Col, 20 Rows 80% MRD</td>
<td>1.9 in</td>
</tr>
<tr>
<td>7.5 mil Code 39</td>
<td>ABCDEFGH 80% MRD</td>
<td>Note 1</td>
</tr>
<tr>
<td>10 mil PDF417</td>
<td>3 Col, 17 Rows 80% MRD</td>
<td>Note 1</td>
</tr>
<tr>
<td>13 mil UPC-A</td>
<td>012345678905 80% MRD</td>
<td>1.6 in</td>
</tr>
<tr>
<td>15 mil PDF417</td>
<td>80% MRD</td>
<td>Note 1</td>
</tr>
<tr>
<td>15 mil Data Matrix</td>
<td>18 x 18 Modules 80% MRD</td>
<td>2.3 in</td>
</tr>
<tr>
<td>20 mil Code 39</td>
<td>123 80% MRD</td>
<td>Note 1</td>
</tr>
</tbody>
</table>

**Notes:**
1. Near distances are FOV limited.
2. Contrast is measured as Mean Reflective Difference (MRD) at 670 nm.
3. Working range specifications at temperature = 23°C, pitch=18°, roll=0°, skew=0°, photographic quality, ambient light ~30 ft-c, humidity 45-70%RH.
4. Distances measured from front edge of scan engine chassis.
SE4500-HD

Figure A-5 shows the decode zone for the SE4500-HD. Typical values appear. Table A-7 lists the typical distances for selected bar code densities. The minimum element width (or “symbol density”) is the width in mils of the narrowest element (bar or space) in the symbol.

Note: Typical performance at 73°F (23°C) on high quality symbols in normal room light. Vcc = 3.3V

* Minimum distance determined by symbol length and scan angle.
## Table A-7  SE4500-HD Decode Distances

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Near</td>
</tr>
<tr>
<td>3.0 mil Code 39</td>
<td>80% MRD</td>
<td>1.6 in</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4.06 cm</td>
</tr>
<tr>
<td>4.0 mil PDF417</td>
<td>80% MRD</td>
<td>1.8 in</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4.57 cm</td>
</tr>
<tr>
<td>5.0 mil Code 39</td>
<td>ABCDEFGH 80% MRD</td>
<td>Note 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.0 mil PDF417</td>
<td>80% MRD</td>
<td>1.6 in</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4.06 cm</td>
</tr>
<tr>
<td>5.0 mil Code 39</td>
<td>ABCDEFGH 80% MRD</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6.67 mil PDF417</td>
<td>18 x 18 Modules 80% MRD</td>
<td>1.8 in</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4.57 cm</td>
</tr>
<tr>
<td>7.5 mil Code 39</td>
<td>4 Col, 20 Rows 80% MRD</td>
<td>1.3 in</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3.30 cm</td>
</tr>
<tr>
<td>10 mil PDF417</td>
<td>3 Col, 17 Rows 80% MRD</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13 mil UPC-A</td>
<td>012345678905 80% MRD</td>
<td>1.6 in</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4.06 cm</td>
</tr>
<tr>
<td>15 mil PDF417</td>
<td>80% MRD</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15 mil Data Matrix</td>
<td>18 x 18 Modules 80% MRD</td>
<td>2.0 in</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5.08 cm</td>
</tr>
<tr>
<td>20.0 mil Code 39</td>
<td>123 80% MRD</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

[^2]: Contrast is measured as Mean Reflective Difference (MRD) at 670 nm.

**Notes:**
1. Near distances are FOV limited.
2. Contrast is measured as Mean Reflective Difference (MRD) at 670 nm.
3. Working range specifications at temperature = 23°C, pitch=18°, roll=0°, skew=0°, photographic quality, ambient light ~30 ft-c, humidity 45-70% RH.
4. Distances measured from front edge of scan engine chassis.
SE4600 Long Range Imager Decode Zones

*Figure A-6* and *Figure A-7* show the decode zones for the SE4600 scan engine. The figures are typical values. *Table A-8* lists the typical distances for selected bar code densities. The minimum element width (or "symbol density") is the width in mils of the narrowest element (bar or space) in the symbol.

**Notes:**
- Typical performance at 73.4°F (23°C) on high quality symbols.

**Bar code width = 10.9 in. @ 49 in. depth of field.**
- Total readable bar code width is 2x the width appearing at the top or bottom of the Width of Field scale.

*Figure A-6 SE4600 Decode Zone - Near Ranges*
Notes:
Bar code width = 72.8 in. @ 360 in. depth of field.
Total readable bar code width is 2x the width appearing at the top or bottom of the Width of Field scale.

* Near range determined by degree of reflectivity and width of bar code.

Figure A-7  SE4600 Decode Zone - Far Ranges
<table>
<thead>
<tr>
<th>Symbology</th>
<th>Bar Code Content/ Contrast</th>
<th>Typical Working Range @ 25 Ft-cd Minimum</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Near</td>
</tr>
<tr>
<td>5 mil Code 39</td>
<td>ABCDEFGH</td>
<td>10 in.</td>
</tr>
<tr>
<td></td>
<td>MRD=80%</td>
<td>25.4 cm</td>
</tr>
<tr>
<td>7.5 mil Code 39</td>
<td>ABCDEF</td>
<td>8.5 in.</td>
</tr>
<tr>
<td></td>
<td>MRD=80%</td>
<td>21.6 cm</td>
</tr>
<tr>
<td>10 mil Code 39 (Note 2)</td>
<td>ABCDE</td>
<td>6.5 in.</td>
</tr>
<tr>
<td></td>
<td>MRD=80%</td>
<td>165.1 cm</td>
</tr>
<tr>
<td>15 mil Code 128</td>
<td>1234</td>
<td>7 in.</td>
</tr>
<tr>
<td></td>
<td>MRD=80%</td>
<td>17.8 cm</td>
</tr>
<tr>
<td>20 mil Code 39</td>
<td>123</td>
<td>8 in.</td>
</tr>
<tr>
<td></td>
<td>MRD=80%</td>
<td>20.3 cm</td>
</tr>
<tr>
<td>40 mil Code 39</td>
<td>AB</td>
<td>22 in. (Note 8)</td>
</tr>
<tr>
<td></td>
<td>MRD=80%</td>
<td>55.9 cm</td>
</tr>
<tr>
<td>55 mil Code 39</td>
<td>CD</td>
<td>26 in. (Note 8)</td>
</tr>
<tr>
<td></td>
<td>MRD=80%</td>
<td>66.0 cm</td>
</tr>
<tr>
<td>100 mil Code 39</td>
<td>12</td>
<td>30 in. (Note 8)</td>
</tr>
<tr>
<td></td>
<td>3:1</td>
<td>76.2 cm</td>
</tr>
<tr>
<td>70 mil Reflective Code 39 (Note 4)</td>
<td>123469</td>
<td>46 in. (Note 8)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>116.8 cm</td>
</tr>
<tr>
<td>100 mil Reflective Code 39 (Note 4)</td>
<td>1234</td>
<td>50 in. (Note 8)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>127 cm</td>
</tr>
</tbody>
</table>

Notes:
1. At 23° C.
2. 6.5 inches achievable with near LED (on the right when facing the front of the engine) on and far LED off.
3. Test bar codes with 2 internal LEDs flashing with 1.2A peak current, at ambient light of minimum 25 foot-candle in the plane of the bar code.
4. Mount reflective bar codes on white or black background with minimum 4" border. Luminance in the line-of-sight direction should be 50-120 cd/mm². Ensure there is no extraneous illumination or shadow on the bar code and that it is centered within the aiming pattern.
5. Reading criteria: 3 successful decodes out of 4 consecutive frames after setting autoexposure.
6. Provide a baffle if needed to prevent stray light from getting into the sensor fields of view.
7. Distances are measured from the front face of the scan engine chassis.
8. Near range may be closer with shorter bar codes.
9. Dependent on length of bar codes.
### Table A-8  SE4600 Decode Distances (Continued)

<table>
<thead>
<tr>
<th>Symbology</th>
<th>Bar Code Content/Contrast</th>
<th>Typical Working Range @ 25 Ft-cd Minimum</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Near</td>
</tr>
<tr>
<td>Data Matrix 10 mil</td>
<td>01234567890123450000</td>
<td>12 in.</td>
</tr>
<tr>
<td></td>
<td>MRD=80%</td>
<td>30.5 cm</td>
</tr>
<tr>
<td>Data Matrix 55 mil</td>
<td>123456789</td>
<td>13 in.</td>
</tr>
<tr>
<td></td>
<td>MRD=80%</td>
<td>33.0 cm</td>
</tr>
<tr>
<td>Data Matrix 100 mil</td>
<td>123456789</td>
<td>20 in.</td>
</tr>
<tr>
<td></td>
<td>MRD=80%</td>
<td>50.8 cm</td>
</tr>
</tbody>
</table>

**Notes:**
1. At 23°C.
2. 6.5 inches achievable with near LED (on the right when facing the front of the engine) on and far LED off.
3. Test bar codes with 2 internal LEDs flashing with 1.2A peak current, at ambient light of minimum 25 foot-candle in the plane of the bar code.
4. Mount reflective bar codes on white or black background with minimum 4” border. Luminance in the line-of-sight direction should be 50-120 cd/mm². Ensure there is no extraneous illumination or shadow on the bar code and that it is centered within the aiming pattern.
5. Reading criteria: 3 successful decodes out of 4 consecutive frames after setting autoexposure.
6. Provide a baffle if needed to prevent stray light from getting into the sensor fields of view.
7. Distances are measured from the front face of the scan engine chassis.
8. Near range may be closer with shorter bar codes.
9. Dependent on length of bar codes.
SE4750 Standard Range Imager Decode Zones

Figure A-8 show the decode zones for the SE47500-SR scan engine. The figures are typical values. Table A-9 lists the typical distances for selected bar code densities. The minimum element width (or “symbol density”) is the width in mils of the narrowest element (bar or space) in the symbol.

Note: Typical performance at 73°F (23°C) on high quality symbols in normal room light. Vcc = 3.3V

* Limited by width of bar code in field of view

Figure A-8  SE4750-SR Decode Zone
### Table A-9  SE4750-SR Decode Distances

<table>
<thead>
<tr>
<th>Symbology</th>
<th>Typical Working Range</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Near</td>
</tr>
<tr>
<td>3 mil Code 39</td>
<td>2.8 in.</td>
</tr>
<tr>
<td></td>
<td>7.1 cm</td>
</tr>
<tr>
<td>5 mil Code 128</td>
<td>2.3 in.</td>
</tr>
<tr>
<td></td>
<td>5.8 cm</td>
</tr>
<tr>
<td>5 mil PDF417</td>
<td>3.0 in.</td>
</tr>
<tr>
<td></td>
<td>7.6 cm</td>
</tr>
<tr>
<td>6.67mil PDF417</td>
<td>2.2 in.</td>
</tr>
<tr>
<td></td>
<td>5.6 cm</td>
</tr>
<tr>
<td>10 mil Data Matrix</td>
<td>2.4 in.</td>
</tr>
<tr>
<td></td>
<td>6.1 cm</td>
</tr>
<tr>
<td>100% UPCA</td>
<td>1.6* in.</td>
</tr>
<tr>
<td></td>
<td>4.1* cm</td>
</tr>
<tr>
<td>15 mil Code 128</td>
<td>2.4* in.</td>
</tr>
<tr>
<td></td>
<td>6.1* cm</td>
</tr>
<tr>
<td>20 mil Code 39</td>
<td>1.6* in.</td>
</tr>
<tr>
<td></td>
<td>4.1* cm</td>
</tr>
</tbody>
</table>

* Limited by width of bar code in field of view.

Note: Photographic quality bar code at 18° tilt pitch angle under 30 fcd ambient illumination.
SE4750 Mid-Range Imager Decode Zones

*Figure A-9* show the decode zones for the SE4750-MR scan engine. The figures are typical values. *Table A-10* lists the typical distances for selected bar code densities. The minimum element width (or "symbol density") is the width in mils of the narrowest element (bar or space) in the symbol.

Note: Typical performance at 73°F (23°C) on high quality symbols in normal room light.

\[ Vcc = 3.3V \]

*Figure A-9*  **SE4750-MR Decode Zone**
Table A-10  *SE4750-MR Decode Distances*

<table>
<thead>
<tr>
<th>Symbology</th>
<th>Typical Working Range</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Near</td>
</tr>
<tr>
<td>5 mil Code 128</td>
<td>7.4 in. 18.8 cm</td>
</tr>
<tr>
<td>5 mil PDF417</td>
<td>8.1 in. 20.6 cm</td>
</tr>
<tr>
<td>7.5 mil Data Matrix</td>
<td>8.3 in. 21.1 cm</td>
</tr>
<tr>
<td>10 mil Data Matrix</td>
<td>7.0 in. 17.8 cm</td>
</tr>
<tr>
<td>13 mil UPCA</td>
<td>2.3* in. 5.8* cm</td>
</tr>
<tr>
<td>15 mil Code 128</td>
<td>4.0* in. 10.2* cm</td>
</tr>
<tr>
<td>20 mil Code 39</td>
<td>2.1* in. 5.3* cm</td>
</tr>
<tr>
<td>100 mil Code 39</td>
<td>11.0 in. 27.9 cm</td>
</tr>
<tr>
<td>160 mil Data Matrix</td>
<td>11.5 in. 29.2 cm</td>
</tr>
</tbody>
</table>

* Limited by width of bar code in field of view.

*Note: Photographic quality bar code at 18° tilt pitch angle under 30 fcd ambient illumination.*
SE4850 Extended Range Imager Decode Zones

*Table A-11* lists the typical distances for selected bar code densities. The minimum element width (or "symbol density") is the width in mils of the narrowest element (bar or space) in the symbol.

<table>
<thead>
<tr>
<th>Symbology</th>
<th>Typical Working Range (inches/centimeters) @ 20 Ft-Cd Minimum</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Start</td>
</tr>
<tr>
<td>10 mil Code 39</td>
<td>3.0 in. 7.6 cm*</td>
</tr>
<tr>
<td>13 100% UPC</td>
<td>3.5 in. 8.9 cm</td>
</tr>
<tr>
<td>15 mil Code 128</td>
<td>6.0 in. 15.2 cm*</td>
</tr>
<tr>
<td>20 mil Code 39</td>
<td>4.0 in. 10.2 cm*</td>
</tr>
<tr>
<td>40 mil Code 39</td>
<td>6.0 in. 15.2 cm*</td>
</tr>
<tr>
<td>55 mil Code 39</td>
<td>7.0 in. 17.8 cm*</td>
</tr>
<tr>
<td>100 mil Code 39 (paper)</td>
<td>20.0 in. 50.8 cm*</td>
</tr>
<tr>
<td>100 mil Code 128 (reflective)</td>
<td>30.0 in. 76.2 cm*</td>
</tr>
<tr>
<td>DataMatrix 10</td>
<td>5.0 in. 12.7 cm</td>
</tr>
<tr>
<td>DataMatrix 55</td>
<td>5.0 in. 12.7 cm</td>
</tr>
<tr>
<td>15 mil Code 128 (4 in. wide)</td>
<td>8.0 in. 20.3 cm*</td>
</tr>
</tbody>
</table>

* Depends on the width of the bar code (shorter bar codes can be read even closer, and wider bar codes farther).

** Range is reduced under lower ambient light level.
# Mobile Computer Pin-Outs

![Diagram of mobile computer pin-out](image)

## Figure A-10  Pin Locations

## Table A-12  Pin-Outs

<table>
<thead>
<tr>
<th>PIN Number</th>
<th>Signal Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USB_GND</td>
<td>USB</td>
</tr>
<tr>
<td>2</td>
<td>USB_D_PLUS</td>
<td>USB</td>
</tr>
<tr>
<td>3</td>
<td>TXD</td>
<td>RS232C</td>
</tr>
<tr>
<td>4</td>
<td>RXD</td>
<td>RS232C</td>
</tr>
<tr>
<td>5</td>
<td>DCD</td>
<td>RS232C</td>
</tr>
<tr>
<td>6</td>
<td>RTS</td>
<td>RS232C</td>
</tr>
<tr>
<td>7</td>
<td>DSR</td>
<td>RS232C</td>
</tr>
<tr>
<td>8</td>
<td>GND</td>
<td>Ground, 2.5A max.</td>
</tr>
<tr>
<td>9</td>
<td>RI</td>
<td>RS232C</td>
</tr>
<tr>
<td>10</td>
<td>CRADLE_DET</td>
<td>Grounded by cradle when in cradle</td>
</tr>
<tr>
<td>11</td>
<td>DTR</td>
<td>RS232C</td>
</tr>
<tr>
<td>12</td>
<td>Not connected</td>
<td>Not connected</td>
</tr>
<tr>
<td>13</td>
<td>POWER_IN</td>
<td>12V, 2.5A max</td>
</tr>
<tr>
<td>14</td>
<td>CTS</td>
<td>RS232C</td>
</tr>
<tr>
<td>15</td>
<td>USB_5V_DET</td>
<td>USB</td>
</tr>
<tr>
<td>16</td>
<td>USB_D_MINUS</td>
<td>USB</td>
</tr>
<tr>
<td>17</td>
<td>EXT_PWR_OUT</td>
<td>3.3V @500mA</td>
</tr>
</tbody>
</table>
Accessory Specifications

Single Slot Serial/USB Cradle

Table A-13  Single Slot Serial/USB Cradle Technical Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions</td>
<td>Height: 13.02 cm (5.13 in.)</td>
</tr>
<tr>
<td></td>
<td>Width: 15.24 cm (6.0 in.)</td>
</tr>
<tr>
<td></td>
<td>Depth: 15.24 cm (6.0 in.)</td>
</tr>
<tr>
<td>Input Power</td>
<td>12 VDC</td>
</tr>
<tr>
<td>Interface</td>
<td>Serial and USB</td>
</tr>
<tr>
<td>Operating Temperature</td>
<td>0°C to 50°C (-13°F to 122°F)</td>
</tr>
<tr>
<td>Storage Temperature</td>
<td>-40°C to 70°C (-40°F to 158°F)</td>
</tr>
<tr>
<td>Charging Temperature</td>
<td>0°C to 40°C (32°F to 104°F)</td>
</tr>
<tr>
<td>Humidity</td>
<td>5% to 95% non-condensing</td>
</tr>
<tr>
<td>Drop</td>
<td>76.2 cm (30.0 in.) drops to vinyl tiled concrete at room temperature</td>
</tr>
<tr>
<td>Electrostatic Discharge (ESD)</td>
<td>+/- 15 kV air</td>
</tr>
<tr>
<td></td>
<td>+/- 8 kV contact</td>
</tr>
</tbody>
</table>

Four Slot Ethernet Cradle

Table A-14  Four Slot Ethernet Cradle Technical Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions</td>
<td>Height: 10.16 cm (4.0 in.)</td>
</tr>
<tr>
<td></td>
<td>Width: 48.77 cm (19.00 in.)</td>
</tr>
<tr>
<td></td>
<td>Depth: 15.24 cm (6.0 in.)</td>
</tr>
<tr>
<td>Input Power</td>
<td>12 VDC</td>
</tr>
<tr>
<td>Interface</td>
<td>Ethernet</td>
</tr>
<tr>
<td>Operating Temperature</td>
<td>0°C to 50°C (-13°F to 122°F)</td>
</tr>
<tr>
<td>Storage Temperature</td>
<td>-40°C to 70°C (-40°F to 158°F)</td>
</tr>
<tr>
<td>Charging Temperature</td>
<td>0°C to 40°C (32°F to 104°F)</td>
</tr>
</tbody>
</table>
Four Slot Charge Only Cradle

Table A-15  Four Slot Charge Only Cradle Technical Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| Dimensions                       | Height: 10.16 cm (4.0 in.)  
                                      | Width: 48.77 cm (19.00 in.)  
                                      | Depth: 15.24 cm (6.0 in.)       |
| Input Power                      | 12 VDC                                                                      |
| Operating Temperature            | 0°C to 50°C (-13°F to 122°F)                                                |
| Storage Temperature              | -40°C to 70°C (-40°F to 158°F)                                              |
| Charging Temperature             | 0°C to 40°C (32°F to 104°F)                                                 |
| Humidity                         | 5% to 95% non-condensing                                                    |
| Drop                             | 76.2 cm (30.0 in.) drops to vinyl tiled concrete at room temperature        |
| Electrostatic Discharge (ESD)    | +/- 15 kV air  
                                      | +/- 8 kV contact                                                            |

Four Slot Battery Charger

Table A-16  Four Slot Battery Charger Technical Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| Dimensions                       | Height: 10.16 cm (4.0 in.)  
                                      | Width: 15.24 cm (6.0 in.)  
                                      | Depth: 15.24 cm (6.0 in.)       |
| Input Power                      | 12 VDC                                                                      |
| Operating Temperature            | 0°C to 45°C (32°F to 113°F)                                                |
| Storage Temperature              | -40°C to 70°C (-40°F to 158°F)                                              |
| Charging Temperature             | 0°C to 40°C (32°F to 104°F)                                                 |
Table A-16  Four Slot Battery Charger Technical Specifications (Continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Humidity</td>
<td>5% to 95% non-condensing</td>
</tr>
<tr>
<td>Drop</td>
<td>76.2 cm (30.0 in.) drops to vinyl tiled concrete at room temperature</td>
</tr>
<tr>
<td>Electrostatic Discharge (ESD)</td>
<td>+/- 15 kV air</td>
</tr>
<tr>
<td></td>
<td>+/- 8 kV contact</td>
</tr>
</tbody>
</table>

Magnetic Stripe Reader

Table A-17  Magnetic Stripe Reader (MSR) Technical Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>Serial with baud rate up to 19,200</td>
</tr>
<tr>
<td>Format</td>
<td>ANSI, ISO, AAMVA, CA DMV, user-configurable generic format</td>
</tr>
<tr>
<td>Swipe Speed</td>
<td>5 to 50 in. (127 to 1270 mm) /sec, bi-directional</td>
</tr>
<tr>
<td>Decoders</td>
<td>Generic, Raw Data</td>
</tr>
<tr>
<td>Mode</td>
<td>Buffered, unbuffered</td>
</tr>
<tr>
<td>Track Reading Capabilities</td>
<td>Tracks 1 and 3: 210 bpi</td>
</tr>
<tr>
<td></td>
<td>Track 2: 75 and 210 bpi, autodetect</td>
</tr>
<tr>
<td>Operating Temperature</td>
<td>-25°C to 50°C (-13°F to 122°F)</td>
</tr>
<tr>
<td>Storage Temperature</td>
<td>-40°C to 70°C (-40°F to 158°F)</td>
</tr>
<tr>
<td>Humidity</td>
<td>5% to 95% non-condensing</td>
</tr>
<tr>
<td>Drop</td>
<td>1.22 m (4 ft.) drops to concrete</td>
</tr>
<tr>
<td>Electrostatic Discharge (ESD)</td>
<td>+/- 15 kV air</td>
</tr>
<tr>
<td></td>
<td>+/- 8 kV contact</td>
</tr>
</tbody>
</table>

Vehicle Cradle

Table A-18  Vehicle Cradle Technical Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Power</td>
<td>12 and 24 VDC</td>
</tr>
<tr>
<td>Operating Temperature</td>
<td>-25°C to 50°C (-13°F to 122°F)</td>
</tr>
<tr>
<td>Storage Temperature</td>
<td>-40°C to 70°C (-40°F to 158°F)</td>
</tr>
<tr>
<td>Charging Temperature</td>
<td>0°C to 40°C (32°F to 104°F)</td>
</tr>
</tbody>
</table>
Table A-18  Vehicle Cradle Technical Specifications (Continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Humidity</td>
<td>10% to 95% non-condensing</td>
</tr>
<tr>
<td>Drop</td>
<td>76.2 cm (30.0 in.) drops to vinyl tiled concrete at room temperature</td>
</tr>
<tr>
<td>Electrostatic Discharge (ESD)</td>
<td>+/- 15 kV air</td>
</tr>
<tr>
<td></td>
<td>+/- 8 kV contact</td>
</tr>
</tbody>
</table>

Accessory CAM and MSR Pin-Outs

Figure A-11  CAM and MSR Serial Connector

Table A-19  CAM and MSR Serial Connector Pin-outs

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USB_5V_DET</td>
</tr>
<tr>
<td>2</td>
<td>USB_D_MINUS</td>
</tr>
<tr>
<td>3</td>
<td>USB_D_PLUS</td>
</tr>
<tr>
<td>4</td>
<td>GND</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
</tr>
<tr>
<td>6</td>
<td>PWR_EXT_OUT</td>
</tr>
<tr>
<td>7</td>
<td>CRADLE_DET*</td>
</tr>
<tr>
<td>8</td>
<td>DSR</td>
</tr>
<tr>
<td>9</td>
<td>DCD</td>
</tr>
<tr>
<td>10</td>
<td>TXD</td>
</tr>
<tr>
<td>11</td>
<td>CTS</td>
</tr>
<tr>
<td>12</td>
<td>DTR</td>
</tr>
<tr>
<td>13</td>
<td>RI</td>
</tr>
<tr>
<td>14</td>
<td>RTS</td>
</tr>
<tr>
<td>15</td>
<td>RXD</td>
</tr>
</tbody>
</table>
APPENDIX B  USING iDOCKIT

Introduction

iDockIt™ manages activities that can occur when the MC92N0-G is connected to a host computer using a cradle (Ethernet, modem, serial or USB) or a USB or a serial cable. iDockIt can enable the MC92N0-G to connect automatically to a host computer, network, or the Internet and then exchange information or launch an application. Use iDockIt to configure settings for each type of connection.

This appendix provides information for configuring iDockIt on an MC92N0-G running Windows Embedded Handheld or Windows CE.

General options include:

- enabling or disabling iDockIt; if enabled, keeps iDockIt running in the background.
- displaying status and cradle settings the MC92N0-G is placed in a cradle.
- defining whether iDockIt should wait before connecting or reconnecting the MC92N0-G to the host computer or network and if waiting, the number of seconds to delay.
- disabling specific error messages.

Connection-specific options include:

- launching Microsoft ActiveSync to synchronize with a host computer.
- establishing a connection to a network.
- launching an application after establishing a network connection.
- establishing a connection via a specified modem.

NOTE iDockIt settings and options control cradle events only while iDockIt is running.

Do not use ActiveSync 4.5 or later to synchronize data between a host computer and a Windows CE based device through an Ethernet cradle.
General Recommendations

The MC92N0-G should not be placed in a cradle or connected when the host computer to which it is physically connected is started or restarted. If the MC92N0-G is cradled when the host computer is started or restarted, the MC92N0-G attempts to connect before ActiveSync has fully loaded and a proper connection is impossible. Follow these general guidelines for avoiding connection problems:

- Connect only one MC92N0-G to the host computer at a time. (More than one serial cable/cradle or USB cable/cradle can be connected simultaneously.)
- When starting or restarting the host computer, wait for the start process to finish completely before placing the MC92N0-G in a cradle. When cradled, it is able to make the connection defined in iDockIt settings.
- If the MC92N0-G was connected to the host computer when the host computer was started, remove the MC92N0-G from the cradle, restart the host computer, and then return the MC92N0-G to the cradle.
- Performing a warm boot on the MC92N0-G can be useful. Remove the MC92N0-G from the cradle before performing a warm boot. Restart iDockIt and then recradle the MC92N0-G.
- For additional information, refer to Microsoft ActiveSync Help on your host computer.

Prepare the MC92N0-G To Connect

When using Microsoft ActiveSync, first establish a partnership between the MC92N0-G and the host computer. This should occur the first time the MC92N0-G is placed in a cradle. If using an Ethernet cradle, first set up the partnership with the host computer using a serial or USB cable or cradle.

Enable iDockIt To Manage Connections Automatically

To connect automatically to a host computer or network:

1. Check Enable iDockIt.
2. Check or uncheck Display status when cradled.
3. Check or uncheck Display settings when cradled.
4. Check or uncheck Autoconnect.
5. Tap the iDockIt tab (Ethernet, Direct or Modem) that corresponds to the cradle type.
6. Check Establish network connection and optionally Launch application.

Enable iDockIt To Manage Connections Manually

To connect manually to a host computer or network:

1. Check Enable iDockIt.
2. Check or uncheck Display status when cradled.
3. Check Display settings when cradled. When the MC92N0-G is placed in the cradle, the Settings tab displays automatically.
4. Uncheck Autoconnect.
5. Tap the iDockIt tab (Ethernet, Direct or Modem) that corresponds to the cradle type.
6. Check **Establish network connection** and optionally **Launch application**.

When the MC92N0-G is placed in a cradle, iDockIt displays the settings tab corresponding to that cradle. Choose the type of connection and tap "". Alternately, establish a new connection settings before placing the MC92N0-G in the cradle.

**Launch Application Upon Connection**

To launch an application when connected:

1. Check **Enable iDockIt**.
2. Tap the tab (**Ethernet**, **Direct** or **Modem**) that corresponds to the type of cradle.
3. Select a connection option as described above.
4. Tap **Launch application**.
5. Tap **Select** and select the application to launch when the MC92N0-G is placed in the cradle. Enter any necessary program arguments.
6. Tap **OK**. The selected application appears in the text box.

**View Connection Status**

To determine the connection status, tap the **Status** tab. See *Status Tab on page B-17*.

**Minimize iDockIt**

To minimize iDockIt, tap **X**. iDockIt controls cradle events while minimized.

**Exit iDockIt**

To close the application, tap **Menu > Exit**. iDockIt does not control cradle events when closed.
Windows Embedded Handheld Configuration

General Tab

Settings on the General tab complement the options set for the cradle.

- **Enable iDockIt** - Enables iDockIt to control cradle events. When the MC92N0-G is placed in a cradle, iDockIt identifies the type of cradle and perform the activities configured.

- **Autostart** - Enables iDockIt to start automatically when the MC92N0-G is rebooted.

- **Display status when cradled** - Displays the iDockIt Status tab when the MC92N0-G is placed in the cradle. If **Display settings when cradled** is selected, the settings tab for the type of cradle detected displays and then the Status tab displays after the specified time elapses.

- **Display settings when cradled** - Displays the cradle settings tab when the MC92N0-G is placed in the cradle.

- **Auto connect after x seconds** - to automatically make the connection defined on the cradle tab after a specific delay. The delay provides the opportunity to review or change connection options. During this waiting period, you can select either **Menu > Connect** or **Menu > Cancel** to connect immediately or cancel automatic connection.

  **CAUTION** If **Display settings when cradled** is selected and **Auto connect after** is not selected, iDockIt only displays the cradle settings tab when the MC92N0-G is placed in a cradle and does not attempt to connect to the network.

- **Reconnect delay** - Specifies the number of seconds iDockIt waits after a connection is lost before attempting to reconnect.

- **USB Function** - When placed into a USB cradle, iDockIt needs to know whether the cradle directly connects to a host computer or if the cradle connects to a network via an Ethernet cable. If using iDockIt to synchronize with a host computer using ActiveSync via USB cable or cradle, select **RNDIS**. If using iDockIt to connect to a network though an Ethernet cradle, select **Serial**. Option are Default, iDockIt, RNDIS and Serial.

- **Ports to monitor** - If RS232 is check, iDockIt monitors the serial ports for direct or modem connection. If USB is checked iDockIt monitors USB connections.
• **Auto-dismiss dialogs** - Configure iDockIt to dismiss several error messages that might be displayed as iDockIt makes the connection. These messages do not require any action. To auto-dismiss a message, tap the checkbox next to its title. If the message occurs during a connection attempt, iDockIt allows it and the event appears in the Status window.

• **Cannot Connect** - The answering modem has disconnected. To check your connection settings and change them if needed, tap Settings.
  
  This message may be displayed when the MC92N0-G is removed from a cradle, breaking the connection. Tapping Settings would display the Pocket host computer Connections dialog. Since you should not need to change these settings, the error message can be dismissed automatically.

• **Communications Error** - Cannot start communications with the desktop computer. Reconnect the MC92N0-G. If the problem persists, see Microsoft ActiveSync Help.
  
  This message is displayed when ActiveSync attempts to connect to a host computer and synchronize data but cannot find the computer name. Since this message may appear in the course of a successful connection attempt, it can be dismissed automatically.

• **Pocket PC Networking** - Unable to obtain a server-assigned IP address. Try again later or enter an IP address in Network settings.
  
  This dialog may appear periodically when the MC92N0-G is out of network range. The message has nothing to do with the connection through a cradle or cable and can therefore be dismissed automatically.

### Ethernet Tab

If using an Ethernet cradle, you can establish an Internet or Intranet connection to a network and/or launch a specified application on the MC92N0-G.

> **NOTE** Do not use ActiveSync 4.5 or later to synchronize data between a host computer and a Windows Mobile based device through an Ethernet cradle.

![Ethernet Settings Tab](image)

**Figure B-2 Ethernet Settings Tab**

- **Establish network connection to** - Establishes a network connection when the MC92N0-G is placed in the cradle.
  
  Select this option in conjunction with Launch application. After iDockIt establishes the network connection, it launches the specified application.

- **Launch application** - Launches the selected application when the MC92N0-G is placed in the cradle. iDockIt uses the specified command line parameters.
1. Tap **Select** to open the **Select Auto-Launch Application** window.

2. Select a File Type in the drop-down list.

3. Select a folder (as needed).

4. Select a file name in the list.

5. In the **Program arguments** field, enter command line parameters.

6. Tap **OK**.

The selected application appears in the text box.

- **Redirect wireless LAN** - When checked, iDockIt ensures that any existing wireless connection is redirected so that it does not conflict with iDockIt settings.
  
  If iDockIt is configured for a Work connection and the wireless LAN is also configured for Work, iDockIt switches the wireless LAN to The Internet and vice versa.

- **Detect serial to ethernet cradle** - This option is not used.

- **Serial cradle baud rate** - Specifies the baud rate iDockIt should use for a serial connection to the Ethernet cradle. Set this rate to match the baud rate configured for the cradle. For maximum performance, always use the maximum baud rate of 115200.
  
  If using a USB-to-Ethernet cradle, the USB driver automatically determines the connection speed.

**Direct Tab**

If using a serial or USB cradle or connect to the MC92N0-G with a serial or USB cable, automatically synchronize with the connected host computer. Alternatively, if the host computer supports RAS connections, connect to a network through a host computer and/or launch a specified application on the MC92N0-G.

- **Launch ActiveSync** - Launches ActiveSync when the MC92N0-G is placed in a serial or USB cradle or when connected to a serial or USB cable. If the MC92N0-G has a partnership with the host computer, ActiveSync automatically synchronizes with the host computer.

  **NOTE** Selecting this option automatically deselects **Establish network connection to** and **Launch application**.

  Similarly, selecting **Establish network connection to** or **Launch application** automatically deselects **Launch ActiveSync**.
• **Establish network connection to** - Establishes a connection to a network when the MC92N0-G is placed in a serial or USB cradle or connected to a serial or USB cable. In order to establish a connection to the network, connect the MC92N0-G to a host computer with a RAS server.

Selecting this option, automatically deselects **Launch ActiveSync**.

Select this option in conjunction with **Launch application**. After iDockIt establishes the network connection, it launches the specified application.

• **Launch application** - Launches the selected application when the MC92N0-G is placed in a serial or USB cradle or connected to a serial or USB cable. iDockIt uses the specified command line parameters. Select an application to launch.

1. Tap **Select** to open the **Select Auto-Launch Application** window.
2. Select a File Type in the drop-down list.
3. Select a folder (as needed).
4. Select a file name in the list.
5. In the **Program arguments** field, enter command line parameters.
6. Tap **OK**.

The selected application appears in the text box.

• **Serial cradle baud rate** - Specify the baud rate iDockIt should use for a serial cable or cradle. Set this rate to match the host computer that the cradle or cable is connected to.

If using a USB cradle or cable, the USB driver automatically determines the connection speed.

**Modem Tab**

If using a modem cradle, automatically connect to a remote host computer or network or you can synchronize with a host computer with which you have set up a partnership using ActiveSync. Alternatively, connect to the network and/or launch a specified application on the MC92N0-G.

• **Use advanced modem detection** - Check this option to have iDockIt perform a more thorough modem detection check. This may be necessary if using an external modem connected via serial cable. Normally, iDockIt only performs a modem detection check if it detects that the MC92N0-G has been placed in a cradle.
When this option is checked, iDockIt continuously checks for the presence of a modem. In order for this option to take effect, check **RS232** checked under **Ports to monitor** on the **General** settings tab.

- **Launch ActiveSync** - Launches ActiveSync when the MC92N0-G is placed in a modem cradle.

  **NOTE** Selecting this option automatically deselects **Establish network connection to** and **Launch application**. Similarly, selecting **Establish network connection to** or **Launch application** automatically deselects **Launch ActiveSync**.

- **Establish network connection to** - Establishes a network connection when the MC92N0-G is placed in a modem cradle. iDockIt uses the modem connection specified in the **Connect using** list.

Selecting this option, automatically deselects **Launch ActiveSync**.

Select this option in conjunction with **Launch application**. After iDockIt establishes the network connection, it launches the specified application.

- **Launch application** - Launches the selected application when the MC92N0-G is placed in a modem cradle. iDockIt uses the specified command line parameters. You must select an application to launch. If **Establish network connection to** is selected, the application does not launch until a connection is successfully established.

  1. Tap **Select** to open the **Select Auto-Launch Application** window.
  2. Select a File Type in the drop-down list.
  3. Select a folder (as needed).
  4. Select a file name in the list.
  5. In the **Program arguments** field, enter command line parameters.
  6. Tap **OK**.

The selected application appears in the text box.

- **Connect using** - Select a connect type from the drop-down list.

  If you check the **General** settings options to **Display settings when cradled** and **Auto-connect after**, you have an opportunity to select the appropriate modem connection when you cradle the MC92N0-G.

  If you do not check the two options, iDockIt uses the last modem connection selected.

- **New** - Create a new modem connection.
- **Edit** - Change the settings of an existing modem connection.
- **Delete** - Delete the currently displayed modem connection.

- **Redirect wireless LAN** - Need info.

**Create A New Modem Connection**

1. Obtain the following information from the ISP or network administrator:
   - dial-up access telephone number
   - user name
   - password
   - domain name
   - TCP/IP settings.

2. Tap **New**.
3. Enter a name for the connection.

4. In the Modem drop-down list, select the modem type. For the modem cradle, select Hayes Compatible on COM1.

5. Tap Configure and change any Port Settings in the Device Properties window, depending on requirements for the modem.

6. Tap OK.

7. Tap Next.

8. Enter the country code, area code and phone number and then tap Next.

9. Enter login information (user name, password, and domain name) and then tap Next.

10. Do not change any TCP/IP settings unless directed by your ISP or network administrator. Tap Next and then tap Finish. The new modem connection appears in the drop-down list.

**Edit an Existing Modem Connection**

1. In the Connect using drop-down list, select the modem connection to modify.

2. Tap Edit.

3. In the Connection Properties window, make any necessary changes to the connection name, modem, or modem configuration options and then tap Next.

4. Change the country code, area code and phone number and then tap Next.

5. Change the login information and then tap Next.

6. Do not change any TCP/IP settings unless directed by your ISP or network administrator. Tap Next and then tap Finish.

**Delete an Existing Modem Connection**

1. In the Connect using drop-down list, select the modem connection to delete.

2. Tap and hold the Connect using box until the pop-up menu displays.

3. Select Delete from the pop-up menu.

4. Tap Yes. The modem connection is removed from the drop-down list.

**Status Tab**

The Status tab displays connection-related events as they occur. Check Display status when cradled on the General tab to display this tab automatically whenever the MC92N0-G is placed in a cradle.
• **Dock Status** - Indicates **Docked** and the type of connection (Serial, Ethernet or USB) when the MC92N0-G is cradled or **Not docked** when the MC92N0-G is removed from the cradle.

• **Connection** - Displays the name of the connection.

• **IP Addresses** - Displays all valid IP addresses assigned to the MC92N0-G. When the MC92N0-G is not cradled, displays either the IP address of the network adapter or, if no network connection, a default IP address.

• **Status window** - Displays a scrolling list of cradle events as they occur, including:
  • **AC power ON** and **AC power OFF** when the MC92N0-G is inserted and removed.
  • **Carrier detect**, **baud rate**, and **(cradle type) connect** when iDockIt identifies the cradle and connection speed.
  • **Launch (application)** when iDockIt launches the selected application, followed by confirmation when the application has been launched successfully.
  • **Sync done** when synchronization has completed successfully.
  • **Dismiss (error message)** when iDockIt dismisses a message you have designated.
  • **Dock event complete** when iDockIt has completed all defined tasks. If the MC92N0-G is removed from the cradle before this item appears, regardless of dock status, you may interrupt assigned tasks.

Tap **Clear** to delete all events from the status window.
Windows CE Configuration

General Tab

Settings on the General tab complement the options set for the cradle.

- **Enable iDockIt** - Enables iDockIt to control cradle events. When the MC92N0-G is placed in a cradle, iDockIt identifies the type of cradle and perform the activities configured. Uncheck this option to restore control of cradle events to Microsoft ActiveSync.

- **Display status when cradled** - Displays the iDockIt Status tab when the MC92N0-G is placed in the cradle. If you also checked **Display settings when cradled**, you first see the Settings tab for the type of cradle detected and then the Status tab after the specified time elapses. Uncheck this option to prevent display of the iDockIt Status tab.

- **Display settings when cradled** - Displays the cradle settings tab when the MC92N0-G is placed in the cradle.

- **Auto connect after x seconds** - to have iDockIt wait a specified time before creating a connection. The delay provides the opportunity to review or change cradle settings. During this waiting period, select either ☑️ or ☐️ in the menu bar to connect immediately or cancel automatic connection.

- **Reconnect delay** - This feature has not been implemented.

- **USB COM port** - The first time running iDockIt, the application attempts to determine whether the MC92N0-G has a USB port and if so, the COM port to which it is mapped.

  If iDockIt does not find a USB port, **None** displays. Choose from all available COM ports in the list. In most cases, this setting does not have to be changed.

- **Auto-dismiss dialogs** - Configure iDockIt to dismiss several error messages that might be displayed as iDockIt makes the connection. These messages do not require any action. To auto-dismiss a message, tap ☑️ or ☐️.
the checkbox next to its title. If the message occurs during a connection attempt, iDockIt allows it and the event appears in the Status window.

- **Port Disconnected** - Cannot start communications with the desktop computer. The connection was terminated.
  
  This message displays when the MC92N0-G is removed from a cradle, breaking the connection. Since this is not really an error, the message can be dismissed automatically.

- **Communications Error** - Cannot start communications with the desktop computer. The computer is either not available or busy and currently cannot accept connections.
  
  This message displays when ActiveSync attempts to connect to a host computer and synchronize data but cannot find the computer name. Since this message may appear in the course of a successful connection attempt, it can be dismissed automatically.

### Ethernet Tab

If using an Ethernet cradle, automatically connect to and sync with a partnered host computer on the network. Alternatively, establish a generic connection to the network and/or launch a specified application on the MC92N0-G.

![Figure B-7 Ethernet Tab](image)

- **Launch ActiveSync** - Launches ActiveSync when the MC92N0-G is placed in the cradle. ActiveSync connects to the host computer specified in the **Sync with** option on the network.

  **NOTE** Before selecting this option, connect to the host computer with a serial or USB cable or cradle and use ActiveSync to set up a partnership with that host computer.

  Selecting this option automatically deselects **Establish network connection to** and **Launch application**. Similarly, selecting **Establish network connection to** or **Launch application** automatically deselects **Launch ActiveSync**.

- **Sync with** - Selects the host computer with which to ActiveSync. The MC92N0-G can have partnerships with up to two host computers. The drop-down list displays only the host computers with which the MC92N0-G has a partnership.
• **Disconnect after sync** - Sets the MC92N0-G to automatically disconnect from the selected host computer when ActiveSync completes synchronization.

• **Establish network connection** - Establishes a connection to the network when the MC92N0-G is placed in a cradle.
  Selecting this option, automatically deselects **Launch ActiveSync**.
  Select this option in conjunction with **Launch application**. After iDockIt establishes the network connection, it launches the specified application.

• **Launch application** - Launches the selected application when the MC92N0-G is placed in the cradle.
  iDockIt uses the specified command line parameters.
  Selecting this option, automatically deselects **Launch ActiveSync**.

  1. Tap **Select** to open the **Select Auto-Launch Application** window.
  2. Select a File Type in the drop-down list.
  3. Select a folder (as needed).
  4. Select a file name in the list.
  5. In the **Program arguments** field, enter command line parameters.
  6. Tap **OK**.
  The selected application appears in the text box.

• **Serial port baud rate** - Specifies the baud rate iDockIt uses for a serial connection to the Ethernet cradle.
  Set this rate to match the baud rate configured for the cradle. For maximum performance, always use the maximum baud rate of 115200.
  If using a USB-to-Ethernet cradle, the USB driver automatically controls the connection speed.

**Direct Tab**

If using a serial or USB cradle or a serial or USB cable, automatically connect to the connected host computer or network or choose a host computer with which to have set up a partnership using ActiveSync. Alternatively, if the host computer supports RAS connections, connect to the network through a host computer and/or launch a specified application on the MC92N0-G.
• **Launch ActiveSync** - Launches ActiveSync when the MC92N0-G is placed in a serial or USB cradle or when connected it to a serial or USB cable.

  **NOTE** Selecting this option automatically deselects **Establish network connection to** and **Launch application**. Similarly, selecting **Establish network connection to** or **Launch application** automatically deselects **Launch ActiveSync**.

• **Sync with** - When this option is not checked, the MC92N0-G synchronizes data with the host computer to which it is connected. To synchronize with a different host computer, check this option and select the host computer in the list. ActiveSync is able to connect to this alternate host computer automatically only if you check this option.

• **Disconnect after sync** - Disconnect automatically from the host computer when ActiveSync has completed synchronization.

• **Establish network connection to** - Establishes a connection to the network when the MC92N0-G is placed in a serial or USB cradle or connected to a serial or USB cable. In order to establish a connection to the network, connect the MC92N0-G to a host computer with a RAS server. If ActiveSync is running on a host computer, it can be used as a RAS server.

  Selecting this option, automatically deselects **Launch ActiveSync**.

  Selecting this option in conjunction with **Launch application**. After iDockIt establishes the network connection, it launches the specified application.

• **Launch application** - Launches the selected application when you place the MC92N0-G in a serial or USB cradle or connect it to a serial or USB cable. iDockIt uses the specified command line parameters. You must select an application to launch.

  1. Tap **Select** to open the **Select Auto-Launch Application** dialog.
  2. Select a **File Type** in the drop-down list.
  3. Select a **Folder** (as needed).
  4. Select a file name in the list.
  5. Use the input panel to specify command line parameters.
  6. Tap **OK** at the top of the screen.

  The selected application appears in the settings tab.

• **Serial port baud rate** - Specifies the baud rate iDockIt should use for a serial cable or cradle. Set this rate to match the host computer that the cradle or cable is connected to.

  If using a USB cradle or cable, the USB driver automatically controls the connection speed.

**USB Notes**

The InVision USB cradle driver for the host computer maps the USB port to a virtual COM port, assigning it the next available port number. Refer to the user guide for your cradle.

Before installing the driver, open ActiveSync Connection Settings to see which ports are available. After installing the driver, a new COM port is available. Select this port for your USB cradle.

Check **Allow USB**... in ActiveSync Connection Settings only if you have a direct USB connection (no cradle) to the MC92N0-G.
If the host computer or ActiveSync is reset, the port selection may revert to COM1. Open **Connection Settings** and re-select the correct USB COM port.

**Modem Tab**

If using a modem cradle, you can automatically connect to a remote host computer or network or you can choose a host computer with which you have set up a partnership using ActiveSync. Alternatively, you can connect to your network and/or launch a specified application on the MC92N0-G.

![Modem Settings Tab](image)

**Figure B-9** Modem Settings Tab

- **Launch ActiveSync** - Launch ActiveSync when the MC92N0-G is placed in a modem cradle.

  ![Checked](image)

  **NOTE** Selecting this option automatically deselects **Establish network connection** and **Launch application**. Similarly, selecting **Establish network connection** or **Launch application** automatically deselects **Launch ActiveSync**.

- **Sync with** - Synchronizes data with the host computer that is directly connected to the remote modem. To synchronize with a different host computer, check this option and select the host computer in the list.

- **Disconnect after sync** - Disconnect automatically from the selected host computer when ActiveSync has completed synchronization.

- **Establish network connection** - Establish a network connection when the MC92N0-G is placed in a modem cradle. iDockIt uses the modem connection specified in the **Connect using** drop-down list.

  Selecting this option automatically deselected **Launch ActiveSync**.

  You can check this option in conjunction with **Launch application**. After iDockIt establishes the network connection, it launches the specified application.

- **Launch application** - Launch the selected application when the MC92N0-G is placed in a modem cradle. iDockIt uses the specified command line parameters.

  If **Establish network connection** is checked the application does not be launched until a connection is successfully established.

  1. Tap **Select** to open the **Select Auto-Launch Application** window.

  2. Select a File Type in the drop-down list.

  3. Select a folder (as needed).

  4. Use the input panel to specify command line parameters.
5. Select a file name in the list.

6. Tap OK at the top of the screen.
   The selected application appears in the text box.
   
   - **Connect using** - Lists all modem connections that have been defined.

If you check the General settings options to **Display settings when cradled** and **Auto-connect after x seconds**, you have an opportunity to select the appropriate modem connection when you place the MC92N0-G in the cradle.

If you do not check the above options, iDockIt uses the last modem connection you selected.

Tap **New** to create a new modem connection.

Tap **Edit** to change the settings of an existing modem connection.

Tap **Delete** to delete the currently displayed modem connection.

**Create A New Modem Connection**

1. Get the following information from your ISP or network administrator: dial-up access telephone number, user name, password, domain name, and TCP/IP settings.

2. Tap **New** below the **Connect using** list.

3. In the Connection Properties dialog, enter a name for the connection.

4. In the Modem list, tap your modem type. For the modem cradle, tap **Hayes Compatible on COM1**.

5. Tap **Configure** and change any Port Settings or Call Options in the Device Properties dialog, depending on requirements for your modem.

6. Tap **Next** after entering the connection name and choosing a modem.

7. Enter the access phone number and then tap **Next**.

8. Enter Login information (user name, password, and domain name) and then tap **Next**.

9. You should not need to change any TCP/IP settings unless directed by your ISP or network administrator. Tap **Next** and then tap **Finish** in the next server address dialog.

The new modem connection is in the drop-down list.

**Edit An Existing Modem Connection**

1. In the **Connect using** list, select the modem connection you need to modify.

2. Tap **Edit**.

3. In the Connection Properties dialog, make any necessary changes to the connection name, modem, or modem configuration options. Tap **Next** to continue or **OK** to close the dialog.

4. If you continue, you can change the access phone number. Tap **Next** to continue or **OK** to close the dialog.

5. If you continue, you can change your login information. If you need to make any TCP IP setting changes, tap **Next**. Otherwise, tap **OK** to close the dialog.
Delete An Existing Modem Connection

1. In the **Connect using** list, select the modem connection you want to delete.

2. Tap **Delete**.

3. The Modem Settings dialog asks you to confirm that you want to delete the named modem connection. Tap **Yes**.

The modem connection is removed from the drop-down list.

**Status Tab**

The **Status** tab displays connection-related events as they occur. Check **Display status when cradled** on the **General** tab to display this tab automatically whenever the MC92N0-G is placed in a cradle.

- **Dock Status** - Indicates **Docked** and the type of connection (Serial, Ethernet or USB) when the MC92N0-G is cradled or **Not docked** when the MC92N0-G is removed from the cradle.

- **Connection** - Displays the name of the connection.

- **IP Addresses** - Displays all valid IP addresses assigned to the MC92N0-G. When the MC92N0-G is not cradled, displays either the IP address of the network adapter or, if no network connection, a default IP address.

- **Status window** - Displays a scrolling list of cradle events as they occur, including:
  - **AC power ON** and **AC power OFF** when the MC92N0-G is inserted and removed.
  - **Carrier detect**, **baud rate**, and **(cradle type) connect** when iDockIt identifies the cradle and connection speed.
  - **Launch (application)** when iDockIt launches the selected application, followed by confirmation when the application has been launched successfully.
  - **Sync done** when synchronization has completed successfully.
  - **Dismiss (error message)** when iDockIt dismisses a message you have designated.
  - **Dock event complete** when iDockIt has completed all defined tasks. If the MC92N0-G is removed from the cradle before this item appears, regardless of dock status, you may interrupt assigned tasks.

Tap **Clear** to empty all events from the Status window.
Un-installing iDockIt

On Windows Embedded Handheld devices:

1. Exit iDockIt.
2. In the System tab, tap the Remove Programs icon.
3. Select InVision iDockIt in the program list.
4. Tap Remove and select Yes in the Remove Program dialog.
5. Tap OK.

On Windows CE devices:

1. Exit iDockIt.
2. Tap Start > Settings and double-tap the Remove Programs icon.
3. Select InVision iDockIt in the program list.
4. Tap Remove and select Yes in the Remove Program dialog.
5. Ignore the Remove Programs Error dialog if it appears. Tap OK.
6. Close the Remove Programs dialog and Settings windows.
Bluetooth Configuration Setting

The MC92N0-G supports both the Microsoft Bluetooth stack and the StoneStreet One Bluetooth stack. Only one Bluetooth stack can be used at a time. By default, the Microsoft Bluetooth stack is enabled. A registry key on the MC92N0-G can be modified to disable the Microsoft stack and enable the StoneStreet One stack.

Using a registry editor, navigate to the following:

[HKEY_LOCAL_MACHINE\Software\SymbolBluetooth]

Edit the following key:

“SSStack”=dword:1

where:

0 = enable Microsoft stack and disable StoneStreet One stack (default)
1 = enable StoneStreet One stack and disable Microsoft stack

After setting the registry key, warm boot the MC92N0-G.

Sample Applications and StartUpCtl Configuration

The MC92N0-G with Windows CE contains a set of sample applications that can be installed on the MC92N0-G. As part of the installation, an application called StartUpCtl is also installed.

On the desktop, double-tap the Install Samples icon.

The Sample Applications and StartUpCtl application installs on the MC92N0-G and the Sample Applications window appears.

After a warm or cold boot, the Sample Applications window appears automatically.
StartUpCtl Application Configuration

StartUpCtl application can be used to automatically launch any application whenever a warm or cold boot is performed.

Refer to the StartUpCtl instruction available with the StartUpCtl software download available on the Support Central web site: http://www.zebra.com/support.

Removing Sample Applications and StartUpCtl Application

To remove the installed applications (before a cold boot is performed):
1. Tap Start > Setting > Control Panel > Remove Programs icon.
2. Select Samples.C from the list.
3. Tap the Remove button.
4. Tap the Yes button.
5. Select startUpCtl from the list.
6. Tap the Remove button.
7. Tap the Yes button.
8. Tap OK.

To remove the installed applications (after a cold boot is performed):
1. Tap Start > Programs > Windows Explorer.
2. Open the Application folder.
4. Delete the StartUpCtl folder and its contents.
5. Delete the Samples.C file.
6. Open the StartUp folder.

After a cold boot the Install Samples icon appears on the desktop.

Switching Between QVGA and VGA Resolution in Windows CE Devices

All MC92N0-G configurations ship with VGA displays (640 H x 480 W resolution). All Windows CE configurations, by default, are set to QVGA resolution (320 H x 240 W). Windows CE operating system icons and applications are designed for QVGA resolution.

The user can change the display resolution from QVGA to VGA but the icons and applications appear 1/4 of the size as in QVGA mode.
To switch display resolution:

1. Tap **Start > Settings > Control Panel > Screen Resolution**.

![Screen Resolution Applet](image)

**Figure C-1  Screen Resolution Window**

2. Select the **Set Screen Resolution** radio button.

3. Select the **Keep settings after Cold Boot** checkbox to maintain this resolution after a cold boot.

4. Tap **Ok**.

5. Tap **Yes** to perform a warm boot.

![Windows CE Desktop in VGA Mode](image)

**Figure C-2  Windows CE Desktop in VGA Mode**

### Battery Usage Threshold Setting

By default the Battery Usage Threshold value is set to a pre-defined value (500 by default). To change the threshold value, a registry key must be created to allow changing this value.
A battery becomes unhealthy when the *Battery Usage Indicator* reaches a predefined threshold (end of usable life).

**NOTE** The point at which a battery becomes unhealthy may vary depending upon the environment and charging conditions.

![Image of Power BatteryMgmt Tab]

**Figure C-3** *Power BatteryMgmt Tab*

**Registry Setting**

Create the following registry key:

```
[HKEY_LOCAL_MACHINE\ControlPanel\Power]
   "EnableCycleCntThresholdEdit"=DWORD:0
```

where:

dword:0 = Enable threshold change

Warm boot the MC92N0-G to have the registry setting take effect.

1. On Windows Embedded Handheld devices, tap Start > Settings > System > Power > BatteryMgmt tab
   or
   On Windows CE devices, tap Start > Control Panel > Settings > Power > BatteryMgmt tab.

![Image of BatteryMgmt Tab with Threshold Change Checkbox]

**Figure C-4** *BatteryMgmt Tab with Threshold Change Checkbox*

2. In the **Battery Usage Threshold** text box, enter a new value.
3. Select the **Check to change the Battery Age Threshold to read only field** checkbox.

4. Tap **Apply**.

   Tap **ok**. The new value is set and then the registry key is deleted.

---

### WLAN Default Settings

By default, the WLAN radio is on when the MC92N0-G turns on. To change the default setting edit the following registry key:

```
[HKEY_LOCAL_MACHINE\Drivers\BuiltIn\WLAN]
   "InitialState"=dword:4
```

where:

- dword:4 = WLAN off.
- dword:0 = WLAN on.

Warm boot the MC92N0-G to have the registry setting take effect.

---

### Shift Key Settings

By default, the Shift keys have two states. First press activates the shift state, a second press unlocks the shift state.

The Shift key can be changed to three states. First press activates the shift state, a second press locks the shift state and a third press unlocks the shift state.

To change the functionality of the Shift key edit the following registry key:

```
[HKEY_LOCAL_MACHINE\HARDWARE\DEVICEMAP\KEYBD]
   "ShiftLockState"=dword:0
```

where:

- dword:0 = Shift Key three states.
- dword:1 = Shift key two states (default).

Warm boot the MC92N0-G to have the registry setting take effect.
**Numeric**

**802.11.** A group of wireless specifications developed by the Institute of Electrical and Electronics Engineers (IEEE). It specifies an over-the-air interface between a wireless client and a base station or between two wireless clients.

**802.11a.** Operates in the 5 GHz frequency range (5.125 to 5.85 GHz) with a maximum 54Mbit/sec. signaling rate. The 5 GHz frequency band is not as crowded as the 2.4 GHz frequency because it offers significantly more radio channels than the 802.11b and is used by fewer applications. It has a shorter range than 802.11g and is not compatible with 802.11b.

**802.11b.** Operates in the 2.4 GHz Industrial, Scientific and Measurement (ISM) band (2.4 to 2.4835 GHz) and provides signaling rates of up to 11Mbit/sec. This is a very commonly used frequency. Microwave ovens, cordless phones, medical and scientific equipment, as well as Bluetooth devices, all work within the 2.4 GHz ISM band.

**802.11g.** Similar to 802.11b, but this standard supports signaling rates of up to 54Mbit/sec. It also operates in the heavily used 2.4 GHz ISM band but uses a different radio technology to boost overall throughput. Compatible with the 802.11b.

**802.11n.** Similar to 802.11g, but this standard supports signaling rates of up to 600Mbit/sec. It is an improvement to the previous 802.11 standards with the addition of multiple-input multiple-output antennas (MIMO). It also operates in both the 2.4 GHz and 5 GHz ISM band.

**A**

**Access Point.** Provides a bridge between Ethernet wired LANs and the wireless network. Access points are the connectivity point between Ethernet wired networks and devices (laptops, hand-held computers, point-of-sale terminals) equipped with a wireless LAN adapter card.

**Ad Hoc Mode.** A wireless network framework in which devices communicate directly with one another without using an access point.

**API.** An interface by means of which one software component communicates with or controls another. Usually used to refer to services provided by one software component to another, usually via software interrupts or function calls.
Application Programming Interface. See API.

ASCII. American Standard Code for Information Interchange. A 7 bit-plus-parity code representing 128 letters, numerals, punctuation marks and control characters. It is a standard data transmission code in the U.S.

Association. The process of determining the viability of the wireless connection and establishing a wireless network's root and designated access points. A mobile computer associates with its wireless network as soon as it is powered on or moves into range.

Bar Code. A pattern of variable-width bars and spaces which represents numeric or alphanumeric data in machine-readable form. The general format of a bar code symbol consists of a leading margin, start character, data or message character, check character (if any), stop character, and trailing margin. Within this framework, each recognizable symbology uses its own unique format. See Symbology.

Bits per Second (bps). Bits transmitted or received.

Bluetooth. A low-cost, short-range radio link between two devices. Bluetooth can replace cables and can be used to create ad hoc networks and provide a standard way to connect devices.

boot or boot-up. The process a computer goes through when it starts. During boot-up, the computer can run self-diagnostic tests and configure hardware and software.

CDRH. (Center for Devices and Radiological Health) A federal agency responsible for regulating laser product safety. This agency specifies various laser operation classes based on power output during operation.

CDRH Class 1. This is the lowest power CDRH laser classification. This class is considered intrinsically safe, even if all laser output were directed into the eye's pupil. There are no special operating procedures for this class.

CDRH Class 2. No additional software mechanisms are needed to conform to this limit. Laser operation in this class poses no danger for unintentional direct human exposure.

CHAP. (Challenge Handshake Authentication Protocol) A type of authentication in which the authentication agent (typically a network server) sends the client program a random value that is used only once and an ID value. Both the sender and peer share a predefined secret. The peer concatenates the random value (or nonce), the ID and the secret and calculates a one-way hash using MD5. The hash value is sent to the authenticator, which in turn builds that same string on its side, calculates the MD5 sum itself and compares the result with the value received from the peer. If the values match, the peer is authenticated.

Cold Boot. A cold boot restarts the mobile computer and erases all user stored records and entries.

COM port. Communication port; ports are identified by number, e.g., COM1, COM2.

Cradle. A cradle is used for charging the terminal battery and for communicating with a host computer, and provides a storage place for the terminal when not in use.
**D**

**Decode.** To recognize a bar code symbology (e.g., UPC/EAN) and then analyze the content of the specific bar code scanned.

**E**

**EAP.** (Extensible Authentication Protocol) A general authentication protocol used to control network access. Many specific authentication methods work within this framework.

**EAP-PEAP.** (Extensible Authentication Protocol-Protected Extensible Authentication Protocol) A mutual authentication method that uses a combination of digital certificates and another system, such as passwords.


**EMDK.** Enterprise Mobility Developer’s Kit.

**Ethernet.** An IEEE standard network protocol that specifies how data is placed on and retrieved from a common transmission medium.

**ESD.** Electro-Static Discharge

**F**

**Flash Memory.** Flash memory is nonvolatile, semi-permanent storage that can be electronically erased in the circuit and reprogrammed.

**H**

**Hard Reset.** See Cold Boot.

**Hz.** Hertz; A unit of frequency equal to one cycle per second.

**Host Computer.** A computer that serves other terminals in a network, providing such services as computation, database access, supervisory programs and network control.

**I**

**IEC.** International Electrotechnical Commission. This international agency regulates laser safety by specifying various laser operation classes based on power output during operation.
IEC (825) Class 1. This is the lowest power IEC laser classification. Conformity is ensured through a software restriction of 120 seconds of laser operation within any 1000 second window and an automatic laser shutdown if the scanner's oscillating mirror fails.

IEEE Address. See MAC Address.

Internet Protocol Address. See IP.

IP. (Internet Protocol) The IP part of the TCP/IP communications protocol. IP implements the network layer (layer 3) of the protocol, which contains a network address and is used to route a message to a different network or subnetwork. IP accepts “packets” from the layer 4 transport protocol (TCP or UDP), adds its own header to it and delivers a “datagram” to the layer 2 data link protocol. It may also break the packet into fragments to support the maximum transmission unit (MTU) of the network.

IP Address. (Internet Protocol address) The address of a computer attached to an IP network. Every client and server station must have a unique IP address. A 32-bit address used by a computer on a IP network. Client workstations have either a permanent address or one that is dynamically assigned to them each session. IP addresses are written as four sets of numbers separated by periods; for example, 204.171.64.2.

K

Key. A key is the specific code used by the algorithm to encrypt or decrypt the data. Also see, Encryption and Decrypting.

L

laser scanner. A type of bar code reader that uses a beam of laser light.

LASER. (Light Amplification by Stimulated Emission of Radiation) The laser is an intense light source. Light from a laser is all the same frequency, unlike the output of an incandescent bulb. Laser light is typically coherent and has a high energy density.

Laser Diode. A gallium-arsenide semiconductor type of laser connected to a power source to generate a laser beam. This laser type is a compact source of coherent light.

LEAP. (Lightweight Extensible Authentication Protocol) A mutual authentication method that uses a username and password system.

LED Indicator. A semiconductor diode (LED - Light Emitting Diode) used as an indicator, often in digital displays. The semiconductor uses applied voltage to produce light of a certain frequency determined by the semiconductor's particular chemical composition.

Liquid Crystal Display (LCD). A display that uses liquid crystal sealed between two glass plates. The crystals are excited by precise electrical charges, causing them to reflect light outside according to their bias. They use little electricity and react relatively quickly. They require external light to reflect their information to the user.
**M**

**Mobile Computer.** In this text, mobile computer refers to the Zebra Series 9190 wireless portable computer. It can be set up to run as a stand-alone device, or it can be set up to communicate with a network, using wireless radio technology.

**MS CHAP.** (Microsoft Challenge Handshake Authentication Protocol) is the Microsoft version of CHAP and is an extension to RFC 1994. Like the standard version of CHAP, MS-CHAP is used for PPP authentication; in this case, authentication occurs between a PC using Microsoft Windows NT or Microsoft Windows 95 and a Cisco router or access server acting as a network access server (NAS).

**N**

**Nominal.** The exact (or ideal) intended value for a specified parameter. Tolerances are specified as positive and negative deviations from this value.

**P**

**PAN.** Personal area network. Using Bluetooth wireless technology, PANs enable devices to communicate wirelessly. Generally, a wireless PAN consists of a dynamic group of less than 255 devices that communicate within about a 33-foot range. Only devices within this limited area typically participate in the network.

**PING.** (Packet Internet Groper) An Internet utility used to determine whether a particular IP address is online. It is used to test and debug a network by sending out a packet and waiting for a response.

**Q**

**QWERTY.** A standard keyboard commonly used on North American and some European PC keyboards. “QWERTY” refers to the arrangement of keys on the left side of the third row of keys.

**R**

**RAM.** Random Access Memory. Data in RAM can be accessed in random order, and quickly written and read.

**ROM.** Read-Only Memory. Data stored in ROM cannot be changed or removed.

**Router.** A device that connects networks and supports the required protocols for packet filtering. Routers are typically used to extend the range of cabling and to organize the topology of a network into subnets. See Subnet.

**RS-232.** An Electronic Industries Association (EIA) standard that defines the connector, connector pins, and signals used to transfer data serially from one device to another.
**S**

**Scanner.** An electronic device used to scan bar code symbols and produce a digitized pattern that corresponds to the bars and spaces of the symbol.

**Scanning Mode.** The scanner is energized, programmed and ready to read a bar code.

**Shared Key.** Shared Key authentication is an algorithm where both the AP and the MU share an authentication key.

**Soft Reset.** See **Warm Boot**.

**Specular Reflection.** The mirror-like direct reflection of light from a surface, which can cause difficulty decoding a bar code.

**Subnet.** A subset of nodes on a network that are serviced by the same router. See **Router**.

**Subnet Mask.** A 32-bit number used to separate the network and host sections of an IP address. A custom subnet mask subdivides an IP network into smaller subsections. The mask is a binary pattern that is matched up with the IP address to turn part of the host ID address field into a field for subnets. Default is often 255.255.255.0.

**Symbol.** A scannable unit that encodes data within the conventions of a certain symbology, usually including start/stop characters, quiet zones, data characters and check characters.

**Symbology.** The structural rules and conventions for representing data within a particular bar code type (e.g. UPC/EAN, Code 39, PDF417, etc.).

---

**T**

**TCP/IP.** (Transmission Control Protocol/Internet Protocol) A communications protocol used to internetwork dissimilar systems. This standard is the protocol of the Internet and has become the global standard for communications. TCP provides transport functions, which ensures that the total amount of bytes sent is received correctly at the other end. UDP is an alternate transport that does not guarantee delivery. It is widely used for real-time voice and video transmissions where erroneous packets are not retransmitted. IP provides the routing mechanism. TCP/IP is a routable protocol, which means that all messages contain not only the address of the destination station, but the address of a destination network. This allows TCP/IP messages to be sent to multiple networks within an organization or around the world, hence its use in the worldwide Internet. Every client and server in a TCP/IP network requires an IP address, which is either permanently assigned or dynamically assigned at startup.

**Terminal Emulation.** A “terminal emulation” emulates a character-based mainframe session on a remote non-mainframe terminal, including all display features, commands and function keys. The MC92N0 Series supports Terminal Emulations in 3270, 5250 and VT220.

**TKIP.** (Temporal Key Integrity Protocol) A wireless encryption protocol that periodically changes the encryption key, making it harder to decode.

**TLS.** (Transport Layer Security) TLS is a protocol that ensures privacy between communicating applications and their users on the Internet. When a server and client communicate, TLS ensures that no third party may eavesdrop or tamper with any message. TLS is the successor to the Secure Sockets Layer (SSL).
**V**

**Visible Laser Diode (VLD).** A solid state device which produces visible laser light.

**W**

**Warm Boot.** A warm boot restarts the mobile computer by closing all running programs. All data that is not saved to flash memory is lost.

**WAP.** (Wireless Application Protocol) A set of specifications, developed by the WAP Forum, that lets developers using Wireless Markup Language build networked applications designed for handheld wireless devices. WAP was designed to work within the constraints of these devices: a limited memory and CPU size, small, monochrome screens, low bandwidth and erratic connections.

**WEP.** Wired-Equivalent Privacy protocol was specified in the IEEE 802.11 standard to provide a WLAN with a minimal level of security and privacy comparable to a typical wired LAN, using data encryption.

**WPA.** Wi-Fi Protected Access is a data encryption specification for 802.11 wireless networks that replaces the weaker WEP. It improves on WEP by using dynamic keys, Extensible Authentication Protocol to secure network access, and an encryption method called Temporal Key Integrity Protocol (TKIP) to secure data transmissions.

**WPA2.** Wi-Fi Protected Access 2 is an enhanced version of WPA. It uses Advanced Encryption Standard instead of TKIP.

**WLAN.** Wireless local-area networks use radio waves instead of a cable to connect a user device, such as a mobile computer, to a LAN. They provide Ethernet connections over the air and operate under the 802.11 family of specifications developed by the IEEE.
INDEX

Numerics

12 volt auto charge cable ........................................... 2-2
24 volt auto charge cable ........................................... 2-2
28-key keypad .......................................................... 2-3
43-key keypad .......................................................... 2-4
53-key 3270 keypad .................................................... 2-4
53-key 5250 keypad .................................................... 2-4
53-key keypad ............................................................ 2-3
53-key VT keypad ....................................................... 2-4
53-key White keypad .................................................... 2-4

A

AC power ................................................................. 2-27
accessories
  12 volt auto charge cable ........................................... 2-2
  24 volt auto charge cable ........................................... 2-2
  28-key keypad .......................................................... 2-3
  43-key keypad .......................................................... 2-4
  53-key 3270 keypad .................................................... 2-4
  53-key 5250 keypad .................................................... 2-4
  53-key keypad ............................................................ 2-3
  53-key VT keypad ....................................................... 2-4
  53-key White keypad .................................................... 2-4
  belt ................................................................. 2-3
  belt clip .............................................................. 2-4
  cables ................................................................. 2-3
  CAM ................................................................. 2-3, 2-28
    installation .......................................................... 2-29
    USB connection .................................................... 2-25, 2-29
  DC line cord .......................................................... 2-2
  DEX cable ............................................................. 2-2
  fork lift cradle ...................................................... 2-1
  fork lift high voltage power converter ......................... 2-2
  fork lift low voltage power converter ......................... 2-2
  fork lift power input cable ................................... 2-2

  four slot charge only cradle .................................... 2-1, 2-21
  four slot Ethernet cradle ........................................ 2-17, 2-18
  four slot Ethernet/USB cradle ................................... 2-1
  four slot spare battery charger ................................ 2-1
  GSM headset .......................................................... 2-4
  handstrap ............................................................ 2-3
  heated boot ........................................................... 2-3
  holster, quick release ........................................... 2-3
  magnetic stripe reader ........................................... 2-3
  MC90XX Cradle Bracket .......................................... 2-4
  MC90XX wall mounting bracket .................................. 2-4
  modem cable .......................................................... 2-3
  modem dongle .......................................................... 2-3
  MSR ................................................................. 2-25
    battery charging .................................................. 2-27, 2-33
    installation .......................................................... 2-26
    magnetic stripe reading ........................................ 2-27
    power connection ............................................... 2-26, 2-30, 2-33
    serial connection ............................................... 2-27, 2-31
  O’Neil printer cable ............................................. 2-3
  paxar printer cable ............................................... 2-3
  power supply .......................................................... 2-2
  protective boot ..................................................... 2-3
  RCH50 adapter cable .............................................. 2-4
  RS232 cable .......................................................... 2-2
  rugged cable headset ............................................. 2-4
  screen protector .................................................... 2-4
  serial cable .......................................................... 2-3
  serial/USB cradle ................................................... 2-1
  shoulder strap ....................................................... 2-3
  single slot serial/USB cradle .................................. 2-8, 2-36
    LED indicators ..................................................... 2-9, 2-10, 2-24
  spare battery .......................................................... 2-2
  spare battery charger ............................................ 2-23
  power connection ................................................... 2-24
  stylus kit .............................................................. 2-4
  UBC
<table>
<thead>
<tr>
<th>Battery Insertion</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>UBC Adapter Power Supply Kit</td>
<td>2-2</td>
</tr>
<tr>
<td>UBC Four Slot Base</td>
<td>2-1</td>
</tr>
<tr>
<td>UBC2000 Wall Mount Kit</td>
<td>2-4</td>
</tr>
<tr>
<td>Universal Battery Charger Adapter</td>
<td>2-1</td>
</tr>
<tr>
<td>USB Adapter ESD</td>
<td>2-4</td>
</tr>
<tr>
<td>USB Cable</td>
<td>2-2</td>
</tr>
<tr>
<td>USB Sync Cable</td>
<td>2-2</td>
</tr>
<tr>
<td>Zebra Printer Cable</td>
<td>2-3</td>
</tr>
<tr>
<td>ActiveSync</td>
<td>3-2, 3-6</td>
</tr>
<tr>
<td>Deploying CAB Files</td>
<td>8-8</td>
</tr>
<tr>
<td>Adding Programs</td>
<td>7-7</td>
</tr>
<tr>
<td>From Internet</td>
<td>7-9, 7-10</td>
</tr>
<tr>
<td>AirBEAM</td>
<td>8-9</td>
</tr>
<tr>
<td>CAB Files</td>
<td>7-1, 8-1, 8-8</td>
</tr>
<tr>
<td>Application Folder</td>
<td>8-8</td>
</tr>
<tr>
<td>Application Packaging</td>
<td>7-1, 8-6</td>
</tr>
<tr>
<td>Application Security</td>
<td>8-1</td>
</tr>
<tr>
<td>B</td>
<td></td>
</tr>
<tr>
<td>Battery Charging Temperature</td>
<td>A-2</td>
</tr>
<tr>
<td>Belt</td>
<td>2-3</td>
</tr>
<tr>
<td>Belt Clip</td>
<td>2-4</td>
</tr>
<tr>
<td>Boot</td>
<td>1-2, 1-3</td>
</tr>
<tr>
<td>Clean</td>
<td>1-2, 1-3</td>
</tr>
<tr>
<td>Cold</td>
<td>1-2</td>
</tr>
<tr>
<td>Warm</td>
<td></td>
</tr>
<tr>
<td>BootLoader</td>
<td>7-4, 7-5</td>
</tr>
<tr>
<td>Error Messages</td>
<td>7-13</td>
</tr>
<tr>
<td>Bullets</td>
<td>xxiii</td>
</tr>
<tr>
<td>C</td>
<td></td>
</tr>
<tr>
<td>CAB Files</td>
<td>8-4, 8-8</td>
</tr>
<tr>
<td>Deployment via ActiveSync</td>
<td>8-8</td>
</tr>
<tr>
<td>Deployment via AirBEAM</td>
<td>8-9</td>
</tr>
<tr>
<td>Deployment via Image Update</td>
<td>7-8, 8-10</td>
</tr>
<tr>
<td>Deployment via Storage Card</td>
<td>8-8</td>
</tr>
<tr>
<td>Cable</td>
<td>2-2</td>
</tr>
<tr>
<td>12 Volt Auto Charge Cable</td>
<td>2-2</td>
</tr>
<tr>
<td>24 Volt Auto Charge Cable</td>
<td>2-2</td>
</tr>
<tr>
<td>DC Line Cord</td>
<td>2-2</td>
</tr>
<tr>
<td>DEX Cable</td>
<td>2-2</td>
</tr>
<tr>
<td>Fork Lift Power Input Cable</td>
<td>2-2</td>
</tr>
<tr>
<td>Modem Cable</td>
<td>2-3</td>
</tr>
<tr>
<td>O'Neil Printer Cable</td>
<td>2-3</td>
</tr>
<tr>
<td>Paxar Printer Cable</td>
<td>2-3</td>
</tr>
<tr>
<td>RCH50 Adapter Cable</td>
<td>2-4</td>
</tr>
<tr>
<td>RS232 Cable</td>
<td>2-2</td>
</tr>
<tr>
<td>Serial Cable</td>
<td>2-3</td>
</tr>
<tr>
<td>USB Cable</td>
<td>2-2</td>
</tr>
<tr>
<td>USB Sync Cable</td>
<td>2-2</td>
</tr>
<tr>
<td>Zebra Printer Cable</td>
<td>2-3</td>
</tr>
<tr>
<td>Cable Adapter Module</td>
<td>2-3</td>
</tr>
<tr>
<td>Cables</td>
<td>2-3</td>
</tr>
<tr>
<td>Cache Disk</td>
<td>8-7</td>
</tr>
<tr>
<td>CAB</td>
<td>2-3, 2-28</td>
</tr>
<tr>
<td>Installation</td>
<td>2-29</td>
</tr>
<tr>
<td>USB Connection</td>
<td>2-25, 2-29</td>
</tr>
<tr>
<td>Certificates</td>
<td>8-3</td>
</tr>
<tr>
<td>Clean Boot</td>
<td>1-2, 1-3</td>
</tr>
<tr>
<td>Cleaning</td>
<td>12-1</td>
</tr>
<tr>
<td>Cold Boot</td>
<td>1-2, 1-3</td>
</tr>
<tr>
<td>Communication Setup</td>
<td>2-39</td>
</tr>
<tr>
<td>Serial Communication</td>
<td>2-39</td>
</tr>
<tr>
<td>USB Communication Setup</td>
<td>2-39</td>
</tr>
<tr>
<td>Communication Software</td>
<td></td>
</tr>
<tr>
<td>MobileDoxEthernet Communication</td>
<td>2-13</td>
</tr>
<tr>
<td>Installing MobileDox</td>
<td></td>
</tr>
<tr>
<td>Configuration</td>
<td>xviii</td>
</tr>
<tr>
<td>Conventions</td>
<td></td>
</tr>
<tr>
<td>Notational</td>
<td>xxii</td>
</tr>
<tr>
<td>Copyfile</td>
<td>8-5</td>
</tr>
<tr>
<td>Cpf File</td>
<td>8-4</td>
</tr>
<tr>
<td>CPU</td>
<td>A-1</td>
</tr>
<tr>
<td>Cradles</td>
<td>2-1</td>
</tr>
<tr>
<td>Fork Lift</td>
<td>2-1, 2-21</td>
</tr>
<tr>
<td>Four Slot Charge Only</td>
<td>2-1</td>
</tr>
<tr>
<td>Four Slot Ethernet</td>
<td>2-11, 2-18</td>
</tr>
<tr>
<td>Four Slot Ethernet/USB</td>
<td>2-1</td>
</tr>
<tr>
<td>Serial/USB</td>
<td>2-1</td>
</tr>
<tr>
<td>Single Slot</td>
<td>2-8, 2-36</td>
</tr>
<tr>
<td>LED Indicators</td>
<td>2-9, 2-10, 2-24</td>
</tr>
<tr>
<td>Spare Battery Charger</td>
<td>2-23</td>
</tr>
<tr>
<td>Power Connection</td>
<td>2-24</td>
</tr>
<tr>
<td>Creating a Splash Screen</td>
<td>7-16</td>
</tr>
<tr>
<td>Creating Cpf File</td>
<td>8-4</td>
</tr>
<tr>
<td>Creating Splash Screen</td>
<td>8-11</td>
</tr>
<tr>
<td>D</td>
<td></td>
</tr>
<tr>
<td>Data Capture</td>
<td>xviii</td>
</tr>
<tr>
<td>DC Line Cord</td>
<td>2-2</td>
</tr>
<tr>
<td>Decode Distances</td>
<td>A-5, A-7</td>
</tr>
<tr>
<td>DL Focus</td>
<td>A-11</td>
</tr>
<tr>
<td>HD Focus</td>
<td>A-13</td>
</tr>
<tr>
<td>SR Focus</td>
<td>A-9</td>
</tr>
<tr>
<td>Decode Ranges</td>
<td>A-23</td>
</tr>
<tr>
<td>Decode Zone</td>
<td>A-4</td>
</tr>
<tr>
<td>DL Focus</td>
<td>A-10</td>
</tr>
<tr>
<td>HD Focus</td>
<td>A-12</td>
</tr>
<tr>
<td>Deployment</td>
<td>7-1, 8-1, 8-8</td>
</tr>
</tbody>
</table>
E

electro-static discharge ........................................ 7-1, 7-2, 8-6
EMDK ....................................................................... 7-1, 7-2, 6-8
EMDK for eVC4 ...................................................... xxiii
Enterprise Mobility Developer Kit for eVC4 ................... xxiii
error messages ......................................................... 7-13
ESD ........................................................................ 2-5, 2-6
Ethernet communication

cradle config .......................................................... 2-14
modifying cradle settings ......................................... 2-15
setting IP address .................................................... 2-14
DHCP server config ................................................. 2-14
installing iDockIt ..................................................... 2-13
F

file update ............................................................... 7-5
flash file system ....................................................... 7-3
copyfile ................................................................ 8-5
downloading partitions ........................................... 7-5
non-FFS partitions ................................................... 7-4
BootLoader .............................................................. 7-4
splash screen .......................................................... 7-4
partitions ................................................................. 7-3
copyfile ................................................................ 7-4
regmerge ................................................................. 7-3
regmerge ................................................................. 8-5
flash storage ........................................................... 7-3
fork lift cradle .......................................................... 2-1
fork lift high voltage power converter ......................... 2-2
fork lift low voltage power converter ......................... 2-2
fork lift power input cable ........................................ 2-2
four slot charge only ................................................ 2-1
four slot charge only cradle ...................................... 2-21
four slot Ethernet cradle .......................................... 2-11, 2-18
four slot Ethernet/USB ............................................. 2-1
four slot spare battery charger ................................... 2-1
G

GSM headset ............................................................. 2-4

H

handstrap ................................................................. 2-3
hard reset ................................................................. 1-2, 1-3

I

image update

deploying CAB files ................................................ 7-8, 8-10
information, service ................................................ xxiii
installation

development tools ................................................... 7-3, 8-7
Installing Window Mobile Device Center ..................... 3-1

K

keyboard .................................................................. A-1
keypad

28-key keypad .......................................................... 2-3
43-key keypad .......................................................... 2-4
53-key 3270 keypad .................................................. 2-4
53-key 5250 keypad .................................................. 2-4
53-key keypad .......................................................... 2-3
53-key VT keypad ..................................................... 2-4
53-key White keypad ................................................ 2-4
keypads ................................................................. xviii

L

lithium-ion battery ................................................... 1-1
locking EDA ............................................................. 8-2

M

magnetic stripe reader ............................................... 2-3, 2-25
maintenance ............................................................ 12-1
MC90XX Cradle Bracket ........................................ 2-4
MC90XX wall mounting bracket ................................ 2-4
memory ................................................................. xviii, A-1
MobileDox

install ................................................................. 2-13
modem cable .......................................................... 2-3
modem dongle ........................................................ 2-3
MSR ................................................................. 2-3, 2-25
battery charging ...................................................... 2-27, 2-33
installation .............................................................. 2-26
magnetic stripe reading ........................................... 2-27
power connection .................................................. 2-26, 2-30, 2-33
serial connection ..................................................... 2-27, 2-31

O

O’Neil printer cable .................................................. 2-3
operating system ................................................... xviii, A-1
Index - 4  MC92N0-G Integrator Guide

operating temperature ........................................ A-2

P
packaging ......................................................... 7-1, 8-6
partition update .................................................. 7-5
partitions
  downloading ..................................................... 7-5
  FFS ............................................................. 7-3
  non-FFS ......................................................... 7-4
  BootLoader .................................................... 7-4
  splash screen ................................................... 7-4
paxar printer cable ............................................... 2-3
persistent storage ............................................... 8-8
pin-outs
  accessory ......................................................... A-28
  mobile computer ................................................. A-24
Platform SDK .................................................... 7-2
ten power supply ............................................... 2-2
programs
  adding from Internet ............................................ 7-7
  adding using BootLoader ....................................... 7-9, 7-10
  flash file system ............................................... 7-3
protective boot ................................................... 2-3
provisioning ....................................................... 7-15
PSDK ............................................................. 7-1

Q
quick release holster ........................................... 2-3

R
radios .............................................................. xviii
RAM ............................................................... 8-7
random access memory .......................................... 8-7
RAPI ............................................................... 8-3
RCH50 adapter cable ............................................. 2-4
RegMerge.dll ...................................................... 7-3
remote API ........................................................ 8-3
reset
  hard ............................................................. 1-2, 1-3
  soft .............................................................. 1-2
resetting .......................................................... 1-2
RS232 cable ....................................................... 2-2
rugged cable headset ............................................. 2-4

device management ................................................ 8-3
digital signatures .................................................. 8-3
locking device ..................................................... 8-1
remote API ........................................................ 8-3
serial cable ........................................................ 2-3
serial/USB cradle ................................................ 2-1
setting up a partnership
  partnership ....................................................... 3-4
shoulder strap ..................................................... 2-3
single slot serial/USB cradle .................................. 2-8, 2-36
  LED indicators .................................................. 2-9, 2-10, 2-24
soft reset .......................................................... 1-2
software installation ............................................. 7-15
  BootLoader ...................................................... 7-9, 7-10
spare battery ..................................................... 2-2
spare battery charger ........................................... 2-23
power connection ................................................ 2-24
splash screen ...................................................... 7-4
SR focus decode distances ..................................... A-9
storage
  application folder ............................................... 8-8
  cache disk ....................................................... 8-7
  persistent ....................................................... 8-8
  volatile ........................................................ 8-7
storage card
  deploying CAB files ........................................... 8-8
storage temperature ............................................. A-2
strap ................................................................. 1-1
stylus ............................................................... 1-1
stylus kit .......................................................... 2-4
Syncing
  Installing ActiveSync ......................................... 3-1
  Windows Mobile Device Center ................................. 3-3

troubleshooting .................................................. 12-5
turning the radios off ........................................... WLAN ......................................................... 1-8

U
UBC ................................................................. 2-32
UBC adapter power supply kit .................................. 2-2
UBC four slot base ............................................... 2-1
UBC2000 wall mount kit ......................................... 2-4
universal battery charger ....................................... 2-32
universal battery charger adapter ................................ 2-1
unpacking .......................................................... 1-1
USB adapter ESD .................................................. 2-4
USB cable .......................................................... 2-2
USB sync sync cable ............................................... 2-2

S
screen protector ................................................... 2-4
security
  application ....................................................... 8-1
certificates ........................................................ 8-3
V
volatile storage ........................................ 8-7

W
warm boot .............................................. 1-2
weight .................................................. A-1
Windows Mobile Device Center .................. 3-3
Wireless ............................................... 1-8, 5-4
Wireless Manager ................................. 1-8, 5-4
WLAN 802.11a/b/g/n ......................... xviii, xix
WPAN Bluetooth ................................. xviii, xix

X
XML provisioning .................................... 8-4
certificates ......................................... 8-3

Z
zebra printer cable ................................. 2-3